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END-USER LICENSE AGREEMENT
WITH METTLER TOLEDO
FOR
WinBridge® Sofiware

This END-USER LICENSE AGREEMENT FOR WinBridge® SOFTWARE (hereinafter
“AGREEMENT") is enfered into by and between the END-USER LICENSEE and Meftler-
Toledo, Inc., a Delaware corporation with a principal place of business at 1900 Polaris
Parkway, Columbus, Ohio 43240 (hereinafter *“MTI”). In return for good and valuable
consideration, the receipt and sufficiency of which are hereby acknowledge, END-USER
LICENSEE and MTI agree as follows:

1. Definitions

a. “SOFTWARE” shall mean the WinBridge® Software, documentation, manuals
and other materials as packaged and/or delivered by MTI fo END-USER
LICENSEE, including without limitation, any and all updates, later versions or
revisions, upgrades, improvements, enhancements or modifications made
during the term hereof. SOFTWARE shall include, but not be limited to, any
changes, updates, later versions, revisions, upgrades, improvements,
enhancements or modifications made thereto by MTI by virtue of MTI’s activity as
a CONFIGURATOR, including those made specifically af the request or direction of
END-USER LICENSEE.

b. “SITE” shall refer only to the address identified above for END-USER
LICENSEE.

¢. "CONFIGURATION TOOLS” shall mean all software and all information,
whether in electronic, written or verbal form, used by MTI to customize the
SOFTWARE to meet the needs of END-USER LICENSEE. CONFIGURATION TOOLS
shall include but not be limited to the Configurator Software program, WinEdit
Tools, and Report Writer Tools, markefing materials, flow charts, pricing
information, and demo programs as well as any and all updates, later versions
or revisions, upgrades, improvements, enhancements or modifications thereto.
CONFIGURATION TOOLS shall not include any information disclosed by END-
USER LICENSEE for the purpose of enabling MTI to cusfomize the SOFTWARE fo
meet the needs of END-USER LICENSEE.

d. “CONFIGURATOR” shall refer to the acfivity of MTI in marketing, installing,
and/or customizing the SOFTWARE to meet the needs of END-USER LICENSEE.

e. "LICENSED CPU" shall mean any single ceniral processing unit owned or
leased by END-USER Licensee and locafed at the SITE. If “LAN OPTION” is
selected, then LICENSED CPU shall mean the computer sysfem comprising a file
server and up fo five (6) concurrent users.



2. GRANT OF LICENSE

a. Effective upon logging info SOFTWARE, MTI hereby grants to END-USER
LICENSEE, and END-USER LICENSEE hereby accepts, a personal, nonexclusive
and nontransferable license to utilize only at the SITE and only upon the
LICENSED CPU, during the term hereof, the SOFTWARE, subject to the conditions
set forth herein (hereinafter “SOFTWARE LICENSE”). A separate license shall be
required, together with the payment of additional license fees, to concurrently
use the SOFTWARE on anything other than the LICENSED CPU at the SITE. END-
USER LICENSEE acquires no rights in or to the CONFIGURATION TOOLS.

3. LICENSE RESTRICTIONS
a. END-USER LICENSEE agrees:

1. not to market, distribute or disclose to any third party the SOFTWARE, or any
portion thereof; and

2. not to reverse engineer, decompile, reproduce or modify the SOFTWARE or
any portion thereof without MTI's prior written consentf; END-USER LICENSEE
may make one (1) copy of the floppy disks provided with the SOFTWARE: (i) for
archival purposes or, (ii) when copying is an essential step in the use of the
SOFTWARE with the LICENSED CPU so long as the copies are used in no other
manner; if the LICENSED CPU is inoperative due to malfunction, the license granted
under this AGREEMENT shall be temporarily exfended to authorize the END-USER
LICENSEE to use the SOFTWARE on another computer at the SITE until the
LICENSED CPU is refurned to operation; END-USER LICENSEE may not copy any
of the documentation or written materials which are part of the SOFTWARE; and

3. not fo remove any labeling or nofices included with or embedded in the
SOFTWARE; and

4. to promptly inform MTI of any unauthorized possession, use or copying by
END-USER LICENSEE or others of the SOFTWARE or any portion thereof; and

4. OWNERSHIP

a. Title. Title fo the SOFTWARE is not transferred to END-USER LICENSEE.
Ownership of the SOFTWARE and of authorized copies made by END-USER
LICENSEE is vested in MTI, subject to the rights granfed to END-USER LICENSEE
in this AGREEMENT. END-USER LICENSEE agrees that the SOFTWARE is the
exclusive property and constitutes a valuable frade secret of MTI. END-USER
LICENSEE shall not disclose or make available the SOFTWARE, or any portion
thereof, fo third parties without MTI's prior written consent.

5. SUPPORT - END-USER LICENSEE shall identify o MTI one member of its staff having
sufficient expertise in the SOFTWARE ("LIAISON CONTACT") to act as the primary technical
liaison responsible for all communications with MTI regarding the SOFTWARE. The
LIAISON CONTACT shall direct all communications regarding the SOFTWARE fo MTI.



6. A. LIMITED WARRANTIES - MTI EXPRESSLY WARRANTS THE SOFTWARE PROVIDED TO
END-USER LICENSEE AS SET FORTH HEREIN. MTI MAKES NO OTHER WARRANTIES, EITHER
EXPRESS OR IMPLIED (INCLUDING WITHOUT LIMITATION WARRANTIES AS TO
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE). In addition, the following
shall constitute the sole and exclusive remedies of END-USER LICENSEE for any breach by
MTI of its warranty hereunder.

MTI warrants that the media upon which the SOFTWARE are provided to END-USER
LICENSEE will be free from defects in workmanship and materials for a period of one (1)
year from the date of shipment to the END-USER LICENSEE. Should any such defects be
found and reported during such one year period MTI will send END-USER LICENSEE
replacement media.

MTI does not warrant that any software comprising the SOFTWARE will be free from errors
in program logic, clerical program preparation and transcription. The foregoing warranty
shall not apply fo defects resulting from: (1) unauthorized modification; (2) END-USER
supplied software or interfacing; (3) accident, transportation, neglect, misuse, alteration,
modification, or enhancement by anyone other than MTI; (4) the failure fo provide a
suitable installation environment; (5) uses other than the specific purpose for which the
Software is designed; (6) use on any systems other than specified MTI hardware; or (7)
failure to incorporate any update(s) previously released by MTI.

B. DISCLAIMER - EXCEPT AS EXPRESSLY STATED HEREIN, THE SOFTWARE IS PROVIDED
"AS IS" WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING, BUT NOT
LIMITED TO, WARRANTIES OF PERFORMANCE OR MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. END-USER LICENSEE BEARS ALL RISK RELATING TO QUALITY
AND PERFORMANCE OF THE SOFTWARE. MTI does not warrant the level of performance
of the SOFTWARE, nor does MTI warrant that the SOFTWARE will meet END-USER
LICENSEE's requirements nor that the SOFTWARE will operafe without inferruption or be
error free. LICENSEE SHALL BE SOLELY RESPONSIBLE FOR THE SELECTION,
INSTALLATION, USE, EFFICIENCY AND SUITABILITY OF THE SOFTWARE AND/OR ANY
CUSTOMIZATION OF SAME AND MTI SHALL HAVE NO LIABILITY THEREFOR. IN NO EVENT
SHALL MTI BE LIABLE TO END-USER LICENSEE FOR ANY DAMAGES RESULTING FROM OR
RELATED TO ANY FAILURE OF THE SOFTWARE, INCLUDING, BUT NOT LIMITED TO LOSS
OF DATA, OR DELAY BY MTI IN THE DELIVERY OF THE SOFTWARE. EXCEPT TO THE EXTENT
PROVIDED IN SECTION 6.D. “INDEMNIFICATION BY MTI”, IN NO EVENT AND UNDER NO
CIRCUMSTANCES SHALL MTI BE LIABLE FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL,
OR PUNITIVE DAMAGES, OR FOR ANY LOST PROFITS OR FOR ANY OTHER TYPE OF DAMAGE,
INCLUDING BUT NOT LIMITED TO ANY DAMAGES RESULTING FROM OR RELATED TO ANY
FAILURE OF THE SOFTWARE and/or CONFIGURATION TOOLS, LOSS OF DATA, OR DELAY
by MTI IN THE DELIVERY OF THE SOFTWARE AND/OR CONFIGURATION TOOLS OR IN THE
PERFORMANCE OF THIS AGREEMENT, EVEN IF MTI HAS BEEN ADVISED OF THE
POSSIBILITY THEREOF. MTI’s LIABILITY HEREUNDER TO END-USER LICENSEE, IF ANY,
SHALL IN NO EVENT EXCEED ONE THOUSAND DOLLARS. No action, regardless of form,
arising out of the fransactions under this AGREEMENT may be brought by either party more
than one (1) year affer the cause of action has accrued.

C. Limitation of Liability - END-USER LICENSEE's exclusive remedy for breach by MTI of
the above limited warranty shall be replacement of any defective medium returned to MTI
within the warranty period. END-USER LICENSEE agrees not to hold MTI responsible for
any losses or damages arising ouf of any acts or omissions of MTI related fo the
provision of the SOFTWARE fo END-USER LICENSEE, including but not limited fo MTI's



activities as a CONFIGURATOR. END-USER LICENSEE acknowledges that it must enter into
a separate written agreement with MTI to specify how the SOFTWARE is to be customized
to meet the needs of END-USER LICENSEE and the amount of license fee to be paid for the
SOFTWARE. IN NO EVENT shall such other written agreement between END-USER
LICENSEE and MTI alter or change any of the ferms and conditions contained in this
AGREEMENT.

D. INDEMNIFICATION BY MTI - MTI shall defend any suit or proceeding brought against
END-USER LICENSEE so far as the same is based on a claim that the SOFTWARE furnished
by MTI hereunder, or any part thereof, constitutes an infringement of any United States
patent or United States copyright, if nofified promptly in writing and given authority
information and assistance (at MTI's expense) for the defense of the same and if such
alleged infringement is not the result of a design or other special requirement specified by
END-USER LICENSEE such as, but not limited to, how the SOFTWARE has been customized
for END-USER LICENSEE. MTI will pay all damages and costs awarded in such suit or
proceeding provided that MTI shall have the sole and exclusive right to defend, settle or
compromise any suit or proceeding and END-USER fakes no action which would materially
detract from MTI's ability to conduct an effective defense, settlement or compromise. In
case any portion of the SOFTWARE in such suit is held to infringe any such patent or
copyright and the use thereof is enjoined, MTI shall at its expense and at its sole opfion,
either: (a) obfain for END-USER LICENSEE the right fo confinue using such SOFTWARE or
part thereof or; (b) replace the same with non infringing material, or; (c) modify the same
so that it becomes non infringing or; (d) accept return of the SOFTWARE and pay END-
USER LICENSEE one-thousand dollars (§1,000.00). The foregoing states the entire liability
of MTI to END-USER LICENSEE for patent and/or copyright infringement. MTI shall have no
liability for any claim of copyright or patent infringement based on (a) uses of other than the
lafest unmodified release of the SOFTWARE if such infringement could have been avoided by
the use of the lafest release.

7. Term and Termination - The term of this AGREEMENT and of the license granted herein
shall commence on the date this AGREEMENT is signed by END-USER LICENSEE and
shall continue until END-USER LICENSEE discontinues the licensed use of the SOFTWARE
on the LICENSED CPU. END-USER LICENSEE may terminafe this AGREEMENT by giving
MTI written nofice of termination. MTI may ferminate this AGREEMENT by giving END-
USER LICENSEE written notice of fermination if END-USER LICENSEE commits a material
breach hereof or if END-USER LICENSEE becomes insolvent or seeks protection,
voluntarily or involuntarily, under any bankruptcy law. Upon any termination of this
AGREEMENT, END-USER LICENSEE shall cease all use of SOFTWARE, destroy all copies
then in its possession and take such other actions as MTI may reasonably request fo
ensure that no copy of SOFTWARE remains in END-USER LICENSEE's possession.

8. Effect of Agreement - This Agreement is the sole agreement between the parties relafing
fo the subject matter hereof and supersedes all prior understandings, writings, proposals,
representations or communications, oral or written, of either party. No provision hereof may
be waived, modified or superseded, except by written document signed by the parties herefo.
If any provision herein is deemed fo be unenforceable or illegal, the parties shall negotiate
in good faith to achieve a new legal enforceable provision which most closely
approximates the original intent of the provision declared unenforceable or illegal. Any
cause of action arising out of or relafed fo this AGREEMENT must be brought no later than
one year after it has accrued. Excepting defined terms which are denoted with capital
letfers, the headings and capfions contained in this AGREEMENT are inserfed for



convenience only and shall not constitute a part hereof. This Agreement may be executed
in several counterparts, each of which shall be deemed an original and all of which shall
constitute one and the same instrument.

9. Governing Law - This AGREEMENT shall be governed by and construed under the laws
of the State of Ohio, U.S.A.

10. Assignment - Neither this AGREEMENT nor any part or portion hereof shall be
assigned, sublicensed or otherwise fransferred by END-USER LICENSEE. Failure of a party
fo enforce any provision of this AGREEMENT shall not constitute or be construed as a
waiver of such provision or of the right to enforce such provision. MTI may assign any
part or portion of this AGREEMENT fo an authorized MTI distributor.

11. U.S. GOVERNMENT RESTRICTED RIGHTS - The SOFTWARE is provided with
RESTRICTED RIGHTS. Use, duplication or disclosure by the government is subject to
restrictions as set forth in subparagraph (c)(l )(ii) of the Rights in Technical Data in
Computer Software clause at DFARS 252.227-7013 or the Commercial Computer
Software Restricted Rights clause af FAR 52.227-19 subdivision (c)(1) and (2), as
applicable. Contractor/manufacturer is Mettler-Toledo, Inc., 1900 Polaris Parkway,
Columbus, Ohio 43240.



CONTENTS

1 Infroduction 1-1
PUIPOSE......eeeiiei it e e et e e e e e e s e e e e e e e e s nn e e e e e e e e eesannreeeeeseeannnnnns 1-1
REQUITEMENTS .....coooi i 1-1
Overview 1-2
How 10 Start WinBridge ...........ccceevieerieiiei e ssreessseres e e s 1-3
How 10 CloSe WINBIdge..............umrieeiiiiiiiiee e ee e 1-4
How to Select a Menu Hem...........cccceiiiiiniienn e 1-4
How to Press a Push BUHON ............ccccooooiiiiiie e 1-4
How to Use Data Fields ..............ccceeeeriiiiiieee e 1-4

2 Vehicle Processing Screen 2-1
MENU BAF ...t e e s e annne 2-2
TOOIDAL....... e 2-2
DATA GIOUPS ....eoeeeeieeieieiieeeeeeiereree e s e e e sesanre e e e e e s eesnnreeeeesseesnnsnreeessaenan 2-4

VENICIE GIOUD ... 2-4
ACCOUNT BIOUP ...ttt e e e e e e e e 2-5
ProduCt GIOUD ...ttt 2-5
TrANSACHON GIOUP ....vviiiiiiiieie e 2-5
CONMACT GIOUP ...ttt 2-6
AMOUNT GIOUP ... 2-6
Company and Carrier COmbo BOXES............ccccveeeeeiiiiiviniereeen e ernnneeeen 2-6
PUSH BUHONS ..........ooiiiiieic et e e e e e e s e aannes 2-7
REMAIKS........ccoeeeeeeee 2-8
£ L T ] LS 2-8
£33 (o1 (1 G- T R 2-8

3 Creating Database Records 3-1

WinBridge TabIes..............eeeeeieee e 3-1

FOMMIS e 3-2

TOADIBS. ... 3-3
Modifying TADIES .......ccooviiiiiiieiiee e 3-3
TOOIDAL ... e e e e e e e e e e e e e eeeees 3-4
SPeCial BUHONS............coovviiiiiiiiiiiieieieeeer e e e e e e e e eerenees 3-5
Editing Table ENtries ...........ccccueeeeeiiiiiere e e 3-6

Inserting @ NeW RECOIT.............ccoiiiiiiiiiiiiiie e 3-6

Deleting an EXisting RECOI...............cooviiiiiiiiiiiiiiicc e 3-6

Editing an Existing RECOI.................oooiiiiiiiiiii 3-7
[ 11 o 1S 3-8
[ R 3-10
ProducCt ...... ..o 3-11
ACCOUNT ...t e e s s anr e e e e e s s e e sannnes 3-14
(117111 £+ T R 3-17
(1 T 3] SR 3-20
VERICIE..........eeeee e —————— 3-21
(1171 11T PP 3-23
OPEIATON. ... .eeeeeereeeerreesesr e e e e rr e e s sne e e s e ssr e e s e nr e s s ssn e e s sanre e e s enreesennnes 3-24



BIOUPS ...eeiuereeeeeereeesreeessssreesessreesssreeseasreesessreesesneessanreessenneesennnnes 3-28
Badge and Short Code..............cccueeeeiiiiiiiiiireee e 3-29
4 WinBridge Advanced Module 4-1
Extended TAaDIES ..........cceeeiiieieeeie e s 4-1
Carrier TADIE .......eeeeeieeeecee e 4-3
[ (=TT PP 4-3
[T TN o =71 S 4-3
Converted WeIgRES............cceviiiiiei e s 4-3
Virtual INdICATOrS .........ooviiiiiiiciee e 4-4
Advanced PriCing ............occeieieiii i 4-5
SUFCRANGES ....eeiereeeireee e e e e e e s e s snr e e s s e e e s s nr e e s ennnressanrneenan 4-6
SAMPIING.....ooiiiieie et e s e e snr e s s snreeeean 4-8
5 Groups and Group Presets 5-1
Creating @ GrOUP .........ccuuvveiieeiiiiiirrr e e e e s e s e e r e e s e annr e e e 5-2
Adding Records 10 0 GroUP ...........coccuerieeiriiiiiinnreee e s esernrr e e e s e ennreeee s 5-3
LINKING GrOUPS.........cooviireiiiirieneiieesesrre e srre e s s sre e snr e s s sre e e s nne e s nnees 5-5
USiNg Group PreSets .........ccoooeiiierieeiiiiicieieeee s snre e 5-6
6 Operating WinBridge 6-1
Processing TranSACHiONS ...........ccceeviiiiiiiiniieei i 6-1
o (=11 PR 6-4
Creating PreSeIS........ooviiiiiiiii e 6-4

USING PIESEIS. .....eeiiiiiiiie e 6-5

Storing Tare Weights............cccoviiiiiiieei e 6-6
Printing Reports and Tickets ...............cccmiiiiiiiiiie s 6-8
PriNF REPOM ... 6-8

SIANAArd REPOMS ... 6-9

MU REPOI TOG ..ot 6-13
PrinETICKEE ... 6-14

LOSE TICKEE. ... 6-14
Managing the Database.............ccoooooiiiiiiien e e 6-15
BOCKUD ..ottt 6-15

EXDOM ..ottt 6-16

IMPOM ... 6-17

Global Import and EXPOM ............oooiiiiiiiiiiiiii e 6-18
Database SPEeA............eeviiii i 6-18
Managing TranSACHONS. ............ccevriiieiiiieeeie e e s e snnees 6-19
Transaction SIATUS...........cooiiiiiiiiiii e 6-19

Modifying TranSACHONS .............ooiiiiiiiiiiiiii e 6-20

Voiding TranSACHIONS ..........cuviiiiiiiiiiii e 6-22

Weight Correction FACIOr.............cooivviiiiieiiiiic e 6-23

EXPOrting TranSACHONS ..........cooiiiiiiiieeee it 6-24

RESEE COUNTEE ... 6-24

7 WinBridge Settings and Tools 7-1
Setting Up Scales and Traffic Lights ...............ccoccerriiine e, 7-1
SCAIE MBNU ...t 7-1

TrOffIC LIGNTS. ...t 7-3
Processing PArAMETErs............covvicieirieireeiiieeesesre e snre s s e e e 7-5
SPlit WeIGNING ... 7-8

TOOIS.....ceeiiie et 7-9



DispIay AIGIM SEHINGS ... ... vveeeeeeeeeseeseseeeeeseeeeseeeeesee e 7-11

End-of-Period Operations.............ccccoooiiiiiiiiiiiiiiicieeee 7-12

SCAIE VIBW.....veiiiiciiciii e 7-13

HOSt 7-14

HEIP MENU.......cc oo 7-15
Software Version Identifier ..................cccoooo 7-15

Software Checksum CONMIOL...............coooiviiiiiiiiiiiiii e 7-15

8 WinBridge Unattended Module 8-1
INtrOdUCHON ... 8-1
DA ENIIY oo 8-2
BOAGE. ... vttt 8-2

ShOM COUE ... 8-3
Unattended Mode Processing............cceeevveerrieeenssreesssseesssssneessssesssnnns 8-4
9 WinBridge Report Module 9-1
Creating @ REPOI ... e 9-1
DefiNing @ QUETY..........coeiiiiiiiceriee e 9-3
EdIting 0 QUETY ......oviiiiiiiii e 9-7

Reports with Dynamic Variables.................cccccooviiiiiiiiin 9-10

Defining @ Layoul...........oooiriiiiiee e 9-11
Using Empty Fields in @ Report .............cccooeeieriiiciiiiiee e 9-13
Printing Gross, Net, and Tare Calculations.............cc.occcevrrieeeneiciennnnns 9-14
Using Spare Fields for Calculations.............cccccoeeiviiieeencccciieeeeee e, 9-15
Printing Duplicate TiCKetS.........ccccooviiiiiieiii e 9-16
Using Dates in RePOMS............cooeviiiiiiii 9-17
10 Report Writer Tutorial 10-1
Generating @ TICKeT ..........ccceerieiiee e s 10-1
DEfiniNg the QUENY ...........v.veeeeeeeeeeee e, 10-2

LinKiNg TADIES..........oeiiiiiiii 10-4

Testthe QUETY .......oooiiiiiiiiei e 10-7

Defining the Layoul ... e 10-8
Dettil BIOCK ........coiviiiiiii i 10-13
Generating a REPOI ...........oovviiiiiiie e 10-14
Dynamic Variables..............cocoiiiiiiiii 10-15

OFABI BY ... 10-16

FOrMAMiNG ... 10-18

11 Specific Industries 11-1
FOTOSITY .o 11-1
AGFICUITUIE ... s e e e s snr e enns 11-4
Aggregate: Sand and Gravel ...............ccceeeerieeieiiiieeee e 11-7
Aggregate: Concrete and ASphalt ...........ccc.oooeiiiieeii i 11-10
Waste: RECYCIING ...........ouevieeiiiiiiriee e e 11-13
Waste: Transfer STAtoNs..............cccceveeiieniniiien e 11-16
Waste: LandfillS............ccuveeeiiiiiiiiii e 11-19
Waste: MERF and RRF ...........cooooiiiiii e 11-22
WB-SHANAQAN ........coooeieiieeee e e e s e e 11-25

12 Definitions 12-1



Chapter 1: Introduction
Purpose

] Introduction
Purpose

The WinBridge® Vehicle Scale Information Technology software
package is designed fo handle transactions in which material is
bought, sold, or processed on a scale. WinBridge software can
connect to as many as four scale indicators, plus peripherals such
as bar-code readers, traffic lights, and unattended driver stations.
This manual explains how fo use WinBridge software.

The main purposes of the WinBridge software package:
«  Record fransactions that involve weighing vehicles.
¢ Produce reports about the transactions.

e Provide information from the WinBridge database in ASCII file
format use with external software packages.

*  Manage unattended weighing sfations.

Requirements

WinBridge 1.3.9 requires the following minimum hardware:
e A personal computer with
v" Pentium®/133 MHz CPU
CD-ROM player
32 MB RAM
1 GB hard drive

800x600 SVGA monitor using small fonts. Monitor
should be 17 inches or larger to make it easy to read the
screen, especially if you include the maximum options.

v Parallel printer for reports and tickets

e An 8530 Cougar, 8142, Jaguar, Lynx, Panther, or
compatible Cardinal, Fairbanks, GSE, Rice Lake, \Western, or
\Weigh-Tronix scale indicator.

e Optional: An Unattended Terminal (contact your METTLER
TOLEDO distributor for hardware and software specifications).

The following minimum software is required:
e Windows 95, 98, or NT

LSRN NN
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The following list outlines the basic steps involved in sefting up
and operating your WinBridge system:

1.

Have your supplier install WinBridge and configure it for you.
Discuss your processing needs with the supplier to make sure
the installation is configured to meet them. Your supplier can
handle the following configuration options:

« Install on a single PC or network

« Install add-ons such as unattended ferminals
 Connect fo scales and traffic lights

« Translate the program to another language

« Change the appearance of screens
 Enable/disable individual functions

¢ Enable supervisors and operators

« Set up tickets and reports for printing

« Provide WinBridge passwords

Create database records (see Chapters 3, 4 and 5). Before

you can process fransactions, you need fo enfer information
about products, accounts, contracts, vehicles, etc., in your

dafabase.

Process fransactions (see Chapter 6). Once you have had
your WinBridge sysfem configured and have entered
information in the database, you can begin processing
transactions. You can speed up fransactions by creating
presets that automatically enter dafa for a transaction.

Print tickets and reports (see Chapter 6). WinBridge can print
a ticket aufomatically for each transaction. If also provides a
selection of basic reports that you can print. The optional
report module enables you fo design your own fickets and
reports.

Manage records of fransactions (see Chapter 6). WinBridge
stores a complete record of each fransaction. If gives you the
ability to void, modify, and export transactions.

Manage the database (see Chapter 6). WinBridge enables
you to backup your database, import information info the
dafabase, and export information from the dafabase for use
with other software packages.

Change default settings (see Chapter 7). You can change a
wide range of default seftings fo modify the way your
WinBridge system operates.



Chapter 1: Introduction
How to Start WinBridge

How to Start
WinBridge

Your supplier will install the WinBridge program and configure it for
you. Each time you start WinBridge, you must identify yourself as
an authorized user.

1.

WinBridge Log In [ %]

WinBridge

By logging into YWinBridge you
agree to the licensing terms in the
Mettler-Toledo and Centura
Licensing Agreements.

Operator:
Password:

€
Login Logout

Start SQLBase by selecting the SQLBase Database Engine
icon and double-clicking on it (or pressing the ENTER key).

Select the WB icon and double-click on it (or press the
ENTER key). The WinBridge Log In screen will appear.

Release 1.3.9

METTLER TOLEDO

Place the cursor in the Operator field and type your user
name.

Move the cursor fo the Password field and type your
password. The password will not be shown in the field;
each character will appear as an asterisk.

Click the Login button or press the ENTER key to start
WinBridge (click the Logout butfon to exit).

If you typed your user name and password correctly, the WinBridge

Vehicle

Processing screen will appear.

(9/00) 1-3
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How to Close
WinBridge

To close WinBridge, click the Close button on the Vehicle
Processing screen (or select Exit from the Program menu). Type
your user name and password in the data fields on the WinBridge
Log In screen. Then click the Logout bufton fo exit.

If you have started WinBridge but have not entered a user name or

password, you can exit the program by pressing the ESC key or
clicking the Logout butfon.

How to Select
da Menu ltem

1. If you have a mouse, click on the menu item.

2. If you do not have a mouse, press the ALT key fo select the
first menu item, and then use the leff and right arrow keys to
move fo other menu ifems.

e To open a menu, use the down arrow key.

e To select a menu item, highlight it with the up or down
arrow key and then press the ENTER key.

How to Press
a Push Button

If you have a mouse, click on the push button.

2. If you do not have a mouse, press ALT+ the character that is
underlined on the push button.

How to Use
Data Fields

1-4 (9/00)

To move from an input data field to the next field, press the TAB
key. This also checks any dafa enfered in the field to make sure it
is valid. To move fo the previous dafa field, press TAB+SHIFT.

WinBridge can be configured so thaf the ENTER key (instead of the
TAB key) is used to move from one field to another. When the
ENTER key is used to move between fields, it cannot be used for
other purposes, such as accepting a weight.



Chapter 2: Vehicle Processing Screen
Menu Bar

2 Vehicle Processing Screen

When you stfart the WinBridge program, the Vehicle Processing
screen will appear. This screen is used to process all vehicle
weighing fransactions. It also provides access fo WinBridge tables,
reports, and other tools. The exact appearance and operation of the
Vehicle Processing screen depends on how WinBridge is
configured by your supplier. The sample screen shown below
offers the most complete setf of vehicle processing options. In other
configurations, some fields and buttons might be arranged
differently or hidden. The order in which fields are entered on the
screen also depends on how your system is configured.

Program  Edit Table Extdtables Repory/Ticket Datsbase Scale Tools Help
0= o EeEE OEE g - —
Lt [PCE
: 7 ' L
—Vehicl . =
|| ﬂl B Tare weight Load1
| | k[ ] % Laad?
Cont | ﬂl min kgl | Truek
Cinly n Load3:
| | me b | | 0 [N S T 3 K mE
[~ Customer i~ Contract
| - L] — o
0al
i Product
tax tax2 Accept | COfHLTE Clear
Loadd:
SUNCHEMES el
—Transaction
In ko Discount Tax1 :l Daily deliv, Wt
P |
L et Totl [ ]
Comryis | =
Canerd [ =]
‘ ﬂ‘ | Table 1 I” Validate Date =
Ll | _»l_I
[ mov
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Menu Bar

The menu bar shows the main functions available in WinBridge:
Program, Edit, Table, Extended Tables, Report/Ticket, Database,
Scale, Tools, and Help. Clicking on one of these will display a
secondary menu (for example, clicking on Table displays the list of
tables available for editing).

Program  Edit Table Estdtables Report/Ticket Database Scale Toolz Help

Toolbar

2

SESIC

g

Spli

gntrafl

Trans

2-2 (9/00)

The Program menu is used to exit WinBridge. The Edit menu
provides Undo, Cut, Copy, Paste, and Clear commands for editing
dafa field enfries. Tables are discussed in Chapter 3, Extended
Tables in Chapter 4, and other menu items in Chapters 6 and 7.

The toolbar is located under the menu bar. The push buftons and
data fields found on the toolbar are described below.

Close: Exits from the Vehicle Processing screen (same as Exit in
the Program menu).

Search: Displays the table associated with the data field in which
the cursor is positioned. When you select a record from the fable
(by pressing ENTER or double-clicking the left mouse button),
information from the record is entered into the data field. You can
also display a table by clicking the right mouse bufton on the
appropriate dafa field. If a partial ID is specified in a field, the table
will open on the first row that includes that partial ID.

One/Two: Toggles between one-pass weighing (weigh a loaded
vehicle and use a sfored tare weight or manual tare entry) and
two-pass weighing (weigh a vehicle once when it is empty and
once when it is loaded). Two-pass weighing is the default for
vehicles without a sfored tare weight.

Split: Allows split-load transactions (weights are recorded twice,
possibly under different product codes). THIS PROCESS IS NOT
WEIGHTS AND MEASURES APPROVED.

Contract: Enables/disables the use of the contract functions for the
current fransaction.

Transaction: Displays a table that lists all two-pass fransactions
that are open (have not been complefed). When a vehicle refurns
for its second weighing, select the appropriate open fransaction to
complete the two-pass weighing operation.



Preze

=l

Ticket

Tr. It

Chapter 2: Vehicle Processing Screen
Toolbar

Preset: Loads preset default values info empty data fields (see the
information about using presets in Chapter 6).

Report: Allows you fo choose, print, or view reports.

Ticket: Prints a tickef for the most recent transaction.
Unattended: Switches between operator and unattended mode.
Calculator: Displays a calculator for the operator to use.

Help: Displays the on-line help (same as Help menu).

Store Tare: Allows you fo store a tare for a vehicle. It is enabled
only when a vehicle is specified in the Vehicle field and has been
verified in the database.

Transaction Number: Shows the current fransaction number. You
must export all data before you reset this number.

Scale 1,2,3,4: Reads the weight from any of the enabled scale
devices.

Virtual Indicator: Retfrieves a weight from a virfual indicator.

Manual: Allows manual input of weight. This is available only if the
operator is authorized and manual mode is enabled for the product.

Use Stored Tare: Automatically inputs the current weight reading as
a vehicle tare weight in either the Weight In or Weight Out box.

Traffic Light: Displays push buttons for manual control of fraffic
lights. Displays aufomatically controlled traffic lights.

Unattended Printing: Enables (green) or disables (red) printing of
a ticket for an unattended fransaction.

Master Transaction Number: Shows the fofal number of

323
fransactions. This number cannot be reset.

Load Number: This number can be reset at any fime. It
shows the number of transactions since the last reset.
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Data Groups

Vehicle Group

Wehicle

To make it easier to locate information on the Vehicle Processing
screen, the data is arranged in six groups: Vehicle, Account,
Product, Transaction, Confract, and Amount. The groups confain
yellow input fields where you enter data and gray outputf fields
where the system displays data.

\When you start a new transaction, the cursor appears inside the
first input field. You can move to the next input field by pressing the
TAB key (your system can be set up to use the ENTER key instead
of the TAB key). The cursor cannot move to fields that are not input
fields. You can also move directly to any input field by clicking on
it with the mouse. WinBridge validates the data entered info the
field before moving to the next field. If the data are correct, then the
cursor will move to the next input field. Otherwise, an error dialog
box will appear, and the cursor will not move to the next field until
a valid entry is made.

The Vehicle group contains information about a vehicle and its tare
weight:

e Vehicle: vehicle ID, description, minimum and maximum
weights (if they are enabled), container ID, container weight,
and a Truck Only box to check when a container vehicle does
not have a container attached. The Container combo box
(which lists container IDs) is enabled only if a vehicle has a
container.

e Tare: a vehicle’s fare weight and pictures of the tractor and
frailer associafed with the tare configuration. If more than one
tare weight is stored for a vehicle, use the scroll bar below the
Tare Weight data field fo select the appropriate tare weight.

New tare values can be stored by pressing the Store Tare button.
Values will then be saved to the Tare table.

|VEH123

M)

Tare weight

|

Ib
Cant. j min Ik 9000 'IC')rulck Ijl
n
o [ Jmacw [ soog]

1
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Account Group
The Account group contains information about the account
(customer or supplier), such as the account ID, name, and
addresses (there can be more than one shipping address).

Account
| K1 =] | 4572 main Street =]
‘ Block Construction j‘

Product Group
The Product group includes the product ID, description, faxes, and
price per unit (Pr/U).

Product taxl tax?
PO1 = 22.00% 0.00%
Gravel = e $5.00

Transaction
Group

The Transaction group confains information about the current
transaction. It can include the in and out fime of the fransaction,
the inbound and outbound weights (if the fransaction is
complefed), and the net weight.

NOTE: If the Truck Only box is checked in the Vehicle data group,
the net weight will be reduced by the fare weight of the container.
The mode of operation (Ship or Receive) can be selected from the
combo box. A conversion unit will be shown if that option is
enabled in the Product fable.

—Transaction
In 4]

Ourt 14

5 | Net
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Contract Group

The Confract group confains the contract ID (selectable from a
combo box), the maximum weight authorized for the contract, and
the accumulated delivery weight. These fields are filled only when
an account and a product have been identified.

Contract
BC22 x| max b 20000|

deliv. b | 1?}'g|]|

Amount Group

The Amount group contains data used for computing the final cost
of a fransaction. For instance, it can show the price of the weighed
goods, surcharges, faxes, total price, and discount. This data is
displayed only after a weight is entered.

—Amaunt
SUrCharges "
Discaunt: Tax 1
0.10% Tax 2
@ Total

Company and
Carrier Combo
Boxes

The Company ID combo box shows the company ID. Until you
select a company ID, the box will display the first ID in the
database. The Carrier ID combo box shows the carrier ID.
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Push Buttons

v
Accept

Compute

W

Clear

Daily deliv. Yyt

Continue

The following buttons are used on the Vehicle Processing screen:

Use the Accept button fo complete a transaction by accepfing the
data currently displayed on the Vehicle Processing screen. If the
data are valid and complete, the transaction will be recorded in the
database. If any of the data are invalid (or do not exist in the
database), an error dialog box will appear. If that happens, correct
the invalid data entries and press the Accept butfon again.

Use the Compute button to recalculate the price or weight for a
fransaction after editing the Truck Only, Add Price, or Surcharges
field. The updated information will then be displayed. This option is
used to view the results of a computation before accepting a
fransaction. If is also used when new taxes or surcharges are
added: simply press the Compute button fo display the new fotal.

Use the Clear button to clear the Vehicle Processing screen and
move the cursor to the first dafa field. All data fields are cleared
aufomatically when a fransaction is accepted.

Use the Daily Delivery Weight button fo show how much of the
product selected in the product ID field has been weighed on the
current day. WinBridge can be configured to show Received
Weight, Shipped Weight, and Total Weight (received weight plus
shipped weight).

Use the Confinue button fo process multiple weighings as a single
fransaction. It allows you to run a two-pass transaction that
involves (1) weighing more than one product on a single vehicle
or (2) weighing products for more than one account on a single
vehicle. Suppose, for example, that a vehicle needs to pick up
several products for a customer:

1. Weigh the empty vehicle on its first pass over the scale.

2. Load the first product onto the vehicle, take a second-pass
weight reading, and then click the Continue bufton. This
stores the weight for the product.

3. Load the next product onto the vehicle, and then take another
second-pass weight reading. If more products need fo be
weighed, click the Continue button and repeat this step for
each product.

4. \When all products have been weighed, click the Accept button
to complete the fransaction.
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Remarks

The Remark and Remark2 combo boxes are located to the right of
the Company ID and Carrier ID combo boxes on the sample
Vehicle Processing screen. You can enter remarks related to the
current transaction or select predefined remarks from the combo
boxes.

Spare Fields

Spare data fields are available on the Vehicle Processing screen fo
display data that is not stored in the database. Spare fields 10, 11,
12, and 13 are designed so that the text entered info them will
wrap; however, the configurator must remove the borders around
these fields for the wrapping function to work.

Status Bar

The status bar at the botfom of the screen shows the seftings of the
Caps Lock, Number Lock, and Scroll Lock keys. It also displays a
brief explanation of the current menu selection or wait messages
and other information.

Fazs Zero function enabled | |E,-.‘-,F'5 (MU |
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WinBridge Tables

3 Creating Database Records

WinBridge
Tables

Before you can use WinBridge to process fransactions, you need to
enter information in the database about products, accounts,
vehicles, efc. This information is stored in a series of WinBridge
tables (each table is described later in this chapfer). The only limit
to the number of records that you can store in your database is the
amount of hard disk space available on the computer.

The Product, Account, Contract, and Vehicle tables are the four
main WinBridge fables. To view a fable, open the Table menu on
the Vehicle Processing screen and click on the desired table.

| Table
Company...
Product...
Account...
Contract...
Carrier. .
Yehicle...
Container...
Eadge... +
ShonCode...
Operatar...
Tax...
Tare...
Femark...
Bemark?...
Groups...
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Forms
When you select a table from the menu, the first thing you will see
is a form designed fo display an individual record from the table.
You can go directly from the Vehicle Processing screen fo a form
by placing the cursor in the appropriafe ID data field and pressing
the SHIFT+? key. A sample form for the Company fable is shown
below.
B2 compANyY =1 E3
Tahle Data Edit
B | & | @ (B | .| | | B| |7
Close Hew Query | Tahle : Insert | Update | Delete
Company Id: D
Name | | Load Mo |:|
MNote: Valid Load Numbers
Address 1 | | are from 1-10
Address 2: | |
City: | | State: |:|
Fiscal Code: | |
Fress "Query" to retrieve information... ‘ MUK

Each form contains data fields, which are used to enter, view, and
edit information for a record.

e The yellow data fields must be filled in. They represent the
minimum information required to create a database record.

e The ID field is the record’s primary key (unique identifier).

< The white data fields are optional. You can leave these fields
blank when creating a record, but we suggest that you enter
as much information as possible.

NOTE: Do not use an apostrophe (or single quotation mark) in
data field entries. The WinBridge program does not recognize it as
a legitimate character.
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Modifying Tables
Tables
To display all the records stored in a fable, click the Query button
on the form’s toolbar and then click the Table button. A sample
Company table is shown below.
i COMPANY [_ (O] =]
ID HAME ADDR1 ADDRZ2 R f e
01 ACME Indust 3752 County Central City : OH
o4 CARCO 357 Main St Milltown OH
coz Johnson Inci 6961 River R Srmallville  i0H
03 Spencer Cok 8353 Brook Zenith oH
05 Textran Inc {1245 Fine A Salem OH
| [
Use the scrollbar at the bottom of the fable fo view all the data in
the fable. To search for a specific record, type the ID (or other
information known about the record) in the appropriate data field
on the form. Then click the Query button.
I
Modifying
Tables

| WEHICLE_ID |

-+

You can modify a table by rearranging rows and columns and by

changing col

umn widths.

To rearrange rows, click on one of the column headings. The rows
will be rearranged so that the items under the heading that you
clicked on are in alphabetical/numerical order.

To rearrange columns, position the cursor on the botfom border of
a column heading until the symbol shown to the left appears. Then
hold down the left mouse butfon and drag the column to a new

location.

To change the width of a column, position the cursor on the side
border of a column heading until the symbol shown to the left
appears. Then hold down the leff mouse button and drag the
column border fo the desired width.
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Toolbar

3-4 (9/00)

A foolbar is located near the top of each of the forms used fo
display individual records from the fables. The push buttons on the
toolbar provide the following functions:

Closes the form.

Clears all data fields and begins a new record.

Recalls all records if all data fields are blank. Any dafa entered into
a required or opfional data field will be used as a filter.

Shows query results in a table. When you highlight one of the

records listed in a table, the highlighted record will be displayed in

the data fields on the form.

Returns to the first record in the query.

Returns to the previous record.

Goes forward to the next record.

Goes forward fo the last record in the query.

Inserts a new record once all required fields have been filled.

Accepts changes made fo an existing record.

Deletes the current record.



Special
Buttons

Chapter 3: Creating Database Records
Special Buttons

Several push buttons are used to perform special tasks. The
Presets button is available for the main WinBridge tables (Product,
Account, Contract, and Vehicle). The Groups and Sample buttons
are available for the four main tables only if the Advanced Module
is enabled. In the WinBridge Advanced Module, the Presets and
Groups buttons are available for the Carrier table.

The Presets button lefs you create an automatic link that connects
a vehicle, a product, an account, and a contract. Once presets
have been defined, you can enfer them into the dafa fields on the
Vehicle Processing screen with a single keystroke (see Chapter 6).
The last preset used will override previously defined presets.

The Groups bufton appears only if the Advanced Module is
enabled. This button can make it easier fo manage your weighing
operations by allowing you fo create groups of products, accounts,
contracts, or vehicles. See Chapter 5 for a description of how
groups can be set up and used.

The Sample button appears only if the Advanced Module is
enabled. Pressing this button will display a screen from which you
can determine how and when product samples are to be faken for
an individual product, account, contract, or vehicle.

There are also several push buttons that are discussed in the
sections about the individual tables:

«  The Detail button is covered in the Contract table section.
< The Shipping button is covered in the Account table section.

< The Advanced Pricing button is covered in the Product table
section. This button also appears on the Contract Detail table.
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Editing Table
Entries

Inserting a
New Record

Deleting an

Existing Record

3-6 (9/00)

You can insert new records in a table, delete existing records, and
edit existing records.

Open the Table menu and select the table info which you wish to
insert a record. The form for that table will appear.

1. Click the New button to clear all dafa fields on the form and
provide a fresh screen for you o use.

2. Fill in the appropriate data fields. If you do not fill in all
required fields, a “Value not entered in this field” error
message will appear when you try fo insert the new record.

3. When you have entered all the information, click the Insert
butfon. This will enter the new record in the existing table.

A quick way to create a record is fo display an existing record that
is similar fo the one you want to create. Change the record’s ID
and click the Insert button. This will give you a new record based
on a copy of the existing record.

Open the Table menu and select the table from which you wish to
delete a record. The form for that fable will appear.

1. Click the Query button and then click the Table button. This
will display all entries in the table.

2. Double-click on the entry you wish fo delete. This will display
the record on the form. Click the Delete butfon to delete it. You
will then be prompted fo confirm the deletion.

Another way to delete a record is fo enter its ID in the ID data field
and then click the Query button. Once the record is displayed on
your screen, click the Delete button.

The Sampling and Surcharge fables are the only exceptions fo this
procedure. A record in those fables must be marked for deletion by
clicking on it with the right mouse button. Once the record has
been marked, delete it using the DELETE key on the keyboard. An X
will appear af the beginning of the row. Then click the OK button fo
accept the delefion.
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Editing an
Existing Record
Open the Table menu and select the table you wish to edit.

1. Click the Query button and then click the Table bufton. This
will open a fable that displays all records.

2. Double-click on the record you wish to edit. The record will be
displayed on the form, and you will be able to edit any of the
fields.

3. When you have finished editing the record, click the Update
butfon. This will update the existing record so that the
changes will be available immediately.

Another way to edit a record is to enfer its ID in the ID data field
and then click the Query button. Once the record is displayed on
your screen, you can edit it and update the record.

The Sampling and Surcharge fables are the only excepfions fo this
procedure. For those tables, use the left mouse button to click on
the item you wish to edit. Then type in the changes or use the
combo box to make a change. Once the changes have been
made, click the OK bufton fo accept them.
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Company
This form lets you add, edif, and delete information about each
company that processes transactions on your WinBridge system.
In many cases, only one company will be involved. But there can
be more than one entry if several companies share a scale.

B comMpaANY _ (O] x|
Table Data Edit
¥ | &|o|eE| | .| |, | &8|"]"
Close Hew Query | Table Insert | Update | Delete
Companyld:D

Mote: Walid Load Mumbers

Address 1:| are from 1-10

City: |

|
|
Address 2 | |
|
|

Country: |

Fiscal Code: | |

Press "Query" to retrieve information... | UK

Required Data Fields
Company ID: The primary key for this table.

Optional Data Fields
Name: The name of the company.
Address 1:

Address 2:

City:

State:

Country:

Zip:

Phone:

Fax:

Fiscal Code:
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Load No: A number from 1 to 10 that corresponds fo
one of the Load data fields on the Vehicle
Processing screen.

Multiple Loads

The mulfiple loads feature can be used when you are processing
tfransactions for several companies. It keeps track of how many
fransactions are processed for each company.

1. When inserting or updating a company record, enter a
number from 1 to 10 in the Load No data field on the
Company form. A separate load number should be assigned
for each company.

2. \When you process a fransaction, make sure that the Load No
box on the Vehicle Processing screen’s foolbar is checked.

3. The number of loads processed for a company will be shown
on the Vehicle Processing screen in the Load data field (see
below) that corresponds fo the load number assigned fo the
company.

Lozd1:

LozdZ:

Lozd3:

Lozdd:

Lozds:

LozdE:

LozdT:

Lozde:

Lozds:

Lozd10;

The load number count for each company can be resef to 1 by
using the Reset Loads function in the Transactions section of the
Tools menu.
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Tax

This form is used fo store information abouf faxes. You should
enfer Tax table information before you create a Product record, so
that the tax information will be available for use when you fill in the
Product form’s Tax1 and Tax2 data fields.

= TAX =] E3
Table Data Edit

| &|wo|B] | .|, || &8|0|T
Close Hew Query | Table Insert | Update | Delete

Tax ld:

Description: |VP\T |

walue: |22.00%

| [
Required Data Fields
Tax ID: The primary key for this table.
Value: Value of the fax is shown as a percentage.

Optional Data Fields

Description: A description of the tax being defined. Examples:
federal, state/provincial, harmonized, county,
and municipal tax.
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Product

This form lefs you add, edit, and delete information about the
different products that you will be weighing.

& PRODUCT [_ O] =]
Table Data Edit
I| a0 B «|v || 20O
Close Hew | Query | Table ' Insert | Update | Delete
Productld: ¥ Manual [ FPrice Type——  ~Operation :I
| & weight | | € ship
DrOSet, ’Grave\ : " Pieces I iFReceive
Stock Level: || @ Either
Price Faormula: iADV NET*PR1 1000 2000 3000 4000 140 120 100 80 60 RAW |
2] 00
Tat It 6” | P
Fresets Groups
Cony. Unit: . % fﬁi
Cony. Factar: :I ol i
Select row then press CTRL + INSERT to Insed into Surcharge Table
PRODUCT_ID  |SURCHARGES D SURCHARGES_DESCRIPTION
=]
‘ ...... ’m ,_
Required Data Fields
Product ID: The primary key for this fable.
Optional Data Fields
Manual
\Weighing: Check this box if you wish o be able fo enter the
weight of this product manually (it will still be
possible to weigh the product on a scale).
Descripfion: A description of the product.
Stock Level: The amount (in pounds, kilograms, or metric

tfons) of the product currently in stock. As the
product is received or shipped, this value will be
updated automatically.

Unit Price: The price of the product per Unit ID. This value is
sfored as PR1.
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3-12 (9/00)

Unit ID:

Price Type:

Price
Formula:

Minimum
Price:

Tax1 ID:
Tax2 ID:

Conv. Unit:

Conv. Factor:

Default
Operation:

Surcharges:

Advanced
Pricing:

The primary unit used for weighing the product
(pounds, kilograms, or metric tons).

Choose one of the two pricing methods: by
Weight (default price formula is NET*PR1) or by
Pieces (default price formula is PCS*PRT).

The price formula is created when you insert or
update a record. Price formula variables include
NET (net weight), PR1 (unit price), PCS (pieces),
/, +, -, * and #### (numbers).

You can set a minimum price for a product. This
price will be used whenever the calculated price
is lower than the minimum price.

Taxes defined in the Tax table. Choose from an
existing list or NA if taxes are Not Applicable.

Taxes defined in the Tax fable. Choose from an
existing list or NA if taxes are Not Applicable.

A secondary weight unit.

The multiplier used to convert the primary weight
unit fo a secondary unit. Conversion Unit and

Conversion Factor work fogether produce a
second unif used in reporting. Examples:

Unit ID Conv. Factor Conv. Unit
kg 2.2046 Ib
Ib 0.4536 kg
Ib 0.0005 tons
kg 0.001 tonnes

Choose one of the options: Ship, Receive, or
Either. If you choose Either, then the product can
be both shipped and received.

If the Advanced Module is instfalled, you can use
the fable atf the botfom of the screen to assign up
fo six surcharges for a product. All preset
surcharges will be used when a price is
calculated for a fransaction.

When you click the Adv Pricing butfon, the
following form appears:



Advanced Price Definition B

¥ Enable advanced pricing
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Product

—Advanced pricing parameters
Unit price |140 ;
Max Price
Step 1 |1DDD | |14D ‘ X
Step 2 |zuuu | |120 ‘ | Camed |
Step 3 |3mn | |mn ‘
Step 4 |4EIEID | |8EI ‘

™ Fixed price [~ Raw price

Base formula:

Clear Formula |

NETPR1

Enable Advanced
Pricing:

Unit Price:

If this option is enabled, then the Advanced
Pricing parameters will be used. If it is not
enabled, then the Base Formula will be used.

Price per unit (from Product form).

The Max and Price columns are used for step pricing only. You can
define up to five steps in a pricing scheme. For each step, enfer a
price and the maximum weight for which that price is used.

Fixed Price:

Raw Price:

Base Formula:

Clear Formula:

OK:
Cancel:

Sefs a single price per unit for the enfire load (for
example, $120 for loads up fo 2,000 pounds).

Sets a different price per unit for portions of a
load (for example, $140 for the first 1,000
pounds, $120 for the second 1,000 pounds,
efc.).

This is the same as the Price Formula described
in the Product form (usually NET*PRT).

Clear the existing formula. A formula must be
entered for the price definition to be accepted.

Save the existing formula or step pricing scheme.

Cancel any changes made tfo the original
formula.
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Account

This form lefs you add, edit, and delefe information about accounts
(customers or suppliers). The Enabled box must be checked for an
account before you can process transactions for that account.

B2 ACCOUNT =13
Tahle Data Edit
Qe | 0 | BB " g > " -3 [ 0 | O
Close Hew Query | Tahle Insert | Update | Delete
Account Id ¥ Enahbled PeRfE: Ol
& Cash  Ship
MName: |BIDCR Canstruction | .
©Imvoice  Receive
Fizcal Code | | € Other « Either
Address 1 |1SDD Eeech Street | Discount |:|
City: |Sma||vi|\e | State:
Country: |USA | Zipl43566
Fan Masx. Credit: 150000
[ ] preses | _ Stiging
Person: | | o® t#
Ticket In: | T SaMPLE Ticket OUt|T SAMPLE i
Info: | |

I

3-14 (9/00)

Required Data Fields
Account ID: The primary key for this table.

Optional Data Fields

Enabled: Check this box to enable the account.
Name: Account name.

Fiscal Code:

Address 1:

City:

State:

Country:

Zip:

Phone:




Fax:
Person:

Max. Credit:

Act. Credit:

Ticket In:

Ticket Out:

Info:

Discount:

Payment:

Operation:

Chapter 3: Creating Database Records
Account

The name of the confact person at the customer’s
or supplier’s office.

The credit limit extended to this account. You can
make this a required field by enabling Use Credit
Check in the Processing Parameters form (see
the information about processing parameters in
Chapter 7).

This field confains the amount of active credif the
account has used to date. As the account uses
credit, this field will update aufomatically. When
the account makes a payment, this field must be
edited manually. Once the Act. Credit equals
Max. Credit, you will receive the following
message: “Max credit exceeded for Account.” At
this point you must either extend further credit or
cancel the transaction. You can make this a
required field by enabling Use Credit Check in the
Processing Parameters form (see the information
about processing parameters in Chapter 7).

Choose from a selection of predefined tickets to
print when a vehicle enters your facility. If you do
not wish fo use an entry ticket, leave this field
blank.

Choose from a selection of predefined tickets to
print when a vehicle exits your facility. Nofe:
Ticket In and Ticket Out can be used
independently. You can use a different format for
each ficket.

For enfering additional information about the
account.

A discount (%) allowed for the account. The
price on the ticket will need to be reduced by this
percentage.

Choose one of the payment types: Cash, Invoice,
or Other.

Choose one of the options: Ship, Receive, or
Either. If you choose Either, then both shipping
and receiving transactions will be allowed for the
account.
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The Shipping button is an option found only on the Account form.
When you click this button, the Shipping Address form will be
displayed. In this form, you can enter additional shipping
addresses for an account.

= SHIPPING_ADDRESS =13

Loc?
Elock Construction

4572 Main Street
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I
Contract
This form lets you add, edit, and delete contract information for an
account. Each account can have more than one contract. To use
this fable, you must enable Use Contract on the Processing
Parameters form (see Chapter 7).
B2 CONTRACT _ (o] x|
Tehle Data Edit
= iz +0 B I’ P l [« -5 0 m}
Close Hew Query | Table : Insert | Update | Delete
Contract |d: ¥ Enabled
Description ‘
Cther Id:
Account Id
Cantract with Block Canst 3%
Info | ontract wa ock Constr ‘ # Pé:‘l
First deliv. date: |EEI—DE::—1 598 ‘ Sample Groups
(A &
First deliv. QT |:| Ll
Expiration Date: RESEE DEEl
\ INUM

Required Data Fields

Contract ID:
Account ID:

The primary key for this fable.

Use the combo box fo choose from a list of
existing enabled accounts. The account’s record
must already exist in the Account fable.

Optional Data Fields

Enabled:

Descripfion:
Other ID:
Info:

First Deliv.
Date:

Check this box to activate the contract. If it is not
enabled, then the contract will not be available
for use.

A description of the contract.
Further clarification of the Contract ID.
Additional information about the contract.

The date of your first delivery to or from the
account under this contract.
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First Deliv.
Qry: The quantity of the product delivered to or from

the account on the first delivery dafe.

The date when the contract expires. If a contract
is used affer this dafe, a warning appears on
screen.

Expiration Date:

The Detail butfton is an option found only on the Confract form.
When you click this button, the Contract Detail form will be
displayed. This form provides additional information about the
confract that was selected in the previous screen.

E= CONTRACT_DETAIL

Table Data Edit
U" ﬁ 0 % 1 7 f i "E +0 @
Close Hew | Query | Table Insert | Update | Delete
Contractld: |[BC22 ¥ Enabled
—Cperation
Product |d: =l -:‘I
: 20000 @ Ship
Mazx. Yeight: ~ Racajva
e 16000
Dieliv. Weight: ~Price Type
Discount: _ o \Wejght
UnitPrice; [5 2 Adv Pricing
Frice Formula: | |
Clear Formula

e

NOTE: It is not necessary to use the Confract Detail form, but we suggest that you enter
as much information as possible about active confracts. You must enter values in all
data fields except Price Formula in order fo insert a contract defail record.

Contract ID: The contract ID from the previous form.

Product ID: The product identifier for the product that will be
delivered through this confract. A record for this
product must already exist in the Product table.

Max. Weight: ~ The maximum weight of the product that is
allowed for this contract.

Deliv. Weight:  The actual weight of the product delivered under

this contract. This field is automatically updated
when a delivery is processed on the Vehicle
Processing screen.

3-18 (9/00)



Discount:

Unit Price:

Advanced
Pricing:

Enabled:
Operation:

Price Type:

Chapter 3: Creating Database Records
Contract

A discount rate to be applied to the product price.
NOTE: If you enter a negafive amount, then an
increase is calculated instead of a discount.

The unit price for a product.

Advanced Pricing is described in the Product
table section. The Advanced Pricing formula is
displayed in the Price Formula field. A push
button is supplied for clearing the formula.

Check this box to enable the confract.

This indicates whether you will ship or receive
this product (you cannot choose both).

This indicates whether a product is priced by
weight or per piece.
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I
Carrier
This form lets you add, edit, and delete information about carriers
that use your weighing operations. A carrier can ship products for
more than one account, and each account can use more than one
carrier. None of the entries is tied fo the Account fable. The Carrier
form will include Presets and Groups buttons only if the Advanced
Module is installed.
= CARRIER [_ O[]
Table Data Edit
U" @ +[ % [ 7 r [r "E +0 @
Close Hew | Query [ Table : Ingert | Update | Delete
Marne: |Ad\ranced Freight |
A [ @
P |SBDD Ridye Road | 6] J‘-%Qﬂ
Addrass 2 | | Presets Groups
Gty [Townley | staefor |
Country: |USA | Zip: |43222 |
| NUM
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Required Data Fields
Carrier ID: The primary key for this table.

Optional Data Fields

Name: The full name of the carrier.
Address 1:

Address 2:

City:

State:

Country:

Zip:

Phone:

Fax:
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Vehicle

This form lefs you add, edit, and delete information about vehicles
that use your scales. If a vehicle is set up as a confainer-type
vehicle, the system will prompt for the container type when the
vehicle is selected for a transaction. If a container vehicle enters or
leaves without a container, check the Truck Only box on the Vehicle
Processing screen or select a zero-tare container (a container with
zero entered in the Tare data field).

Infi:

£= VEHICLE = B3
Table Data Edit
Qe | gl | 0 |\ B | (| || =|0| O
Close Hew | Query | Table : Insert | Update | Delete
vehicle Id: [VEF1 23 I” Container Veh. R SR
[¥ Unattended Ticket & Tractar * Ship
Description: | | " Trailer " Receive
Carrier |d: [\ J " Either
Diriver:
[ ] 2 | @g
: Fey [
License: |ODLSE2 Groups Fresets

Expiration:
Min. Legal YWeight:

Max. Legal Weight:

1601201999 0: Sample
a000
20000

| how [
Required Data Fields
Vehicle ID: The primary key for this fable.
Min. Legal
Weight: The minimum legal weight of an empty vehicle.
Max. Legal
Weight: The maximum legal weight of a full vehicle.

NOTE: Min. Legal Weight and Max. Legal Weight are required only
when Check Vehicle Weight is enabled in the Processing
Parameters screen (see Chapter 7).
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Optional Data Fields

Container

Vehicle: Check this option if the vehicle requires or can
carry a separate confainer.

Unattended

Ticket: This check box is used to enable WinBridge fo
print tickets while operating an unattended scale
ferminal.

Type: Choose Tractor or Trailer.

Descripfion: A short description of the vehicle.

Carrier ID: This combo box is connected fo the Carrier fable.

If a carrier is using this vehicle, select that carrier
from a predefined list. NOTE: The carrier is not
automatically linked fo this field.

Operation: Choose Ship, Receive, or Either. If you choose
Ship, the vehicle can be used only for shipping. If
you choose Receive, the vehicle can be used
only for receiving. If you choose Either, the
vehicle can be used for both shipping and

receiving.

Driver: The name of the vehicle’s driver.

License: The license plate numbers of the vehicle.

Info: Additional information about the vehicle or driver.

Expiration: The date that the vehicle license expires. If the
vehicle is used affer this date, a warning appears
on screen.

Transient Vehicles

You can weigh a vehicle that is not listed in your dafabase. To
process the fransaction, enter a vehicle ID in the appropriate data
field on the Vehicle Processing screen. \When you move the cursor
to another data field, the following message will appear on the
screen: “Unknown vehicle! Is it a fransient one?” Click the Yes
button and continue with the transaction.
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This form lefs you add, edit, and delete information about
containers. Note that a tare value is required for the container.

E= CONTAIMER
T
Je | |0 (B[ | | . »l =
Close | Hew | Guery | Table Insert | Updste | Delete
ountainer|d:|:|
Description:l |
Tare::
Inf01:| |
Inf02:| |
e

Required Data Fields
Container ID: The primary key for this fable.
Tare: A manually entered weight for this container.

Optional Data Fields

Descripfion: A description of the type of container.
Info 1: Additional information about the confainer.
Info 2: Additional information about the confainer.

A vehicle that uses a confainer will have separate tare weights for
the vehicle and the confainer. Indicate that a vehicle can carry a
container by checking the Container Veh box on the Vehicle form.
Create a record in the Container table for each type of container
(including the tare weight). To weigh a confainer vehicle that does
not have a confainer attached, check the Truck Only box on the
Vehicle Processing screen or select a container ID that has zero
entered as its fare weight.
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Operator

This form is used fo sef up users as supervisors or operators. Only
supervisors can change passwords or user information.

f= OPERATOR [ O] <]
Table Data Edi
U" ﬁl +0 % z » M +3 +0 |
Close Hew | Query | Table Insert | Update | Delete
Type
Operator Id: Level: IU
 Superisor
e |Robendohnson |
& Operatar
Fassword: [RJ972 Expiration: |
—Function Enable/Disable
¥ Transaction v ehicle
¥ Transient Vehicle I” Export
[~ Unda [" Datahase
™ Utility ¥ Wanual Weighing
¥ void Transaction ¥ Tahla
I
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Required Data Fields

Operator ID:
Level:

Name:
Password:

Type:

The primary key for this table.

The level of security for the supervisor or operator
(0-9, zero providing the greatest access). The
supervisor or operator will not be able to use any
WinBridge function that requires a greater
security level than the one assigned here.

The full name of the user.

The user’s assigned password. Only supervisors
can change a password. NOTE: This field is case
sensitive.

Indicate whether the user has Supervisor or
Operator status.

Optional Data Fields

Expiration:

Defines when the account is due fo expire. This
field is useful if contract or temporary personnel
are employed.



Chapter 3: Creating Database Records
Operator

Function

Enable/

Disable: The specific responsibilities of the user are
defined here. Your configurator can select up fo
10 functions (from the 30 available functions
listed in the WinBridge Configurafor Manual,
Chapter 7).

NOTE: Be careful when enabling functions. If operators are given
too little authority, they might not be able to do work. If they are
given foo much authority, they might be able to delete all the stored
information.

Setting Up Users

1. Enter an ID in the Operator ID field o create a new record, or
click the Query button fo update an existing operator or
supervisor record.

2. Set up the user as a supervisor or operator by selecting the
appropriafe radio button in the Type group box.

3. Choose a level of access by typing in the appropriate number
in the Level field (0-9, with zero providing the greatest
access). The entry in this field will limit the user’s level of
access regardless of whether the user is set up as a
supervisor or operator.

4. Enter the full name of the user in the Name field.

5. Enter a password in the Password field. We recommend
giving each operator a unique password. Operators cannot
change their own passwords.

6. You can limit the time period for which an operator has
access fo the WinBridge system by entering a dafe in the
Expiration field. When the user fries to login after this date, a
“Password has expired” message will appear on the screen.
This effectively locks the user out of the system until a
supervisor changes the expiration date.

7. Ifthe user type has been sef to Operator, you will need to
enable the desired functions in the Function Enable/Disable
group box. Supervisors have access fo all functions by
default. Check the boxes corresponding to the functions you
want fo enable for the operator. Functions listed in this section
will vary from client to client, depending on how the system is
configured. If you have questions about the availability of a
function or the definition of a function, refer to the WinBridge
Configurator Manual.

8. Click the Insert butfon to save the new operator/supervisor
record. Or click the Update button fo update an existing
operator/supervisor record.

9. Click the Close button to complete this procedure.
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Tare

This fable stores tare values for vehicles. Each vehicle can have
more than one tare value. This form is used fo provide information
about fares, not to edit the data fields. Notice that there are no
Insert or Update buttons on the toolbar. Tare weights are entfered
using the Store Tare button on the Vehicle Processing screen (see

Chapter 7).
= TARE M=l E3
Table Data Edit
u“- % 0 % fit ] {f
Close Hew | Query | Table i
Vehicle Id:
Tare Id:
Cescription: | |
Expir. Date:  [22/0911999 0:
Consecutive: |U |
Scale |d;  |MAN Trailar:
| o [
Required Data Fields
Vehicle ID: A unique vehicle identifier.
Tare ID: A unique identifier for this tare type.
Tare: The fare weight of the empty vehicle.

Consecufive: The number of the current transaction. WinBridge
numbers each fransaction consecutively.

Scale ID: The identifier of the scale being used to measure
the tare value.

Optional Data Fields
Description: A description of the tare or vehicle.

Expir. Date: The date that the tare value for this vehicle
expires. If this field is left blank, the tare will
disappear the following day.
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Remarks

The Remark and Remark2 forms lef you add, edit, and delete
remarks o be aftached to a transaction.

E= REMARE H=l
Table Data Edit
[« g | <0 | B ¢ v 2= A
Close Hew Query | Table Insert | Update | Delete
Remark Id: I:I
Description: | |
Press "Queny” to retrieve informatiarn... | LM |

Required Data Fields
Remark ID: The primary key for this table.

Optional Data Fields

Description: Enter the remark that you want to appear on the
Vehicle Processing screen. Although this field is
noft required, we recommend that it be filled in at
all times.
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Groups
This form is used fo create groups of accounts (cusfomers or
suppliers), contracts, vehicles, carriers, or products. See Chapter 5
for an explanation of how to create groups and group presets.

E= GROUPS H= B
Table Data Edit
U_{- % [ % [ 0 i " +E = 1Y ifi
Close Hew | Query | Table ! Ingert | Update | Delete
—Type
Group_d: 1:| & Customer
Description: I  Caontract
ehicle
" Carrier
 Product
Press "Queny’ to retieve information. .. | |— """"" ML :_

Required Data Fields
Group ID: The primary key for this table.

Optional Data Fields
Descripfion: A description of the group.
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Badge and
Short Code

If WinBridge is used in unattended mode, the driver of a vehicle
can enter data at an unattended driver stafion with a badge or short
code. When the Unattended Module is instfalled, you can enable
this type of data entry by assigning a badge ID or short code and
linking it fo a vehicle, contract, account, or product.

The Table menu on the Vehicle Processing screen includes menu
items for enabling a Badge or Short Code. When you select one of
those items, WinBridge displays a submenu with the following
options: Vehicle, Contract, Account, and Product. Selecting one of
those options displays a Badge Administration or Short Code
Administration form. For example, selecting the Badge menu item
and then the Vehicle submenu item will display the Badge
Administration form shown below.

E= Badge Administration

Table [ata  Edit
B-| &0 B| | . | r = | 0| W
Close Hew | GQuery | Table 5 i Insert | Update | Dejete
Badage Id;
Yehicle:
Press "Bueny" to retrieve information.. | NOM [

All eight forms work the same way. Enter a badge ID (or short
code) in the datfa field, and then use the combo box to link it to a
vehicle, contract, account, or product.
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4 WinBridge Advanced Module

The WinBridge Advanced Module is an add-on software program
that provides additional capabilities.

Extended
Tables

The Advanced Module enables 15 additional fables that can be
used fo sfore information not found in the standard WinBridge
tables. Examples are authorization codes, product grade,
unloading areq, efc. To use these tables, open the Extended Tables
menu on the Vehicle Processing screen and select the desired
table. The form for Table 1 is shown below.

£ Table1 _[O] x]
Table Data Edit
¥ | & | |B| | .| | | -&]"]|"
Close New Query | Table Insert | Update | Delete
Tahle Id
Description:
Infat:
Info2
)
Info3: &
| | Fresets
Press "Quen' to retrieve information... | MUK

The extended tables confain the following fields:

Table ID 10 characters
Desctription 40 characters
Infol 50 characters
Info2 50 characters
Info3 50 characters
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Two of the data fields (Table ID and Description) are visible on the
Vehicle Processing screen. The Table ID can be selected by using a
combo box. Each fable can be set up so that both fields are used
or only the ID field is used. Your configurator can set up each field
that is used according to one of the following opfions:

e Opfional and verified (present in database) if inserted.
e Mandatory and verified.

»  Optional and not verified when inserted.

«  Mandafory and noft verified.

Expiration Date Validation

An expiration date can be assigned for each extended table. The
date should be entered in the Description field on the extended
table form in a YYYY/MM/DD format.

Each extended fable that has been enabled will be listed af the
bottom of the Vehicle Processing screen (see below). If you check
the Validate Date box for a fable, WinBridge will check the table’s
expiration dafe when a fransaction is processed.

| =] | | Table 1 validate Date
| =] | | Table 2 validate Date
| =] | | Table 3 ¥ validate Date
| =] | | Tabled

| =] Table 5 [~ validate Date
| = Table 6 I~ validate Date
| = Table 7 [~ validate Date
| = Table 8 I validate Date
| = Table 8 I validate Date
| = Table 10~ validate Date
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Carrier Table

When the Advanced Module is installed, the Carrier table becomes
one of the main fables. It will appear on the Vehicle Processing
screen and offer presefs and group presets functions.

Presets
When the Advanced Module is installed, WinBridge's Presefs
functions are added fo the Carrier, Container, Remark, Remark2,

Shipping Address, and extended tables. See Chapter 6 for an
explanation of how to use presefs.

Group Presets
When the Advanced Module is installed, a Group ID field will be
added to each of the main WinBridge tables. Group presets are
enabled from the Processing Parameters screen. See Chapter 6 for
an explanation of how fo use group presefs.

Converted
Weights

When the Advanced Module is installed, an additional field is
displayed on the Vehicle Processing screen, showing the weight
converted info another unit. The conversion factor and conversion
unit (visible on the screen) are stored in the Product table.
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Virtual
Indicators

You can process large vehicles that need to be weighed on more
than one scale by setting up a virtual indicator. The virtual indicator
lets you define a new indicator as the sum of two or more existing
indicators. Suppose that scales 1 and 2 are enabled. You can set
up the virtual indicator as scale 3, so that it displays the sum of
the weight from scale 1 and scale 2. Tickets can be printed to
indicate that the weight is from scale 3.

To set up a virtual indicator, select Virtual Indicator from the Scale
menu on the Vehicle Processing screen.

Yirtual Indicator SetUp

Virtual Scale Id: |I| &y

1st 2nd

4th

~|

¥ Enable Yirtual Indicator

TN

EANEY
Save Exit

1. Check the Enable Virtual Indicator box on the Virtual Indicator

SetUp form.

2. Enter a Virtual Scale ID number.

Use the T1st combo box to select the first scale (scale number
1, 2, 3, or 4) fo be summed by the virtual indicator.

4. Use the 2nd combo box fo select the second scale fo be
summed by the virtual indicator. The 3rd and 4th combo
boxes can be used if you want to sum more than two scales.

5. Click Save to save the virtual indicator setup.
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Advanced
Pricing

Advanced Price Definition m

v Enahle advanced pricing

The Advanced Pricing function lets you set up a complex price
sfructure. For example, you might want to charge a lower rafe
when larger amounts of a product are purchased. You can access
this function from the Product table and from the Confract Detail
table. That allows you to define an advanced pricing structure for a
product or for an individual contract. Click the Advanced Pricing
button to display the Advanced Price Definition form.

—Advanced pricing parameters
Unitprice (140 v
Max Price =
Step 1 |1DDD | |14D | 5
Step 2 [2000 N | Cancel
Step 3 |SDDD | |mn |
Step 4 |4DDD | |ED |
Step &
I~ Fixed price I~ Raw price

Base formula:

Clear Formula

NET*PR1

Check the Enable Advanced Pricing box. You can define up to five
steps by entering weight thresholds in the Max column. For each
maximum weight, define a unit price to be used within the weight
range. There are two ways fo define the price structure:

«  Fixed Price: The entire load will be priced using the value in
the Price column next to the weight range into which the load
falls. For example, a load weighing 2,000 pounds could be
priced af a fixed rate of $120 per unit.

»  Raw Price: A different unit price will be used within each of the
weight ranges. For example, $140 per unit might be charged
for the first 1,000 pounds, $120 per unit for the second
1,000 pounds, etc. The fotal price will be calculated
according fo this pricing formula.

(9/00) 4-5



METTLER TOLEDO WinBridge Software User Manual

Surcharges

Surcharges Id:

EEI Surcharges Definition

The Surcharges function lefs you set additional charges for a
delivered load. Surcharges can be assessed by fixed rate ($5), by
weight (85 per fon), by percentage of price (5% of price), or by
the piece (S5 per piece).

The Surcharges Definition form displays all applicable surcharges.
To reach this form, select Surcharges Definition from the Extended
Tables menu on the Vehicle Processing screen. Although no fields
are marked as required, all fields need to be completed for you to
use a surcharge. Enfries can be made directly in the fable or
chosen through the use of radio buttons and dafa fields. To delefe
a record, click on it with the right mouse butfon and then press the
DELETE key on the keyboard.

Type
 Fixed Ceight Walue:
© Percent  Pieces $12.00 il E
Iy Clear
v e
Description: Surcharge 1 ‘ ik Eit
Identifier Description Type Walue
1 Surcharge 1 FIZED 12
2 Surcharge 2 @ 5% PRICE 0.05
3 Surcharge 3 @ 100.00 per weigt WEIGHT 1
4 Surcharge 4 @ 10% PRICE 01
=5 Surcharge 5@ 1 piece PIECES 1
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Data Fields and Buttons
Surcharges ID:  Identifies the applicable surcharge.
Type: Choose one of the four radio buttons.
Fixed: A flat rate added to the transaction fotal.

Percent: A percentage of the tofal value of the
fransaction.

Weight: A dollar value entered per weight unit (for
example: $5.00 per Ib).



Value:

Descripfion:
Clear:

Exit:
OK:
New:

Chapter 4: WinBridge Advanced Module
Surcharges

Pieces: If Pieces is chosen as the unit of
measure, this type of surcharge would be a fixed
dollar amount per piece (for example: $.50 per
piece).

Enter the dollar value of the surcharge. This entry
depends on the type of surcharge chosen.

A brief description of the surcharge.

Clear any table entries that are marked with an
arrow (for example, surcharge #5 in the table
shown above).

Exit this screen.
Save any entry or modification.
Add a new entry in the table.

Surcharges are added to the price of the product after a vehicle has
been weighed but before accepting the transaction. To add a
surcharge, press the Surcharges button on the Vehicle Processing
screen. This displays the Surcharges Definition form. Double-click
on the desired surcharge (or surcharges) listed in the table. The
surcharge value will appear in the field next fo the Surcharges
button. The fotal price (with surcharges included) is also shown.
The surcharge is stored in the Add Price field of the Transaction

table.
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Sampling

Sampling is used for government or customer control of the quality
and quantity of materials being processed. Separate sampling
functions are available for the use of a governmental authority and
for the use of the customer. Both functions work the same way, but
they are independent and simultaneous. There are two basic ways
to sample a product:

«  Step sampling whenever a cerfain weight value or number of
loads is reached for a product, contract, or account.

*  Random sampling within a predefined quantity (for example,
taking a random sample for every 200 tons).

To display the Sampling Definition form, select Sampling Definition
from the Extended Tables menu or click the Sampling button on
one of the main WinBridge tables. Although no fields are marked
as required, all fields need to be complefed to define a sampling
operation. Entries can be made directly in the table or chosen
through the use of radio buttons and data fields. To delete a
record, click on it with the right mouse button and then press the
DELETE key on the keyboard.

Sampling Definition
Sample Id: Description: W/}‘H
‘ | | LA Sampling
Sample Made: INBOUND =] g | 0
MNewn Cuery
—3Sample Type Sample Unit Action
-
& Step & | pad ™ Ticket v N
Ok Exit
" Random Weight ™ Block Trans.
—Itern Type Threshold:
¢ Customer  Scale Itern: Trans Mo
Identifier Mode ltern ltern Type Unit | Type | Threshold |Block Ticket Description
Oak INBOUND  § OAK FRODUCT  LOADSISTEP 2 — [~ :0ak Log Sampling
Oak INBOUND § Oak FRODUCT WEIGH: RANDCG 2 [ [ iSampling For oak logs
4 »
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Data Fields and Buttons
Sample ID: An identifier for the sample.
Descripfion: A description of the sample.



Sample Mode:

Sample Type:

Sample Unit:

Action:

[tem Type:

Threshold:

Item:

Chapter 4: WinBridge Advanced Module
Sampling

Use the combo box fo indicate whether samples
will be faken from an inbound or outbound
vehicle.

Step: Choose this radio button if a sample is fo
be taken at a specifically set period (for example:
every 10,000 Ib or every 200 loads).

Random: Choose this radio button if a random
sample is to be taken within specific guidelines
(for example: any time between O and 10,000 Ib
or between 10 and 20 loads).

Load: Choose this radio button if the sampling is
to be done by number of loads.

Weight: Choose this radio button if the sampling
is to be done by weight.

Ticket: Check this box fo send the sampling
reminder to the printed ticket.

Block Trans.: Check this box fo block the
fransaction until the sample has been taken.

Choose one of the radio buttons to determine
how sampling will be done. If you select Product
and set a threshold of 10,000 pounds, a product
sample will be faken for every 10,000 pounds of
a product that is processed. If you select Account
and set a threshold of 10,000 pounds, a product
sample will be faken for every 10,000 pounds of
a product that is processed for an account.

Product: Sample by product.

Account: Sample by account.

Contract: Sample by contract.

Vehicle: Sample by vehicle.

Scale: Sample by scale.

\WB Station: Sample by WinBridge station.

The weight or number of loads at which a new
sample is to be faken.

The name of the product being sampled (the
primary key for this table).

Government sampling is set up from an external program and is
password protected. Only authorized personnel can enter the setup

procedure.

Whenever sampling is called for, the Sampling Event form appears
on the operafor's computer screen indicating that the current load
needs to be sampled. If the system is set up to block the
fransaction until a sample has been taken, you will need to enfer a
sample result and click OK.
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W_’Jddnmcsd
_."j"' Sampling
PRODUCT:

The following entity must be sampled: |SAND

The transaction will be completed and later on you can insert
sampling result in sampled transaction table, using transaction
browser.

Sampling Result:

.

/-
A Cancel

The sampling function can be sef up for the following actions:

e A special ficket is printed (a standard ReportWindows ticket
with a fixed name: Sampling).

e The results of the sampling can be infroduced in the Sampling
field in the Extended Transactions table (alphanumeric 30).

«  Two-passage transactions are suspended until the sampling
resulf is infroduced. Suspended transactions can be retrieved
by searching all open fransactions.

To add the sampling result, use the fransaction browser or use the
import utility with the following field order: (1) Result Field, (2)
Owner Field, (3) Sample ID, (4) Transaction Number.

4-10(9/00)
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Groups and Group Presets

WinBridge helps you manage your weighing operations more
efficiently by enabling you to create groups and group presets. You
can define groups and group presets for records in the Account,
Vehicle, Confract, Carrier, and Product tables.

e AGroup is a setf of records in a WinBridge table that are linked
together because they are all related to a record or records in
another WinBridge table. For example, you might creafe a
group of vehicles in the Vehicle table that are used by a
particular account in the Account fable.

e A Group Preset is a link between a group and records
belonging to another table. For example, a group of vehicles
can be linked to the account that uses those vehicles.

If you have a large WinBridge database, your operafors will need
to search through long lists of records when entering datfa for
fransactions. Groups and group presets can speed up fransactions
by limiting the number of choices available to an operator. For
example, if a particular vehicle is used by only four accounts, the
operator will not need to search through a list of all accounts in
your database when that vehicle arrives to begin a transaction.
Instead, the operator can simply choose from a list of the four
accounts linked fo the vehicle.

This chapter contains an example that shows how to create groups
and group presets. The procedure involves three steps:

1. Create two or more groups.
2. Add records to the groups.
3. Link the groups.
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Creating a
Group

Suppose Roberts Construction owns five vehicles and has three
subsidiary contracting companies that use the five vehicles to haul
gravel from your quarry. You want fo be able to bill the three
companies separately while allowing them to share the five
vehicles.

Begin by creating an account (customer) group for the three
contracting companies.

1. From the Vehicle Processing screen, open the Table menu
and select the Groups table.

B crouPs _[O] x|
Table Data Edit
B | & |0 ([B| .| .| | ]| =7 |"
Close Hew Query | Table Insert | Update | Delete
~Type
Description | © Contract
Yehicle
" Carrier
 Product
Fress "Clueny" to retrieve information... | MUK

2. Type the group name (ROBT) in the Group ID field.

3. Inthe Description data field, enter a description of the group
(this data field is optional).

4. Select the Customer (account) radio button in the Type
section to define the type of group you are creating.

5. Click the Insert button fo create account group ROB1.

5-2 (9/00)
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Adding Records
to a Group

Next, add the three subsidiaries of Roberts Consfruction o the
group that you created. Records for these three companies must
exist in the Account fable before you can add them to the group.

1. From the Vehicle Processing screen, open the Table menu
and select the Account table.

2. Locate the record for the first subsidiary (Anfique
Construction) and display it on the Account form.

3. Click the Groups butfon to display the Account Group Setup

form.
ACCOUNT GROUP SETUP _ O] x|
Table Data Edit
| & | 0| BE O P (v € | 0| @
Close Hew Query | Table Insert | Update | Delete
Account_ld
A
Group_Id: E’
Group Presets
| MUK

4. The ID for Antique Construction (ANT1) will appear in the
Account ID data field. Use the combo box in the Group ID data
field to select the desired account group (ROB1).

5. Click the Insert button fo add the account fo the group.
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Return to the Account table and follow the same procedure fo add
the other two subsidiary companies to the account group. When
you are finished, you should have created an account group with
three members (as shown in the diagram below).

Roberts Construction
Group Name: ROB1

T

Antique Baroque Cosmopolitan
Construction Construction Construction

Create a Vehicle Group

Once you have complefed the account group, create a vehicle
group (ROBVEH) and add Roberts Construction’s five vehicles fo it.
Follow the same procedure thaf you used fo create the account
group and add records to it. The completed vehicle group is shown
in the diagram below.

Roberts Vehicle Group
Group Name: ROBVEH

T 1 1

VEH1 VEH2 VEH3 VEH4 VEHS

5-4 (9/00)
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Linking Groups

Once you have created the two groups, you can link them so that
they can be used as presets.

1.

From the Vehicle Processing screen, open the Table menu
and select the Account table.

2. Locate the record for one of the accounts that you added to
the ROB1 group and display it on the Account form.

3. Click the Groups bufton to display the Group Setup form.

4. Then click the Group Presets button to display the Group
Presets form.

§S GROUP PRESETS _[O] x|
Table Data Edit
Qe C +0 B G y i [t =] A1 il
Close New Query | Table Insert | Update | Delete
Contract: ‘ j|
Vehicle:
Account
Product: ‘ j|
Carrier: j|
[T NoM

5. The account group will be shown in the Account data field. In
the Vehicle data field, use the combo box to display the
vehicle group (ROBVEH) that you want o link fo the account
group.

6. Click the Insert button to create the preset for the account
group. You need to complete this procedure for only one of
the three accounts.

7. Follow the same procedure for the vehicle preset. In the

Vehicle table, choose one of the grouped vehicles, click the
Groups button, and then click the Group Presets button. In the
Account data field, select the account group fo be linked, and
then click the Insert butfon. This completes the linking
process.
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Using Group

Presets

The presetfs can be used fo speed up transactions. When you begin
a transaction for one of the Roberts Construction subsidiaries, enter
its Account ID in the appropriate data field on the Vehicle
Processing screen. Normally, you would use the Vehicle data
field’s combo box and scroll through a list of all the vehicles in the
dafabase to select the correct vehicle.

You can simplify the process by using the group presets. After
enfering the Account ID, place the cursor in the Vehicle data field
and click the right mouse button (or press the F2 key). A fable like
the one shown below will appear on the screen.

Yehicle Id Cescription Info hlax Legal Weight | Min Legal Weight
WEHT1 Roherts Const 40000 3000
WEHZ Roherts Const 40000 3000
WEH3 Roherts Const 40000 3000
WEH4 Roherts Const 40000 3000
WEHS Roherts Const 40000 3000
KNI L

5-6 (9/00)

The table limits your choices fo the five vehicles in the vehicle
group that you have linked to the account.
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6 Operating WinBridge

Processing
Transactions

A transaction can involve one-pass or two-pass weighing.

e One-pass weighing: Weigh a loaded vehicle and then enfer a
sfored tare or manual fare to determine the net weight of the
product being shipped or received.

«  Two-pass weighing: Weigh a vehicle once when it is empty
and once when it is loaded fo determine the net weight of the
product being shipped or received.

Choose the desired method with the One/Two button on the Vehicle

Processing screen’s foolbar.

Program  Edit Table Extdtables Report/Ticket Database Scale Tools Help

o= |

|
~Vehicl = =
“ ﬂ‘ | | Tare weight Load!
kg
o g T @ |
Only n Loadd
o | | = | ‘ P T I [ = Loadd
~ Customer i~ Contract
| El oo o [ ] o
[ Product o
tax1 tax2 Kocept | |[Ehmpiie Clear
“Amount toeat
Loadd
Surcherges Saclll
 Transaction
In kg Discount Tax1 Daily deli. Wt
out g Tax2
I =]
\—Ij Net kg Total I:l
Carnpany Id =] ‘ ﬂ‘
Carrir It \ =]

\—L” I—l Table 1 [~ validate Date -
Ll | }

[ how|
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6-2 (9/00)

One-Pass Weighing

1.

When a vehicle arrives at the scale, enfer the information for
the transaction in the dafa fields on the Vehicle Processing
screen. For a typical transaction, you will need to enter a
vehicle ID, account ID, product ID, and contract ID (if
enabled). There are several ways to enter data:

«  Type values in each field.
»  Select values from the combo boxes.

e Place the cursor in a field and click the Search button to
display the fable relafed to that field. To select a record
from the table, double-click on it or use the up and down
arrow keys fo highlight it and then press the ENTER key.

«  If presefs have been defined, enter the ID for the primary
key in the appropriate data field. Then click the Preset
button to enter the preset values in the other data fields.

Press the TAB key (or use the mouse) to move from one data
field fo the next. When you move the cursor, WinBridge
validates the data that you just entered. If an entry is not valid,
an error dialog box will appear, and you will need to correct
the entry before proceeding.

\When one-pass weighing is used, WinBridge determines the
operating mode (Ship or Receive) by reading it first from the
Contract table (if enabled). If the Confract table is disabled,
WinBridge searches the Vehicle fable. If the operating mode in
the Vehicle table is Either, WinBridge searches the Product
table.

The stored fare for the vehicle appears in the In field for
shipping and in the Out field for receiving. You can manually
override the operating mode by selecting Ship or Receive from
the combo box in the Transaction data group.

When all the required (yellow) data fields have been filled in,
click a Scale button on the foolbar fo select the scale that the
vehicle is on and fake a weight reading. If the weight is to be
enfered manually, click the Manual button and enter the
weight when prompfed. The net weight will be shown in the
Transaction data group.

If surcharges need to be added to the price, click the
Surcharges button in the Amount dafa group. The Surcharges
Definition screen will appear. Double-click on the desired
surcharge. Click the Compute bufton to recalculate the price.

Click the Accept button fo complete the transaction by
accepting the data displayed on the Vehicle Processing
screen. A record of the transaction is saved to the database,
and a ticket is automatically printed or stored.
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Two-Pass Weighing

For two-pass transactions, WinBridge monitors the IN and OUT
weights fo defermine the operafing mode (ship or receive).

1.

When a vehicle arrives at the scale, enter the information for
the fransaction in the data fields on the Vehicle Processing
screen. For a typical transaction, you will need to enter a
vehicle ID, account ID, product ID, and contract ID (if
enabled). There are several ways fo enter data:

e Type values in each field.
*  Select values from the combo boxes.

e Place the cursor in a field and click the Search buffon to
display the table relafed fo that field. To select a record
from the table, double-click on it or use the up and down
arrow keys fo highlight it and then press the ENTER key.

e If presets have been defined, enter the ID for the primary
key in the appropriate data field. Then click the Preset
button to enter the preset values in the other data fields.

Press the TAB key (or use the mouse) to move from one data
field to the next. When you move the cursor, WinBridge
validates the data that you just entered. If an entry is not valid,
an error dialog box will appear, and you will need to correct
the entry before proceeding.

When all the required (yellow) data fields have been filled in,
click a Scale button on the foolbar fo select the scale that the
vehicle is on and fake a weight reading. If the weight is to be
enfered manually, click the Manual button and enter the
weight when prompted.

Click the Accept button fo accept the weight and data that you
entered. This information is stored as an open transaction
until the vehicle returns for a second pass over the scale.

When the vehicle refurns, click the Transaction button and
double-click the appropriafe open transaction (or select the
Vehicle ID and move the cursor fo another field to display the
corresponding transaction on the screen).

Click the Scale (or Manual) button again to enter the weight.

If surcharges need to be added to the price, click the
Surcharges button in the Amount dafa group. The Surcharges
Definition screen will appear. Double-click on the desired
surcharge. Click the Compute bufton to recalculate the price.

If additional weighings are required for the transaction, click
the Continue butfon and repeat steps 4 and 5.

Click Accept to complete the transaction. A record of the
transaction is saved to the database. A ticket will be generated
(or stored) if the Vehicle fable’s ticket option is sef.
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Presets

Presetfs are used to speed up transactions by reducing repetitive,
manual dafa entry. Suppose a vehicle always carries the same
product for the same account. You can define presets that link the
vehicle fo the account and product. Once the presets have been
defined, you can automatically insert account and product
information in the Vehicle Processing screen’s data fields by
clicking the Presets butfon when you process a transaction for the
vehicle.

Creating Presets

6-4 (9/00)

Choose one of the main tables (Confract, Vehicle, Account, and
Product) fo use as a primary key (the starting point for the
presets). The Vehicle fable is usually the best choice.

NOTE: All values must already exist in their respective tables in
order for this procedure to be completed successfully.

1. Choose the desired main fable from the Table menu.

2. Enfer the new record or, if you are setting presets for an
existing record, query the database for that record.

3. Click the Presets button to display the Presets screen shown
below. The ID that you selected as a primary key will appear
in the appropriate data field.

4. Select the desired preset values from the combo boxes.

5. Click the Insert butfon to save a new preset record. Click the

Update butfon to save changes fo an existing preset record.
Then close the fables.
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Presets
B2 PRESETS _[O] x]
Table Data Edit
[ 5 210 I
Close Insert | Update | Delete
Contract Id: || =] Tahled Id:
Product et [coR El Tabledl:[  ~]

I
E‘

Using Presets

1. Place the cursor in the Vehicle Processing screen data field
that was chosen as the primary key (for example, the Vehicle
ID field if the Vehicle fable was the starting point for creating
the presef) and enter the appropriate ID.

2. Click the Preset button.

All the information currently stored in the presets will be
entered in the appropriate data fields on the Vehicle
Processing screen. Except for the primary key, these enfries
can be manually overridden for a fransaction.

If Automatic Preset is enabled in Processing Parameters, the
presets will be entered aufomatically without clicking the Preset
button. Simply enter the ID that you used as a primary key in the
appropriate dafa field. As soon as you move the cursor to another
field, the presetfs will appear.
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Storing Tare

Weights

You can stfore a tare weight for a vehicle and use it when

processing one-pass weighing transactions.

1. To store a fare weight, select a vehicle in the vehicle ID field of
the Vehicle Processing screen.

2. Then move the cursor to another field. If a record for the
vehicle exists in the dafabase, the Store Tare button becomes
active. The Vehicle data group (shown below) will display
tare information. If more than one tare weight is stored for a
vehicle, use the scroll bar below the Tare Weight data field to
select the appropriate tare weight.

Wehicle T aht

- are weiyg
|veH123 R | = v [ o] o
cont = win m 9000| Truck . ?

3.

Click the Store Tare butfon on the Vehicle Processing screen to
display the Tare form shown below. The box on the left lists
the scales that are enabled.

Tare m

1 5000
MAN 5

Use Virtual Indicatar |

v A
Ok Cancel

6-6 (9/00)

If you want to enter a tare weight manually, highlight MAN in
the list box and enfer a fare weight in the data field fo the
right. Then click the OK button.

If you want to weigh an empty vehicle and store that weight
as a tare, highlight the number of the scale on which the
vehicle is currently being weighed and then click the OK
button. The fare weight will be entered automatically.
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5.  When you click the OK button, the Tare Setup form will
appear. Make sure that the fare information is correct. Enter a
Tare ID and the number of days (Duration Days) for which the
fare will be saved. Then click the Save button to save the
values and insert them in the Tare fable.

Tare Setup !
Vehicle: (100 /8
Save
Tare Id: P
Tare; 5000

e

Duration Days: Cancel

Description:  |Tare weight of empty truck |

6. If you click the Use Virtual Indicator bufton on the Tare form,
the following form will appear to show you the tare weights
for the scales that are being summed by the virfual indicafor.

Virtual Indicator Tare
First WWeight [
Secaond VWeight
Third Weight
Fourth Weight

v A
Ok Cancel
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Printing Reports

and Tickets

Print Report

The Report/Ticket menu on the Vehicle Processing screen provides
access fo a list of reports that have been configured for printing.

Select Print Report from the Report/Ticket menu fo display the form
shown below. It lists the name and description of each existing

report.

Report Marme | Description |

VB S00001

COMPLETED
CUSTOMERS
DALY REF
TRAN-PRCD
OPEN
FRODUCT
S3mO0002
WEHICLE
COMMA,
CONTRACT
CARRIER-CO
COMPANY

Transactions by Customer/Mat. -~
il File Listing 3
List of completed transactions
Customer File Listing
Transactions by Customer/Prod
Transactions by Product

List of Open Transactions
Product File Listing
Transactions by Customer/iat.
Printaut of Vehicle table
Comma deliminated report
Contract Listing

Transactions by Carrier

Company listing ~

ToFile

6-8 (9/00)

1. Highlight one of the existing reports.

2. Click the Print button to produce a paper copy of the ficket,
click the View button to display it fo your computer screen, or

click the To File button fo output the report o a file.




Standard Reports
The WinBridge program provides a selection of standard sample
reports that you can use. If the Report Module is installed, you can
customize reports to meet your specific needs. Standard reports are
listed in the following tables.
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Standard WinBridge Reports

Report Name

Description

Fields Included

CARRIER Carrier file list Carrier ID, Name, Address1, Address?2,
City, State, Zip, Country, Phone, Fax
CASHREP Cash report by operator Transaction #, Account ID, Product ID,
Remark, Transaction Tofal, Deposit
Received
COMMA Comma delimited report Account, Product, Vehicle, Wt, Status
(EDI)
COMPANY Company file list Company ID, Name, Address1, Address2,
City, State, Zip, Country, Phone, Fax
COMPLETED Completed fransactions Transaction #, Vehicle, Account ID,
Material, Date/Time, In Wt, Out Wi, Net Wt
CONTRACT Contract file list Contract ID, Account ID, Other ID, Info,
Description, Enabled, Initial Stock, Initial
Date, Expiry Date
CUSTOMERS Customer file list Account ID, Account, Ticket In, Ticket Out,
Type, Payment, Phone, Contact, Credit Left
CUSTPROD Date-specific daily report | Transaction #, Vehicle ID, Remark,
sorfed by customer and Date/Time, Wt, Amount, Discount,
product Surcharge, Tax1, Tax2, Deposit, Balance
DAILY REP Transactions sorted by Transaction #, Vehicle ID, Remark,
customer and product Date/Time, Wi, Amount, Discount,
Surcharge, Tax1, Tax2, Deposit, Balance
DAYREP Deposit report sorfed by Transaction #, Account ID, Product ID,
operator Remark, Transaction Tofal, Deposit
GRAPH List of completed Transaction #, Vehicle ID, Account ID,
fransactions Material, Date/Time, In Wt, Out Wi, Net WH.
MULTI Mulfiweigh ficket Transaction ticket information
OPEN List of open fransactions In Date, Vehicle, In Wt, Transaction #
PRODUCT Product file list Product ID, Description, Price Formula,
Unit Price
PAGEBREAK Transaction report with Account, Product, Transaction, Date, Net

page break per customer

Wt, Operation, Total Amount §
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SSM00002 Transactions sorted by Account, Product, Transaction, Date, Net
account and product Wi, Operation, Total Amount
TOT-VEH Vehicle fotals with Transaction #, Transaction, Date, In Wi, In
average weight Scale, Out Wt, Out Scale, Net Wt
TRAN-PROD Date-specific fransaction Product, Account, Transaction, Date, Net
report sorted by product Wi, Operation, Total, Deposit, Balance
TRANSACTIO Date-specific fransaction Transaction #, Company, Account,
report sorted by product, Vehicle, Product, Net Wt, Date
company, contract,
account
T.SAMPLE Sample ticket with pricing | Transaction ticket information
T.SAMPLE?2 Sample ticket without Transaction ficket information
pricing
T.SAMPLE3 Sample ticket without Transaction ticket information
pricing and container
UNDOIN Report for modified Transaction Ticket Information
fransactions
UNDOOUT Report for modified Transaction Tickef Information
fransactions
VEHICLE Vehicle file list Vehicle ID, Description, Tare ID, Tare Wt
\WBS00001 Transactions sorted by Account, Product, Transaction, Date, Nef
account and product \Wt, Operation, Total Amount
WEEKREP Transaction search report | Transaction #, Company, Customer,
Vehicle, Product, Net Wt, Date
WORKREP Transaction search report | Transaction #, Company, Customer,
Vehicle, Product, Net Wt, Date
INVOICE Invoice export file for Transaction, Transaction Type, Invoice
Quickbooks Title, Invoice Memo, Document #,
Account, Amount, Name, Address, Terms,
Price, Quantity
X-CUSTLIST Customer setup file for Customer, Name, Address, Phone, Fax,
Quickbooks Contract, Limit
X-ITEM/ACC Item account setup file for | Account, Name, Account Type, Invoice

Quickbooks

[tem, Invoice Item Type, Description, Price
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Report Name

Description

Fields Included

CONTRACTOR | Contractor file list Contractor ID, Description

CUTBLOCK Cut block file list Cut Block ID, Description

DECK Deck/Yard file list Deck/Yard ID, Description

DESTIN-FOR Destination file list Destination ID, Description

MILL Mill file list Mill ID, Name, Address1, Address2, City,
State, Zip, Country, Phone, Fax

SPECIES Species file list Species ID, Name, Infol, Info2

STRATUM Stratum file list Stratum ID, Description

TIMBERMARK | Timbermark file list Timbermark ID, Description

TRANS-FOR Date-specific fransaction Transaction #, Mill, Contractor, Truck,

report sorted by stratum,
mill, contractor, and fruck

Stratum, Net Wt, Date

Agriculture Reports

Report Name

Description

Fields Included

GRADE Product grade file list Product Grade ID, Description
SILO Silo location file list Silo Location ID, Description
UNLOAD Unload area file list Unload ID, Description

Aggregate Reports

Report Name

Description

Fields Included

CARRIER-CO

Date-specific transaction
report sorted by carrier

Account, Product, Confract, Transaction,
Date, Net Wt, Operation, Total Amount $

Sand and Gravel Reporis

Report Name

Description

Fields Included

D.METHOD Delivery method file list Delivery Method ID, Description
D.SITE Delivery site file list Delivery Site ID, Descripfion
D.ZONE Delivery zone file list Delivery Zone ID, Description
GRADE Product grade file list Product Grade ID, Description
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Concrete and Asphalt Reports

Report Name

Description

Fields Included

BATCHID

Batch ID file list

Batch ID, Description

PRODINFO

Product Information file
list

Product Information, Description

Waste Reports

Report Name

Description

Fields Included

DESTIN

Destination file list

Destination ID, Description

ORIGIN

Origin file list

Origin ID, Description

Landfill Reports

Report Name

Description

Fields Included

CELL.LOC

Cell location file list

Cell Location, Description

Recycling Reports

Report Name

Description

Fields Included

GRADE

Product grade file list

Product Grade ID, Description

Recycling, Transfer Station, MERF/RRF Reports

Report Name

Description

Fields Included

DEL-LOC

Delivery location file list

Delivery Location, Description

UNLOAD

Unload area file list

Unload ID, Description
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The Multi Report Tag function lets you define and store print
operations that include more than one report. Select Multi Report
Tag from the Report/Ticket menu to display the Multi Tag Reports

form.
Multiple Tag Reports m
Multiple Reports Identifier: | j|
—Destination
Report Mame | Description
WWESO0001 Transactions by CustomeriMat. & Print
MILL Mill File Listing
COMPLETED  List of completed transactions  Wigw
CUSTOMERS  Customer File Listing
DALY REP Transactions by Custormer/Prod  TaFile
TRAN-PROD  Transactions by Product
OPEN List of Open Transactions
PRODUCT Product File Listing
55mMo000z2 Transactions by CustomeriMat.
WEHICLE Printout of wehicle table
COMMA Comma deliminated repart
CONTRACT Contract Listing
CARRIER-CO  Transactions by Carrier
COMPANY Company listing
Execution
v
& Immediate " Delayed  End of Day Operations BEun
Cancel

1. Inthe combo box, assign a Multiple Reports ID for the

operation you are defining.

2. Inthe list box, highlight the report(s) you want to run.

3. Select a Destination: Print to print the report, View to view it on
the computer screen, or To File to output it to a file.

4. Select an Execution time for running the report: Immediate,
Delayed (specify a date and fime in the data fields), or End of

Day Operations.

5. Click the Run button to run the report at the specified fime.
6. Click the Save bufton fo store the operation that you defined.

(9/00) 6-13



METTLER TOLEDO WinBridge Software User Manual

Print Ticket

To print a ticket aufomatically when a transaction is accepted, you

need to (1) enable the Print Ticket processing parameter and (2)

select a ticket format. You can select a format for inbound and/or

outbound tickets on the Account table form. You must select a

format for each account that you want to print tickets for. You can

also print a ticket for a fransaction by selecting Print Ticket from the

Report/Ticket menu. The form shown below will appear.

Print Ticket
~Transactian In Date «0 5
T
S, R & Today Query Clear
Yehicle [d: I:l  Yesterday
; " ul-
Campary 1d: I:I « Spectty Ok Exit
Al —
HEEBLITTE: Actual Date: 7 A
Product 1d: | | |16—.Jun—1999 | void | Modify
Contract Id: I Ticket #on @
o - ¥ Correct
= |2 ampled T [~ Mo_Ticket in out s
— Transaction Status 5
@Al O Completed  © Open  taodified ¢ Exported Prrint
Tranzho “ehicleld | Status| Containerd Tare Id Companyld | Accountld | Productld Contractid
156 WEH123 C * PO1 BC22
158 100 C * 1 cm o1 PO1 BC22
159 WEH123  iC ] Kot PO B2z
4 »

1. Enter IDs in the dafa fields and set the radio butfons fo qualify
your search for the transaction you want to print.

2. Then click the Query button, and any transactions that meet
your qualifications will be displayed in the fable af the bottom
of the form.

3. Highlight the desired transaction and click the Print button.

Last Ticket
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Select Last Ticket from the Report/Ticket menu fo reprint the ficket

associated with the most recent transaction.
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Managing the
Database

The Database menu on the Vehicle Processing screen allows you
to backup the WinBridge database, export data from the database,
and import data to the database.

Backup

Select Backup from the Database menu to display the Backup form.

Backup

B

WBRIDGEG B O

Backup Exit

—Backup To

Directaries:

£ dos

£ mt

3 acrobat3
3 adobeapp L= |
£ atimach
£ averywiz

£ framem™1.5

£ license | |
£ msoffice

£ multim™1
£ mydocu™1 | |

Dirives:

‘ = c: mz-doz_b j‘

— File:

Date:

¥ Cwenwrite existing file

Use the combo box to choose the drive and the list box to
choose the directory in which you want to place the backup
file.

Click the Backup button to begin the operation. WinBridge will
automatically save the file with a *.BKP extension.

To find out when the database was last backed up, click the View
button.
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Export
You can export entire tables or individual columns of a fable for
use in accounting programs or other software. Select Export from
the Database menu to display the Select Table form.
Select Table
| TRANSACTION -

STATUS - TRAMS_MNO

COMTAINER_ID

COMPANY_ID = |

ACCOUNT_ID

PRODUCT_ID T

CONTRACT_ID - |

OPERATION

REMARK ;I

SHIP_ID

PAYMENT

WT_LINIT == |

TARE_ID

COMTAINER_TARE

IM_SCALE -

v IS
Exit

i

Clear

[
o
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Use the combo box af the top of the form to select a fable. The
table’s columns will be listed in the window on the left.

Highlight the columns that you want fo export and use the >
arrow button to move them tfo the window on the right.

Click OK fo export the columns listed in the window on the
right.

The Export File window will be displayed. Specify the name of
the file and the directory in which you want to save the
exported data. Then click OK. The function produces two files:
a file (with a *.EXP extension) for the description of the
columns and a file (with a *.DAT extension) for the actual
datfa.

< The fransactions files are Exptrans.exp and
TYYYMDD.dat.

<  The extended transactions files are Exidira.exp and
ETYYMDD.dat.
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Export File
File Hame: Directories:
;m | |c:\whlidge |

= Cancel I
[ [
3 whridge Network__. i
List Files of Type: Dniwes:
Impo/Expo Info Files :_i i = ¢ ms-doz_6 :j
Import

This is the reverse of the export procedure. When you select Import
from the Database menu, the Open Import Info File window
appears. You have to choose the description file (*.EXP extension)
and the data file (*.DAT extension) to import the data from an ASCII
file info the WinBridge database.

Open Import Info File
File Mame: Directories:
|m | | c:whbridge |

3 Cancel ;
e
{23 whridge Network. .. !
List Files of Type: Drives:
Impo/Expo Info Files _:i I = ¢: me-dos_b ;!
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Global Import

and EXpOI‘T
This function allows a supervisor fo import or export all the
database tables at once. Select Global Import or Global Export from
the Database menu.
Global Import
Do not import the fallowing takles: in
‘Xo Elpsafsy s
[ Counter
[~ Parameters W P4
Ok Cancel
[ Delete tahle hefare Import
On both the Global Import and Global Export forms, you can
choose not to import/export Transaction, Counter, and Parameter
tables (refer to the WinBridge Configurator Manual for more
information about these fables). The export operation generates an
ASCII file that contains all the fables in the dafabase.
I
Database
Speed

After you have processed many transactions, the WinBridge
dafabase can slow down. To speed up a slow dafabase, re-index it
by running the Whbstrpr.exe file in the WinBridge directory. At the
“Are you using Network Database Configuration” prompt, click Yes.
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Managing
Transactions

Transaction
Status

WinBridge automatically creates a record of each fransaction that
you process. It helps you manage these records by keeping track
of the status of each transaction and by enabling you to modify,
void, and export transactions.

The current status of each transaction is indicated by the following
stafus codes:

A Active or open transactions (only the first weighing has
been made). These fransactions are kept in the database
no matter how old they are.

c Completed or closed transactions (fwo weighings have
been made). These transactions will not be erased from the
dafabase, even affer the maximum number of days.

X Completed transactions that have been Exported. Because
these transactions have been copied to an export file
(*.DAT), they will be erased from the database after the
maximum number of days.

M Transactions that were Modified with the Modify function
(some data were corrected in the transaction). These
changes have also been logged in the W&M log file.

Y Modified fransactions that have been exported. When they
are imported back into the database, the Y stafus
distinguishes them from completed transactions.

Vv Transactions that were Voided with the Browse & Void
function.

w Voided transactions that have been exported. When they
are imported back into the database, the W status
distinguishes them from completed transactions.

Transactions with a 'V, M, X, W, or Y status are kept in the
dafabase until the number of stored days expires (specified in the
Processing Parameters screen).

Statuses W and Y avoid confusion when you import fransactions
back into the database fo run reports on them.
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Modifying
Transactions
Modifying a fransaction creates a new fransaction number. The
status of the old transaction number will be changed to M
(modified). Select Transactions from the Tools menu on the Vehicle
Processing screen. Then select Modify Transaction from the
submenu to display the Modify Transaction form.
—Transaction In Date =
Trans. Mo ] e
C Today Cluery Clear
v [
& Specify
Company Id: I:' Ok Esi
Al
Account Id I:l Actual Uate: 5 o
s gl
Product Id | | |16—Jun8—99| void || Modify
Contract Id I I e 5,
2 % (i Wiy Correct
I Szl Ed I~ HE_Ticket e —
. Transaction Status o
Al  Completed © Open Clmdified CiEnarted Brint
TransNo  |WEIGHMENT! “ehicleld | Status Containerld|  Tare Id | Companyld Accountld | Productld Ca|
3 WEH1 [ 2 ACCT1 WYHT + |
4 2 WEH1 o 1 ACCT1 RYE +
5 ] WEH1 [ 1 ACCT1 WWHT +
5} 1] WEH1 [ 1 ACCT1 COR +
7 3 WEH1 [ 1 ACCT1 WWHT +
8 1] WEH1 [ 2 ACCT1 COR + |-
. 3|

1. To qualify your search for the fransaction that you want to
modify, enter a transaction number, enter IDs in the dafa
fields, or set the radio buttons.

2. Click the Query button to display the results of the search in
the table af the botfom of the form.

3. Highlight the transaction that you wish to modify, and then
click the Modify button.

4. Information about the transaction will be displayed in the data
fields on the Modify form. Change any of the dafa in the
yellow fields. You cannot make changes fo the blue fields.

The Modify form lets you view the individual weighings for a
multi-weigh transaction. Use the Prev and Next buttons to
scroll through the weighings.
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~Weight s
Transaction: | WWeighments: 1 SN
Account: _ACCT1 ﬂ
i~ Contract i~ Vehicl Froduct: COR ﬂ
Legal Vweight
VEH1 j Min ko . [Booo
~Account Max I:l kg out (5000
[AcCTI iz | || Tare 2/000.00] iq Net:  [2000
Shipping Address - Container i~ Pricing
| Jl | j| " Amaount [4,000.00
e g
Tax1: [$0.00
 Product - Ameunt -
roduc moun Tax2: [$0.00
vET $6,500.00
|—ﬂ‘ I—‘ I—‘ % Surcharge:  [$0.00
Add Price $0.00
PriU 1.00| Pieces 1} Total: [$4,000.00
| i ‘ | ‘ Discount Tax 1 $0.00
Discount:  |0.00%
-~ Transaction 0.00% Tax 2 $0.00
Pieces:
In Scale n 4,000.00 kg o — D
era Total $6,500.00] | 1
ut Seale -w 4,500.00 z
Qut i kg I_I
: I

8
Net 500.00 !
kg Modify

=

o i
Ticket ||

Check

7

A4

Prev Next

5. Click the Check button to make sure the changes are
permitted.

6. To save the changes, click the Modify butfon.

7. To confirm the process, click OK when the prompt appears.
8. Click the Exit buttons fo close both Modify forms.

When you modify a transaction, the record for the original
transaction is kept in the database with an M status (fo indicate
that it has been modified).

A new record (with a new fransaction number) is added fo the
database. It has a C (complefed) status and includes the changes
that you made.

NOTE: You can modify the following fields by entering the changes
in the table at the bottom of the Modify Transaction form: Remark,
Remark2, Spare 1 to Spare 6, Corrected Weight, Corrected Price,

Carrier, Table 1 1o 15 ID, Table 1 fo 15 Description, and Sampling
Results.
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Voiding
Transactions

You can void a fransaction that has not been completed. Select
Transactions from the Tools menu on the Vehicle Processing
screen. Then select Browse & Void fo display the Transaction

Browser form. Completed fransactions can be modified but cannot

be voided.
Transaction Browser
~Transaction In Date < -
manso [ ]
& Today Query Clear
~ ; 1/ Uj-
Company Id: I:l Sy Ok Exit
Al =
Actual Date: X 0
Product Id: | | |16—Jun—1999 | Woid Ifodify
Contract Id: I Ticket e &,
@[] Ll Wiew | Correct
™ Sampled Tr. = inket
—Transaction Status L
Al  Completed  © Open  Modified ¢ Exported Print
Transho | “ehicleld | Status| Containerld Tareld | Companyld | Accountld | Productid Contractid
186 WEH123  iC * [ony] PO B2z
157 100 PO BC22

WEH123

C %

Ko
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1.
you want to void.
2. Click the Query button fo display the results of the search in
the fable at the bottom of the form.
3.
the Void button.
4. To confirm the process, click OK when the prompt appears.
5.

Enter a transaction number, enfer IDs in the data fields, or set
the radio buttons to qualify your search for the transaction that

Highlight the transaction that you wish to void, and then click

Click the Exit butfon to refurn to the Vehicle Processing screen.
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You can change an invoiced price by applying a correction factor
to the net weight.

Weight Correction

1.

Select Transactions from the Tools menu on the Vehicle
Processing screen. Then select Weight Correction Factor fo
display the Transaction Browser form.

Enter IDs in the data fields or sef the radio buttons to qualify
your search for the transaction that you want to correct. Then
click the Query button fo display the results of the search in
the table af the bottom of the form.

Highlight the tfransaction that you wish to correct, and then
click the Correct button to display the Weight Correction form.

—Current Value
Trans. na:

Vehicle Id:

Contract Id

Accaount ld:

Product Id: [COR

T+ ==
9] m
b T
g =

-

;
$2.00 ; Total: [$4,000.00
Prev Mext

Weighments: Met Weight 2000 kg
Amount [$4,000.00
Surcharge $0.00
Weighment Tax 1: ($0.00
L Tax 2 ($0.00

Unit Price
~ Carrection . Corrected Yalues
VALIEhEE Amount: I:I Corrected Weight
kg
Surcharges
I~ percentage g |:| :
IR Ta 1 I:I Corrected Price:
weight percetags) Tz [
5 Ticket: v ha u,.
Ticket i@w Ok Clear Exit
4. Inthe Correction field, enter the weight to be subfracted from
the net weight. If you enter a negative number, it will be added
to the weight. To subfract a percentage of the weight, enter the
percentage in the Correction field and check the percentage
box below it.
5. Click the Try button fo display the corrections on the form.
6. Click the OK button fo accept the changes.

For multi-weigh transactions, use the Prev and Next butfons to
select an individual weighing. If you are correcting more than one
weighing in a fransaction, you must click OK for each change.
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Exporting
Transactions

This function lets you copy completed tfransactions to an external
ASCII file. Select Transactions from the Tools menu on the Vehicle
Processing screen. Then select Export Transaction fo display the
Transaction Data Export form. Enter a beginning and ending date
for the transactions fo be exported. Then click the Export bufton.

Transaction Data Export Ei |

From Date

To Date

Last Export Operation was perfarmed:

bay 12, 2000 7:33 PM ‘

Reset Counter
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Each weighing transaction is numbered consecutively. Three
transaction numbers are shown on the Vehicle Processing screen:

Master Transaction Number: The total number of transactions that
have been processed by your WinBridge system. This number
cannot be reset.

Transaction Number: The number assigned fo the current
transaction. This number can be reset, but you must export all dafa
from the database before you reset it.

Load Number: A fransaction number that can be reset without
exporting data. It can be used fo keep track of the number of
transactions per week, month, or other period.

To reset the fransaction number to 1, select Transactions from the
Tools menu and then select Reset Counter.

To reset a load number fo 1, select Transactions from the Tools
menu and then select Reset Loads for the desired load number.
NOTE: When you reset the fransaction number, the same

tfransaction number will be used for more than one tfransaction.
This might not be legal for some applications.
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7 WinBridge Settings and Tools

Setting Up
Scales and
Traffic Lights

Scale Menu

A window like the one shown below appears on the computer
screen fo display weight readings from each scale that is enabled.

34700 kg

If your system is configured for confinuous data fransmission
mode, this window will always be visible. If the system is in
demand mode, the window will not be displayed. In both modes
you can view the weight by clicking the Scale butfon on the Vehicle
Processing screen.

A Pass Zero function prevents you from starting a weighing
transaction until the scale returns to zero affer the previous
transaction has been completed. This function is enabled from the
Processing Parameters form. If Pass Zero is enabled and you fry fo
start a second transaction before the scale has returned to zero,
you will hear a beep and the weight will not be read. Then you will
have fo return the scale fo zero value and repeat the transaction.
When the scale is opened, a message on the status bar indicates
whether the Pass Zero function is enabled.

The Scale menu on the Vehicle Processing screen is used to
control the scales and fraffic lights. The main Scale menu options
are listed below:

Open: Opens the scale window.
Close: Closes the scale window.

Print: Sends a print command to the terminal associated with the
scale. If the terminal is connected to a printer, it prints a ticket
showing the current weight on the scale. This command works in
demand mode only.

Zero: Resefs the scale to zero.
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Reset: Resets the scale. This closes the connection to the port that
is being used and then reopens it. Reset should be used when
there are problems reading data from the scale.

Virtual Indicator: Lefs you define a new indicator as the sum of two
or more existing indicators. This option is discussed in Chapter 4.

Scale 1,2,3,4: Lefs you define how each scale is configured. You
can enable/disable the scale, sef the data transmission mode
(continuous, demand, or host), set traffic lights for automatic or
manual operation, and set up unaftended weighing stations. When
you click one of the scales listed in the menu, the Scale Setup form

will appear.

B2 scALE SETUP

Scale ld

&
Sample

Address

¥ Scale Enabled

— Traffic Lights Basic Control

IV Automatic Lights
v Manual Lights

Altomatic Strings

—Mode

& Continuous

™ Use Checksum

 Demand

 Host Part
S| * | @
Save Exit Clear

Manual Strings | Part |
—Unatt. In———— [~ Unatt. Qut
IV Installed
I~ Split Mode I~ Split Mode
Fort Port

1. Toenable a scale, check the Scale Enabled box and then
enter a Scale ID and scale Address. Click the Sampling button
if you want to define a sampling operation for the scale.

2. Setthe scale mode (continuous, demand, or host) by
selecting one of the radio butfons. If continuous mode is
selected, you can enable or disable the use of checksum.
Click the Port button fo configure a communication port.

3. Enable any ftraffic lights that will be used before and/or after
the scale (see the next section for details about setting up

fraffic lights).

4. If an unattended terminal will be used, check the appropriate
boxes and configure a communication port.
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WinBridge can be configured fo control traffic lights that are used
with a vehicle scale. The traffic lights switch can be configured for
aufomatic (controlled by WinBridge) or manual control. If manual
control is selected, the Vehicle Processing screen will display red
and green push buttons that the operator can use to switch the
lights. A function key can be assigned to the button, so that
pressing the function key sends the stfring that switches the lights.
A communication port must be defined for automatic or manual
control of lights.

Automatic Lights Control

Check the Automatic Lights box on the Scale Setup screen and
click the Automatic Strings button. In the window that is displayed
below, you can set a threshold weight value and enable the events
that will activate the traffic lights.

— TLEC Strings:

Weight Under Threshold:

Yeight Over Threshold:
Weight Over and Stable:

Transaction Accepted:

Threshold ¥alue; |1000

v X
QK Cancel

The following table shows the typical settings:

State Description Typical Setting
Under Threshold No fruck on scale Green (L)
Over Threshold Truck on scale Red (C)
Over and Stable Truck stabilized on scale Red (C)
Transaction Accepted Transaction accepted Green (L)
Threshold Value Weight indicates that fruck is on scale 1000

When a vehicle is weighed, WinBridge sends a string of characters
to the traffic lights via a serial port. The system can detect four
events:

1. Under: The weight is under the threshold value (stable or not).
2. Over: The weight is over the threshold value.

3. Stable: The weight is over the threshold value and is stable.

4. Accepted: The transaction has been accepted.
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Each of these events can be assigned to a different serial port.

e Communication via the serial port does nof involve any
communication protocols. The character strings are sent
without additional confrol characters.

< This function does not support the split-weighing mode.

Manual Lights Control

Check the Manual Lights box on the Scale Setup screen and click
the Manual Strings button. In the window that is displayed below,
you can enter the strings for switching two sets of lights on and off.

Traffic Lights Manual Switch String Setup m

—Light In String:

« [ — « [ —

—Light Out String:

W A
Ol Cancel
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Configure the red and green lights according to the setup af the
customer’s facility. Usually, red is the first two bits of the final word
sent to the fraffic light and green is the last two bits of the word.
Information sent to the traffic light is sent in four bits, two for red
and two for green (xxxxRRGG, where xxx is configuration
information). Configure the in and out light sfrings. If you are using
the control card developed by MT-Sweden, C=red and L=green.
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Processing
Parameters

You can set system defaults from the Processing Parameters
screen. To display this screen, select System Parameters from the
Tools menu, and then select Processing.

Processing Parameters u
—LInit —Log and Alarm —Pricing Cn Screen

¥ Use Contract

I Contract Can Be Blank
™ Check Deliv. \Weight
I~ Uze Shipping Address
™ Use Credit Check

I~ Owver Weight Mo Block
¥ Automatic Preset

I~ Log Scale Control

" Enter To Tah

I~ Enable Group Presets
v Use Multiple Loads

¥ Show Pricing

kg j Keep Days 5000 I~ Only Cash Custarner

—Enable/Disable — Transaction Rzl A

I Print Ticket et i

=port Interva
I” Log Printer : ﬂ " 5000 C
el | Keep Days 5000 I™ Use Manual tare

Prassssig —Scale —Data in 2nd YWeighing

I~ Check Yehicle Weight I" Enable Pass Zero I~ Contract

Minimum YWeight
1

¥ Customer

V Product

Disable Cantrals an ~ Default Cperation

™ Wehicle  Ship
™ Customer " Receive
™ Product & Either

v X
Ok Cancel

Defining the Default Weight Unit
Choose one of the units of measure listed in the Unit combo box:
kg, Ib, mt (mefric tons).

Enabling Ticket Printing

Check the Print Ticket box in the Enable/Disable section. This will
enable WinBridge fo print a ticket aufomatically when a transaction
is completed.

Logging Transactions to the Printer

Check the Log Printer box in the Enable/Disable section. When Log
Printer is enabled, the weight captured by the scale will be sent to
the log printer every time the Accept button is clicked. The combo
box is used to select a printer port. The Test Log Printer push
butfon allows you to test the ticket printer.
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Enabling Weight Checking

Check the Check Vehicle Weight box in the Processing section fo
enable WinBridge fo check the maximum and minimum vehicle
weights stored in the vehicle table. If a vehicle is over weight, the
fransaction is not allowed.

Enabling Contracts

Check the Use Confract box in the Processing section to enable the
contract functions. A confract will then be required for every
fransaction unless the Contract Can Be Blank box is checked.

Leaving the Contract Field Blank

Check the Contract Can Be Blank box in the Processing section to
allow the operator to leave the Confract field blank when
processing a fransaction. This option makes it possible to leave the
Confract field blank without disabling Use Contract. It lets you use
contracts for some transactions and not use them for others.

Checking Delivery Weight
Check the Check Deliv. Weight box in the Processing section fo
enable WinBridge fo check the delivery weight of a vehicle.

Enabling Shipping Addresses
Check the Use Shipping Address box in the Processing section to
enable the use of shipping addresses for transactions.

Enabling Credit Check

Check the Use Credit Check box in the Processing section to
enable credit checking. This will cause WinBridge to search the
Max. Credit and Act. Credit fields in the Customer table. If the
maximum credit is exceeded, then WinBridge will inform the
operator and prevent the fransaction from being completed until the
available credit is increased.

Enabling Vehicle Blocking

Check the Over Weight No Block box in the Processing section to
prevent WinBridge from blocking a fransaction when the vehicle is
over weight. If the box is left blank, WinBridge will check the
maximum vehicle weight shown on the Vehicle Processing screen.

Enabling Automatic Presets

Check the Automatic Preset box in the Processing section to enable
WinBridge to enter presets automatically in empty data fields for
which presefs have been defined. The Automatic Preset function
works for the main tables and extended tables.

Enabling Weighings Log

Check the Log Scale Control box in the Processing section. This
enables a weighings log function that aufomatically detects when a
vehicle is on the scale and sends messages to the screen and
alarms file if a regular weighing is not made. Two events can be
logged: (1) a vehicle passed over the scale and no stable weight
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was detected and (2) a vehicle passed over the scale and a stable
weight was detected (the weight is indicated).

Switching ENTER and TAB Key

When you check the Enter To Tab box in the Processing section,
the ENTER key will be used instead of the TAB key to move the
cursor befween data fields on the Vehicle Processing screen. If this
box is checked, you will not be able to use the ENTER key for any
other purpose (for example, you will have to use the mouse to
accept a weight). If the box is not checked, the TAB key will be
used fo move the cursor between data fields.

Enabling Group Presets
Check the Enable Group Presets box in the Processing section if
you want to be able to use group presets.

Enabling Multiple Loads

Check the Use Multiple Loads box in the Processing section fo
enable WinBridge fo track the number of transactions processed for
each company to which you have assigned a load number. A load
number is assigned from the Company form, and the number of
fransactions will be displayed on the Vehicle Processing screen.

Displaying Pricing Information

Check the Show Pricing box in the Processing section fo display
pricing information on the Vehicle Processing screen, Product
table, Account table, and Confract table. This box provides a
simple way to show or hide all of the data fields related to pricing.

Editing Alarm Times
In the Log and Alarm section, enter the number of days that you
want the system to keep a record of alarms.

Editing the Transaction Export Interval

In the Transaction section, specify the number of days between
fransaction exports and the number of days you want to keep the
transactions that are sfored in the database. The export option does
not delete tfransactions from the database. It exports complefed
fransactions to another part of the dafabase, allowing room for the
active fransactions.

Enabling Pass Zero

Check the Enable Pass Zero box in the Scale section. This option
requires the scale to return to zero before allowing the next vehicle
to be weighed. If this option is disabled, the Minimum Weight
opfion is used. The Minimum Weight option requires that the scale
reach the minimum weight that is entered in the data field
(negative values are acceptable) before weighing the next vehicle.

Disabling Database Validation
In the Disable Controls on section, select the fields for which you
do not want database validation to be required: Vehicle, Account,
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Split Weighing

7-8 (9/00)

and Product. This will allow entries fo be inserfed manually af the
Vehicle Processing screen.

Enabling Pricing on Screen

Check the Only Cash Customer box in the Pricing On Screen section
to configure WinBridge fo show price dafa on the Vehicle
Processing screen only for cash customers. When this function is
enabled, price datfa for other customers will be stored in the
database but not shown on screen.

Enabling Weighing Modes

Use this section fo enable the one-pass weighing modes you want
to use. Checking the One Passage box allows WinBridge fo
aufomatically apply a stored tare weight so that a vehicle can be
weighed in one pass over the scale. If there is no sfored tare weight
for a vehicle, WinBridge will automatically switch to two-pass
weighing for the vehicle. Checking the Use Manual tare box allows
WinBridge fo weigh a vehicle in one pass over the scale by
prompting the operator to enfer a fare weight manually. Both boxes
must be checked fo allow one-pass weighing in unattended mode.

Taking Information on the Second Pass Only

By default, all vehicle, contract, account, and product information
required for two-pass weighing must be entered when a vehicle
makes its first pass over the scale. You can change this so that
some information can be entered on the second pass. Check the
boxes in the Data in 2nd Weighing section that correspond to the
types of information (Contract, Account, Product) that you want to
enter when a vehicle makes its second pass over the scale. When
you process a vehicle, enfer only the information required on the
first pass (Vehicle information must be entered on the first pass),
and then click the Accept butfon. When the vehicle returns, fill in
the remaining required information, and then click the Accept
button to complete the transaction.

Setting Default Operations

In the Default Operation section, choose a defaulf by selecting the
Ship or Receive radio butfon. Select Either if you want fo be able to
set the mode of operation manually for each transaction.

SPLIT WEIGHING IS NOT WEIGHTS AND MEASURES APPROVED. If
is disabled by default; however, you can enable it for Non-Weights
and Measures processing. To use split weighing, click the Split
button on the Vehicle Processing screen. The system will
automatically ask if you are ready to weigh the trailer. Select OK
and the scale to be used, or enter the weight value manually
(select Manual button). See the WinBridge Configurator Manual for
information about installing this option.
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Tools

The Tools menu on the Vehicle Processing screen provides access
to forms that allow you to view a transaction log, display alarm
seftings, view weights registered on the scales, set up autfomatic
procedures, and configure data to be sent from the WinBridge PC.

WM Log

Select WMLog from the Tools menu to display the Weights &
Measures Transactions Log File. This file sfores every fransaction
that is made on WinBridge for Weights & Measures certification. It
is a locked file that cannot be changed or delefed.

= Log File Search

Click the Query button to search for fransactions. You can limit a
search by entering a fransaction number, range of dates, or status.
The results of a search are shown on the Transaction Data form.
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= Transaction Data

$691,488.00

0.00%
0.00%
2.00%

$691,488.00
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Tools
Display Alarm
Settings
Select Alarms Log from the Tools menu to display the View Alarm
and Log File form. Use the Facility and Severity check boxes to
select the type and severity of past alarms that you want to view.
Choose the date desired. Then click the Query button to display the
alarm messages.
=] View Alarm and Log File !EIB
—Facility — Severity
15-Jul-1999 A
¥ Data ¥ Successful Log Day J
™ Login ¥ Information
¥ Scale ¥ Wyarning
W \iehicle F Fatal NS
Exit
14:18:44 [SvSTEM ] LOG-5-MSG_DbConnect Connected to WEBRIDGES user WBRIDGE -
14:18:56 [MT 1 LOG-5-MSG_WhCnnCk Operator MT logged on —
14:22:01 [MT 1 LOG-3-M3G_WhDsc: Operator MT logged aoff
142208 [3YSTEM ] LOG-3-MSG_DbDisconnect: User WBRIDGE disconnected from WERIDGE
150184 [SYSTEM ] LOG-3-MSG_DbConnect Connected to WEBRIDGEE user WBRIDGE
15:02:03 [MT ] LOG-5-MSG_WhCnnCk Operator MT logged on
16:02:50 [MT 1 DAT-S-MSG_ImpOk: Successfully imparted 0 rowi(s) into REPORT_DETAIL tabl
16:02:84 [MT 1 DAT-W-MSG_NaolmpQk Mot imported 2 row(s) into REPORT_DETAIL tahle heci—
15:03:08 [MT 1 DAT-3-M3G_ImpOk: Successfully imported 0 row(s) into REFPORT table
15:03:06 MT 1 DAT-W-MSGE_NolmpCke Mot imported 1 row({s) into REFORT tahle because alre
15:03:18 [MT 1 DAT-S-MSG_ImpOk: Successfully imparted 27 rowis) into REPORT_DETAIL tat

1503 20 IMT
l

1 DAT-W-MSG NalmnOk Mot imnorted 12 row(s) into REF’OFT DETAILtab\ebj'Ll
»
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End-of-Period
Operations

To set end-of-period operations, select System Parameters from the
Tools menu. Then select Customize Process and End Operations fo
display the form shown below.

End Operations
—Feport
™ End of wark
™ End of day

™ End of week

—Data

" Backup datahasze
™ Export Transactian

[~ Clear Log File

A
Zancel

7-12 (9/00)

Checking the boxes will enable the following operations:

End of work: A report named WORKREP is executed. If includes a
filter for the fransactions run by the current operator.

End of day: A report named DAYREP is executed. It includes a filter
for the transactions run on the current day.

End of week: A report named WEEKREP is executed. It includes a
filter for the transactions run during the current week.

Backup Database: A sfart backup message will appear every fime
an operator logs out.

Export Transaction: A fransaction export message will appear every
time an operator logs out.

The following format is used for the fransaction export file
(Exptrans.exp):

TRANSACTION

WB_Identifier, TRANS_NO, STATUS, VEHICLE_ID,CONTAINER_ID,COM
PANY_ID,ACCOUNT_ID,PRODUCT_ID,CONTRACT_ID, OPERATION,R
EMARK,SHIP_ID, PAYMENT, WT_UNIT, TARE_ID,CONTAINER_TARE, IN
_SCALE, IN_WEIGHT,IN_CONSEC, IN_DATETIME,IN_OPERATOR_ID,0
UT_SCALE,OUT_WEIGHT,OUT_CONSEC, OUT_DATETIME, OUT_OPER
ATOR_ID, PIECES,NET_WEIGHT,AMOUNT,ADD_PRICE, TAX1, TAX2,T
OTAL,V_OPERATOR_ID, TRANSIENT, TRANS_UNDO_ID,SPLIT_LOAD,
DISCOUNT,SPARE2,SPARE1,SPARE3,SPARE4, REMARK2,SPARES, S
PAREG, TRUCK_ONLY,LOAD_NO,MASTER_TRANS_NO,SPARE10,SP
ARE11,SPARE12,SPARE 13, WEIGHMENT,SAMPLE_ID,SAMPLE_OW
NER,SAMPLE_RESULT, TICKET_IN, TICKET_OUT
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Tools

NULL, NUMERIC, CHARACTER, CHARACTER, CHARACTER, CHARACTER
,CHARACTER, CHARACTER, CHARACTER, CHARACTER, CHARACTER,C
HARACTER, CHARACTER, CHARACTER, NUMERIC, NUMERIC, CHARACT
ER,NUMERIC,NUMERIC, DATE, CHARACTER, CHARACTER, NUMERIC,N
UMERIC, DATE, CHARACTER,NUMERIC, NUMERIC, NUMERIC,NUMERIC
,NUMERIC,NUMERIC,NUMERIC, CHARACTER, CHARACTER, NUMERIC,
NUMERIC,NUMERIC,CHARACTER, CHARACTER, CHARACTER, CHARAC
TER,CHARACTER,NUMERIC, NUMERIC, NUMERIC, NUMERIC, NUMERI
C,CHARACTER, CHARACTER, CHARACTER, CHARACTER,NUMERIC,CH
ARACTER,CHARACTER, CHARACTER, CHARACTER, CHARACTER

The following format is used for the extended fransaction export file
(Extdira.exp):

EXTD_TRANS

WB_Identifier, RANS_NO,TBL1_ID,TBL1_DESCR,TBL2_ID,TBL2_DE
SCR,TBL3_ID, TBL3_DESCR,TBL4_ID, TBL4_DESCR,TBL5_ID, TBL5_
DESCR,TBL6_ID,TBL6_DESCR, TBL7_ID,TBL7_DESCR,TBL8_ID, TBL
8_DESCR,TBLO_ID, TBL9_DESCR,TBL10_ID,TBLTO_DESCR,TBL11_
ID,TBL11_DESCR,TBL12_ID,TBL12_DESCR,TBL13_ID,TBL13_DES
CR,TBL14_ID,TBL14_DESCR,TBL15_ID,TBL15_DESCR,CARRIER_|
D,CONVER_UNIT,CONVER_WEIGHT,IN_SCALE1,0UT_SCALE1,IN_S
CALE2,0UT_SCALEZ2,IN_SCALE3,0UT_SCALE3,IN_SCALE4,0UT_SC
ALE4,IN_WEIGHT1,0UT_WEIGHT1,IN_WEIGHT2,0UT_WEIGHT2,IN
_WEIGHT3,0UT_WEIGHT3,IN_WEIGHT4,0UT_WEIGHT4

NULL, NUMERIC, CHARACTER, CHARACTER, CHARACTER, CHARACTER
,CHARACTER, CHARACTER, CHARACTER, CHARACTER, CHARACTER,C

HARACTER,CHARACTER, CHARACTER, CHARACTER, CHARACTER,CHA
RACTER, CHARACTER, CHARACTER, CHARACTER, CHARACTER, CHARA
CTER,CHARACTER, CHARACTER, CHARACTER, CHARACTER, CHARACT
ER,CHARACTER,CHARACTER, CHARACTER, CHARACTER, CHARACTER
,CHARACTER, CHARACTER,NUMERIC,CHARACTER, CHARACTER, CHA
RACTER, CHARACTER, CHARACTER, CHARACTER, CHARACTER, CHARA
CTER,NUMERIC,NUMERIC,NUMERIC, NUMERIC, NUMERIC,NUMERIC,
NUMERIC,NUMERIC

Clear Log File: The log and alarms file is erased every fime an
operator logs out.

You can view a list of fransactions processed on a specific scale.

From the Tools menu select Scale View to display the form shown
below. Use the combo box fo select a scale fo refrieve information
from. You can limit a search by entering a minimum weight and a
starting date. Then click the Query butfon. The results of the search
will appear in the table at the bottom of the form.
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Scale
Min. Weight I:l m«
MAR j i Cuery Exit
Transho Type YWehicle | Consec Number | Weight Date .
1 In TRUCK 1093:0 120000 1999-07-10-18
1 Out TRUCK 10930 100000 1999-07-10-18
3 In TRUCK 10930 125000 1993-07-10-18
3 Oout TRUCK 1093:0 5BE0000 1993-07-10-18
2 In TRUCK 10930 15200 1999-07-10-18
2 Out TRUCK 10930 2300000 1999-07-11-18
4 In TRUCK 10930 12500 1393-07-10-18
4 Out TRUCK 1093:0 100 1999-07-10-18
5 In TRUCK 10930 12500 1999-07-10-18
5 Oout TRUCK 10930 100 1993-07-10-18 -

Host
This Tools menu option can be used to configure the data sent
from the WinBridge PC. The Host configuration form is shown
below. You can enable host communication, define the data you
want to send, define when it should be sent, and define where fo
send it.

¥ Enable Host Cormmunication

—Standard Data to Send

I %ehicle  (12) I Weight (1)
W Account  (10) v DatefTime (14) B ER TR ETR
W Contract  (12) Iv Total (08)

IV Product  (12)

i Port Confi |
W5z Port oY Path { ex. c\programb :
I Disk |D:\TEMF‘\
Custom Farmat: |Sk0g Data j| 4 X

Ok Cancel
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Help Menu

The Help menu on the Vehicle Processing screen provides access
to a WinBridge on-line help file.

Software Version

Identifier

Software
Checksum
Control

To find out which version of WinBridge you are using, select About
WinBridge from the Help menu and look in the Software Version
Identfifier field.

A checksum routine is run every time WinBridge is started (read
from the scale indicator). It checks that the legally relevant parts of
the software have not been modified. The checksum number is
shown on the About WinBridge screen. If a number is visible in the
Checksum Number field, it means that the original software parts
are being used. If, instead of a number, the message “This release
is not certified” appears, then one or more of the legally relevant
parts of the software has been modified.
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Chapter 8: WinBridge Unattended Module
Introduction

WinBridge Unattended Module

Introduction
The WinBridge Unatftended Module is an add-on software program
that enables WinBridge to process weighing transactions in
unaftended mode. An operator is nof needed fo process unattended
fransactions. Instead, the driver of a vehicle can enter all the data
needed on an unattended driver station located at the scale. A driver
station with optional accessories is shown below.
Prinfer ——p> N
© oooo
Proximity > oooo <« Slot Reader
Card oooo
Reader k
- =\ —
] I AN
N\
p—1 Y

Keypad

To start unattended mode, click the unattended push butfton on the
Vehicle Processing screen’s foolbar.
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Data Entry

When unattended mode is enabled, the Badge and Short Code
menu items are activated in the Vehicle Processing screen’s Table
menu. Clicking on either of these will display four submenu items:
Vehicle, Confract, Account, and Product. You can assign a badge ID
or short code for each vehicle, contract, account, and product that
will be processed at the unattended weighing station. Drivers will
use the badge ID or short code fo identify themselves at the driver
station.

Budge
A driver can use a badge to identify a vehicle, contract, account, or
product at the driver station. To assign a badge ID, select one of the
items from the Badge submenu. The Badge Administration form for
vehicles is shown below:
Badge Administration !Elm
Tahle Data Edit
I+ & | 0| H ” . (v -8 | 0|\
Close Hew Query | Table I Insert | Update | Delete
Badge Id:
Vehicle
Press "Query" to retrieve infarmation... | MU

8-2 (9/00)

1. Enter an ID in the Badge ID datfa field.

2. Use the combo box to select the vehicle thaf you want fo link to
the badge ID.

3. Click the Insert button to save this entry in the database.
The other three Badge Administration forms work the same way.
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Data Entry
Short Code
A short code is an ID number that the driver can type on the driver
station’s keypad to identify a vehicle, contract, account, or product.
To assign a short code, select one of the items from the Short Code
submenu. The Short Code Administration form for vehicles is shown
below:
Eil Short Code Administration !EB
Table Data Edit
¥ | & |«w@|B| .| .| || & ]n
Close Hew Query | Table I Insert | Update | Delete
Shart Code:
Vehicle
Press "Cuen" to retrieve information. . | [ oM [

1. Enter an ID in the Short Code data field.

2. Use the combo box to select the vehicle thaf you want fo link to
the short code.

3. Click the Insert button to save this entry in the database.
The other three Short Code Administration forms work the same way.
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Unattended
Mode
Processing

When a vehicle arrives af the unattended scale, the driver must
enter the first input data (Contract or Vehicle ID) at the driver
station by using a badge or typing a short code.

The driver stafion then prompts the driver to enter any
additional data required for the fransaction (required entries are
configured by your supplier). The driver can enter the dafa by
using the keypad or by scrolling through a list of opfions on the
driver sfation display (options are displayed one af a fime).

The driver station keypad has numeric keys (0-9), plus
the following keys:

+ Scroll up the list of values displayed

- Scroll down the list of values displayed

C Clear the data that was fyped in

F Abort fransaction

E Enter the displayed data

. Press this key and then the E key to print a ticket

If data must be entered by an operator, the driver station
displays a wait message until the operator finishes
enfering the dafa.

If the system’s confirmation function is enabled, the driver can
make changes fo the input data during the first weighing. The
driver does this by scrolling through the data that have been
entered and using the E key to make changes. During the
second weighing, the driver cannot change any values that
have been entered.

Once all data have been entered correctly, the vehicle is
weighed automatically and, if the driver station is equipped
with a printer, it will print a ticket. The driver station will display
a message telling the driver whether the fransaction was
accepted or refused. The driver can then fake the ficket and
leave the unattended station. There is a timeout of ten seconds
before WinBridge will accept a new transaction.

If the WinBridge system shufs down accidentally in unattended
mode, it will automatically restart in unattended mode. To allow
aufomatic startup without an operafor present, the PC system on

which WinBridge is installed must be set so that Windows starts

8-4 (9/00)

aufomatically and WinBridge runs automatically af startup.
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Creating a Report

9 WinBridge Report Module

Creating a

Report

The WinBridge Report Module is an add-on software program that

lets you create or customize reports and tickets. There are two steps

fo creating a report: (1) defining a query and (2) defining a layout.

*  Query: A query is a request for information from the WinBridge
database. When you define a query, you tell the database
which information (dafa fields) fo include in the report. A query
consists of SQL statements.

*  Layout: The layout is how the datfa is arranged on the report.

To create a report, select WB Report from the Report/Ticket menu on
the Vehicle Processing screen. This displays the REPORT — Query
and Layout Definition form.

# REPORT - Query and Layout Definition
Table Data Edit
JJ«- o | «0 % e P [ (" -8 | C0 i
Close Hew | Query | Table ' Insert | Update | Delste
Type—— Destinati ~Company
Ij i .
W// Repony id [~ Zip
[“Name [ Country
P [~ Addrl [~ Phone
Description: | I Addr2 T~ Fax
Printer: i H " City [ F. Code
File: | || I state
Layout: I:I Query | Layout |
Var List: | | Quicka. | QuickL. |
Item List: i | Report | Test |
Press "[uerny” to retrieve information | MUK

For a new report, assign a report ID, fill in the other data fields, and
set the radio butfons and check boxes. Then define a query and
layout for the report.
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Required Fields
Report ID: The identifier for the report.

Level: The security level assigned to the report (0-9).
This corresponds to the security level assigned to
each operator.

Layout: The layout created for the report (*.qrp).
Var List: Type of variable (date/time, sfring, number).
[tem List: The variable data items included in the report.

NOTE: The Var List and Item List fields will be filled in when you
define a query for the report. If you edit an existing query, you will
need fo change the list fields manually. Each of these two fields can
hold a maximum of 1,024 characters.

Optional Fields
Description: A description of the report.

Printer: Type in the name of the printer to be used or click
on the push button fo the right of the field and
select from a list of available printers.

File: The file associated with the report.

Type: Use the radio buttons to indicate whether you
want to create a Report or a Ticket. A report
contains general information from the dafabase’s
tables. A ticket contains information about the
current fransaction (net weight, vehicle, etc.).

Destination: Select View to display the report or fickef on a
computer screen, Printer to print a copy on
paper, or File to output it fo a file.

Company: Check the boxes to select which company
information you want fo include in the report.
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Defining a
Query

You can create a new query or edit an existing query. The following
push butftons are used for defining queries:

This button displays the Edit Query form so that you can create a
new query from scratch or retrieve an existing query and modify it fo
create a new query. This procedure is described in the “Editing a
Query” section of this chapter.

This bufton begins the Quick Query procedure, which is
recommended for creating a new report. If you click this butfon and
there is already a report with the report ID that you entered, it will be

replaced by the new Quick Query. Clicking the Quick Q. button
displays the form shown below.

Quick Query [ =]
| ACCOUNT -]
ACT_CREDIT = ACCOUNT.ACCOUNT_ID
ADDR1 ACCOUNT.PHONE
ADDR2 ACCOUNT.FAX
o
COUNTRY
DISCOUNT Z |
ENABLED
FISCAL_CODE
MAX CREDIT
NAME b << I
OPERATION
PAYMENT
PERSON -
v = X
0k Clear Cancel

Use the combo box at the top of the form to choose the WinBridge
table from which you want fo select data fields. The data fields
available from the fable are shown in the list box on the left.
Highlight each field that you want to include in the report, and use
the > arrow button to move it to the list box on the right.
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e

<<

The arrow buttons are used to move items between the two list
boxes:

Moves an item from the left list box to the right list box. You can
also double-click on an item fo move it.

Moves an item from the right list box fo the leff list box. You can
also double-click on an item to move it.

Moves all the items from the left list box to the right list box.

Moves all the items from the right list box to the left list box.

You can select fields from more than one table. Once you have
selected the fields that you want from one table, simply use the
combo box to highlight another table. Then select the desired fields
from it. In the example shown below, Account ID, Phone, and Fax
have been selected from the Account table. Confract ID and
Description have been selected from the Contract table.

Quick Query
| CONTRACT -l
ACCOUNT_ID ACCOUNT.ACCOUNT _ID
DATE_INIT ACCOUNT.PHONE
ENABLED ACCOUNT.FAX
EXP_DATE CONTRACT.CONTRACT_ID
INFO CONTRACT.DESCRIPTION
OTHER_ID < |
STOCK_INIT
<< |
v B X
0ok Clear Cancel

9-4 (9/00)

When all the data fields that you want to include in the report are
displayed in the right list box, click the OK button o confirm the
choices you have made.
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If you have selected data fields from more than one fable, the Link
Tables form will appear when you click OK.

Link Tables
[ACCOUNT =l |CONTRACT =l
= =]
ACT_CREDIT CONTRACT_ID
ADDRI DATE_INIT
ADDR2 I DESCRIPTION

CITY ENABLED
COUNTRY EXP_DATE
DISCOUNT Search I INFO
ENABLED OTHER_ID
FAX - STOCK_INIT

ACCOUNT.ACCOUNT_ID = CONTRACT.ACCOUNT_ID

‘/ :::@
ok Delete

X

Cancel

This form lets you creafe a link between the tables. Select the item
on the left and the item on the right that you want to link. Then select
the type of link from the list box af the cenfer of the form. The
following choices are available:

- 3 <= Less than or equal
<= ; <> Not equal

<> = Equal

: > Greater than

3= - >= Greater than or equal
LIKE Bl UKE  similor

When you have selected two items to be linked and the type of link,
click the Add button. After adding all links, click the OK button.

NOTE: The Search button is used to find relafed items from two
fables. For example, if you select the Transaction table and highlight
the Account ID field and then select the Account table, clicking the
Search button will highlight the Account table’s Account ID field.
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Edit Query

The following Edit Query form shows the query that was defined in
the Quick Query and Link Table forms above.

SELECT ALL

AGCCOUNT.ACCOUNT_ID. :|
ACCOUNT.PHONE,
ACCOUNT.FAX,
CONTRACT.CONTRACT_ID, Test
CONTRACT.DESCRIPTION|

FROM ACCOUNT,

CONTRACT
WHERE ACCOUNT.ACCOUNT_ID = CONTRACT.ACCOUNT_ID

v’
Ok

|

B X
_;I Cancel

9-6 (9/00)

» The Select statement lists the data fields that are to be included
in the report.

»  The From statement lists the tables that the data fields are from.
»  The Where statement lisfs the links between the tables.

Click the Test push butfon to test the syntax of the query. If the
syntax is correct, click the OK button.

NOTE: You must fest a query every time that you create or edit it.
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Editing a Query

After you have defined a query with the Quick Query procedure, you
will need to edit it manually if you want to make changes. To edit an
existing query, open the REPORT — Quety and Layout Definition form,
enter the Report ID in the appropriate data field, and then click the
Query button on the toolbar.

If you do not know the Report ID, click the Query button on the
toolbar to display the first report in the database. Then click the
Table button to display a table containing all existing reports.
Double-click the report that you want to edit.

1. With the query displayed on the REPORT — Query and Layout
Definition form, click the Query butfon in the lower right-hand
corner of the form. This will display the query on the Edit Query
form shown below.

Edit Query x|
SELECT ALL ii ¥
ACCOUNT.ACCOUNT_ID, ok
ACCOUNT.PHONE, =
ACCOUNT.FAX,
CONTRAGT.CONTRACT_ID, Test
CONTRACT.DESCRIPTION]
FROM  ACCOUNT,
CONTRAGT
WHERE  ACCOUNT.ACCOUNT_ID = CONTRACT.ACCOUNT_ID
H X
= » Lancel
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To add a field (for example, ACCOUNT.NAME) to the query
shown above, position the cursor af the end of the last line in
the Select statement (after CONTRACT.DESCRIPTION). Type a
comma, press the RETURN key, and enfer the name of the field
you want to add on the next line. The query should now look
like this:

SELECT ALL

ACCOUNT.ACCOUNT_ID,
ACCOUNT.PHONE,
ACCOUNT.FAX,
CONTRACT.CONTRACT_ID,
CONTRACT.DESCRIPTION,
ACCOUNT.NAME

FROM  ACCOUNT,

CONTRACT

WHERE ACCOUNT.ACCOUNT_ID = CONTRACT.ACCOUNT_ID

3.

5.

Click the Test button to fest the revised query, and then click the
OK button.

Position the cursor af the end of the Var List field on the
REPORT — Query and Layout Definition form. Add a comma,
and type the variable for the item that you added fo the query.
The variable type can be S for string, N for number, and D for
date/time (for example, S[5] means that you are adding a
string field and that is the fifth string field in the query). Since
ACCOUNT.NAME is a string, change the Var List as shown:

change S[01,S[11,8[21,S[31,S[4]
to S[01,S[11,5[21,5[31,5[41.S[5]

Position the cursor af the end of the Item List field. Add a
comma, and type the field name (ACCOUNT.NAME).

NOTE: You can use the END key to move the cursor to the end of the
Var List or Item List field.

6.

Click the Layout button to display the report layourt.
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[El ReportWindows - TEST2 GRP _[O] x|
File Edit View BRepot Tools Format Help
Paos: Width: | ﬂ| ‘Times New Roman ;IH]I] = Bl Fi | 'Sl o)
Content: ‘ LI' EEITdF Fmt: ‘ LI
B
[ FeportHeader  Olines |
| |
[+ [Pags Header |
Eep
IWCCOUNT ACCOUNT 1D ACCOUNT PHONE ACCOUNT. FAX
iCCOUNT ACCOUNT_ID ACCOUNT PHONE ACCOUNT. FAX
[+ [Pags Footer |
Pag
[ FeportFooter  0lines |
< [ | 2P
7. Open the Format menu on the menu bar and select Input and
then Input ltems. The name of the new field should appear af
the end of the list of Input Names. Specify the Data Type
(String, Number, or Date/Time), and then click OK.
Input Name: Input Names:
|ACCOUNT.ACCOUNT_ID ACCOUNT ACCOUNT
ACCOUNT.PHONE
—Data Type: ACCOUNT.FAX Cancel |
. CONTRACT.CONTRACT_I
 Siring CONTRACT.DESCRIPTIO Reset
ACCOUNT.NAME 4|—‘3SE
 Number
New |
 DatefTime
 Object Apply

8. The new field should appear on the layout (you will need to
use the scroll bars fo view the entire layout). You can use the
field tool from the tool palette fo add a field fo the layout. Then
click the down arrow to open the Content list box and select an
item fo place in the field.

9. Now you can test the report to make sure it is correct.
NOTE: When you modify a report, you must also modify its layout.
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Reports with
Dynamic
Variables

9-10 (9/00)

When you edit a query, you can add dynamic variables (a WHERE
statement with variables). You can define as many as 12 dynamic
variables. The names of the variables must satisfy the following
syntactic rules:

String variables :SN
Numeric variables :nN
Date/Time variables :dN

N represents a number from 1 fo 9.

Adding Dynamic Variables

1. In the Edit Query form, add the word AND at the end of the last
line of the WHERE statement, and then press the RETURN key.

Type the fable name, a period, and then the field name.
Type one of the relations (=, I=, >, 1>, <, Ik, >=, or <=).
Then type the name of the variable (for example, :s1).
Repeat steps 1 to 4 for each variable you want to add.

When you click Test for a query with variables, WinBridge prompts
you fo insert the description for the variables by showing an
appropriate window (for example, you can enter IDENTIFIER for a
sfring variable). After you have inserfed the description, click OK.
Then click OK again fo exit from the Edit Query form. Once you have
closed the Edit Query form, you must update the database with the
modified report. You can do that by clicking the Update push button
on the REPORT - Query and Layout Definifion form.

To view the report produced by the dynamic query, click the Report
push button. Select the reporf from the window that is displayed.
After you select it, WinBridge will prompt you to insert the values for
the input variables in the dynamic query (For example, if you
included an in date and out date in the query, you will be asked fo
enter the specific dates you want to use). Click OK to confirm the
values. If you do not specify any value for a dynamic variable when
you run a report, no filtering will be used based on that variable.

o oN
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Defining a Layout

The layout is the second step in creating a report. To define a layout,
click the Layout push button on the REPORT — Query and Layout
Definition form.

The Layout butfon opens Report\Windows so that you can create a
new layout or modify an existing layout. Refer fo the SQLWindows
ReportWindows User’s Guide for instructions about how to use
ReportWindows. The resulting layout is the same as that obtained
by clicking the Quick L. button when you create a new query.

The Quick L. (Quick Layout) butfon opens ReporfWindows and
creates a default layout that corresponds to the current query. We
recommend using this butfon when you first create a new query. If
you do a quick layout on an existing layout, it will be overwritten.

You can insert variables (for data from the Company table) in a
report. Instructions for inserting variables are available in the
ReportWindows User’s Guide.

You can use data fields from the Company table without including
them in the query. From the layout, open the Format menu, select
Input and Variables, and then fype in the following names:

sCld Company ID
sCName Company name
SCAddr1 Address 1
sCAddr2 Address 2
sCCity City

sCState State

sCZip Postal code
sCCountry Country
sCPhone Phone number
sCFax Fax number
sCFCode Tax number

All variables are string type.

You can then define and place the dafa fields in the report layout
and save it.

To be able fo see the variables in a report’s layout, you must
activate them by checking the boxes in the Company section of the
REPORT — Query and Layout Definition form.

When you create reports with dynamic conditions, you must insert
the variables in the layout. Open the Format menu and select Input
and Variables, and then add the names of the variables and the
necessary data fields.
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The final two buftons on the REPORT — Query and Layout Definition
form are the Report and Test butfons.

R rt Clicking the Report butfon displays the same form that appears
=) | when you select Print Report from the Report/Ticket menu.
Clicking the Test button checks to make sure the query and layout
Test | are syntactically compatible. If they are compatible, a blank ticket

will appear; if not, an error message will appear.
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Chapter 9: WinBridge Report Module
Using Empty Fields in a Report

If one or more fields present in the query was not filled in on the
current fransaction, the ficket printout will be blank. For example:
you want the Carrier Name printed on the ficket, but no carrier was
defined for the vehicle used in the current transaction. When the
query searches for the Carrier Name and finds nothing, the whole
query is left empty. This is true for all the fields in the database
except the following ones:

Vehicle ID: Since the vehicle can be transient (not present in the
database), you can define a so-called “outer join.” To do that you
have to add ( + ) to the WHERE statement of the query:
TRANSACTION.VEHICLE_ID = VEHICLE.VEHICLE_ID ( + ). If you do
that, the ficket will be printed even when the Vehicle ID is blank.

Container ID: When the container description is required on a ficket,
the ficket printout will be blank if a non-container vehicle is selected.
In order to avoid printing a blank ticket, insert a record with three
asterisks (***) as the Container ID in the Container fable. This
record will aufomatically be used when the Container field is blank.

Confract ID: In the Contract table, insert a record with a plus sign
(+) as the Contract ID. This record will aufomatically be used when
the Contract field is blank.

Confract ID, Customer ID, Ship Addr ID, Product ID: If one of these
items is entered in second weighing, af the moment the inbound
ticket is being prinfed, the ficket will be blank. In order to avoid
printing a blank ticket, insert a record with an asterisk (*) as the ID
in each of the above tables. This record will automatically be used
when the ID field is blank.

It is not possible to apply the above conditions fo any other field in
the database. Every other field in the database must filled in at the
time of the printout.
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Printing Gross,
Net, and Tare

Calculations

9-14 (9/00)

In order to have the Gross, Net, and Tare print on tickets rather than
simply inbound/outbound weights, place the following formulas on
the layout of the ficket.

On the Layout screen, select the field that you would like to represent
the Gross and fype in the following formula:

NumberlFF((TRANSACTION.IN_WEIGHT —
TRANSACTION.OUT_WEIGHT), TRANSACTION.OUT_WEIGHT, O,
TRANSACTION.IN_WEIGHT)

On the Layout screen, select the field that you would like to represent
the Tare and type in the following formula:
NumberlFF((TRANSACTION.IN_WEIGHT —
TRANSACTION.OUT_WEIGHT), TRANSACTION.IN_WEIGHT, O,
TRANSACTION.OUT_WEIGHT)

For the Nef calculatfion, type the following:

TRANSACTION.NET_WEIGHT
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Using Spare
Fields for
Calculations

To use a spare field from the configuration screen for calculations on
reports or tickets, follow the guidelines below. For this example, we
are using a Spare]1 field to make further pricing calculations in
conjunction with the existing price fields. The first thing you need to
do is to name the Spare]1 field as a numerical string.

1.

On the REPORT — Query and Layout Definition form, press the
Query button in the lower right-hand corner of the form.
Position the cursor at the end of the last line of the SELECT
ALL statement, type a comma, and then type
@VALUE(TRANSACTION.SPARE1)AS P1. The P1 can be any
name that notifies you what the name of the field is.

Click Test and then OK.

Return to the REPORT — Query and Layout Definition form and
place the cursor at the end of the Var List field. Type N[#],
which is a numerical variable. Be sure fo use the next
consecutive number in place of the # sign.

Then place the cursor af the end of the Item List. Type in the
P1 or whatever name you gave this variable in the query.

NOTE: The variable must be placed at the same position in the
Variable List and Item List.

5.

10.

Once you have complefed these sfeps, go to the Layout
screen and select Format and then Input Items.

Type the name of the variable (for example, P1) and select
New.

Click Close.
Use the field fool to place a new field on your ficket/report.

Select this new field and click the Editor button. Then select
the name of the variable (for example, P1).

Now you are able to provide other fields that can use this
variable in calculations because the system understands it as
a numerical variable.
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Printing
Duplicate
Tickets

9-16 (9/00)

In order to print duplicate tickets, you will need fo include the
variable sDuplicate on the ticket. This places the word duplicate on
all duplicate ticketfs that are printed. A duplicate ticket will not print
unless this variable is on the ticket fo satisfy Weights & Measures
requirements and protect against fraud. To place this variable on the
ticket, go fo Format, Input Items, type sDuplicafe, select New, and
then click OK.

Once you have placed this as an input item, you can create a field
using the field tool. Then with the field selected, click the Editor
button. Select the sDuplicate variable from the list and then click OK.
Now you will be able to print this ticket as a duplicate ticket from the
Vehicle Processing screen.
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Using Dates
in Reports

The following example can be used fo insert an MM/DD/YY date

format in a comma delimited report.

YYYY/MM/DD — 06.22.45.000000

I I
%" 1l Str Mid (Str Pad (Date to Str (outdate), 7), 5, 2) Il

I |
YYYY/MM I

MM

YYYY/MM/DD — 06.22.45.000000

I I
Str Mid (Str Pad (Date fo Sir (outdate), 10), 8, 2) Il
I

I
YYYY/MM/DD ‘

DD

YYYY/MM/DD — 06.22.45.000000

I
Str Mid (Str Pad (Date fo Str (outdate), 4), 2, 2) I/’

I |
YYYY ‘

YY

Il is a concatenation character (Shift+F7 x 2)
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10 Report Writer Tutorial

Generating a
Ticket

Open the WinBridge REPORT — Query and Layout Definition form by
selecting WB Report from the Report/Ticket menu on the Vehicle
Processing screen. Enter the following information in the data fields:

Report ID: TESTT

Level: O

Description: Test Ticket

Printer: (Press the Printer button and select from the list)
File: (Leave blank)

Layout: TESTT.QRP

Var List: (Leave blank)

[tem List: (Leave blank)

Type: Select the Ticket radio butfon
Destination: Select the View radio button
Company: Check the Id and Name boxes

Your screen should look like the one shown below:

# REPORT - Query and Layout Definition

Tahle Data Edit

| & | |®B| | .| | | &|7|F
Close New Query | Table I Insert | Update | Delete
Destination; — Company
& Vi
View ” Id ~Zip

 Printer
© File

F:Name I Country

Type
“;/B -  Report
= # Ticket

Report Id: [TESTT Level: IZI
" Addrl I Phone

Description: |T95tTiCkBt | g rAddr2 T Fax

Printer: |HP LaserJet 55i Mo‘lHPSSI ||\\Tms1\tmsfmkt7lj55i ‘ Gty . ke
File: | || rstate
Layout: Query | Layout |
Var List | Quick . | GuickL |
Item List: | | Report |  Test |
Fress "Query" to retrieve information ‘ [ NoMm [
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Defining the
Query

A query provides the Report Writer with all of the information about
a fransaction that is used to print a ticket. Since a ticket is produced
for each transaction, the Transaction table is the main source of
information used to generate fickets.

1. To begin a query, click the Quick Q. button on the form that
you just filled in. The Quick Query form will appear. You
should use this button only when you first create a query
because it will write over any existing query.

TRANSACTION
ACCOUNT_ID 2]
ADD_PRICE
AMOUNT
COMPANY_ID 7 |
CONTAINER_ID —
CONTAINER_TARE P |
CONTRACT_ID
DISCOUNT
IN_CONSEC >> |
IN_DATETIME
IN_OPERATOR_ID << |
IN_SCALE
IN_WEIGHT
LOAD_NO ~

v B
Ok Clear

A

Cancel

10-2 (9/00)

2. Select Transaction from the combo box at the top of the form.

The list box on the leff displays the transaction data that is
available. The list box on the right displays the data fo be
included in the report.

3. Select the following transaction data items from the list box on

the left and move them to the list box on the right:

Account ID
Product ID
Vehicle ID

In Weight
Out Weight
Net Weight

In DateTime
Out DateTime
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Generating a Ticket

Out Consecutive
Wt Unit

To move an item to the box on the right, highlight it and click
the > arrow button.

4. Change the combo box to Account and select Name.

5. Change the combo box fo Product and select Description.

6. Change the combo box fo Vehicle and select Descripfion.

7. When the form looks like the one shown below, click OK.

[VEHICLE =]

CARRIER_ID TRANSACTION.ACCOUNT |
CONTAINER TRANSACTION.PRODUCT |
DRIVER TRANSACTION.VEHICLE_I
EXP_DATE TRANSACTION.IN_WEIGHT,
INFO TRANSACTION.QUT_WEIG
LICENSE TRANSACTION.NET_WEIG

MaAX_LEGAL _WEIGHT
MIN_LEGAL_WEIGHT

v
Ok

o
#

OPERATION TRANSACTION.OQUT_CONS
TYPE TRANSACTION.WT_UNIT
UNAT_TICKET ACCOUNT.NAME
VEHICLE_ID PRODUCT.DESCRIPTION

B

Clear

TRANSACTION.IN_DATETI
TRANSACTION.OUT_DATE

VEHICLE.DESCRIPTION

X
Cancel

Since your query includes items from several fables (the

Transaction, Account, Product, and Vehicle tables), you will need to

link those fables.
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Linking Tables

Report Writer searches the Transaction table for information about a
specific transaction that you want to include on a ticket. By linking
other tables to the Transaction table, you make it possible to include

information from those tables. For example, you can link the

Account ID field in the Transaction table to the Account ID field in
the Account fable. When Report Writer prints a ticket, it will then be
able to include information about the account that was involved in

the fransaction.

Because you have included several tables in your quick query, the
Link Tables form will appear when you click the OK button.

TRANSACTION | | ACCOUNT ~|

ACCOUNT_ID =] [ =] |ACCOUNT_ID N

ADD_PRICE ACT_CREDIT

AMOUNT = ADDRI1

COMPANY_ID Add ADDR?2 |

CONTAINER_ID CITY

CONTAINER_TARE COUNTRY

CONTRACT_ID Sedrch | DISCOUNT

DISCOUNT ENABLED

IN_CONSEC - FAX -
0Ok Delete Cancel

1. Select Transaction in the left combo box, and highlight Account
ID in the list box below it.

2. Select = in the center combo box.

3. Select Account in the right combo box, and highlight Account
ID in the list box below it.

4. Click the Add button to create a link.

5. Select Transaction in the left combo box, and highlight Product
ID in the list box below it.
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6. Select = in the cenfer combo box.

7. Select Product in the right combo box, and highlight Product
ID in the list box below it.

8. Click the Add button to create a link.

9. Select Transaction in the left combo box, and highlight Vehicle
ID in the list box below it.

10. Select = in the cenfer combo box.

11. Select Vehicle in the right combo box, and highlight Vehicle ID
in the list box below it.

12. Click the Add button to create a link.

13. The three links that you just created will be shown in the list
box at the bottom of the form. Click the OK button to accept the

links.
[TRANSACTION = |VEHICLE -]
TAX2 - - ~] [inFo -
TOTAL LICENSE
TRANS_NO MAX_LEGAL_WEIGHT
TRANS_UNDO_ID ] I EGAL WEIGHT
TRUCK_ONLY TYPE
V_OPERATOR_ID Search | UNAT_TICKET
WT_UNIT -

TRANSACTION.ACCOUNT_ID = ACCOUNT.ACCOUNT_ID
TRANSACTION.PRODUCT_ID = PRODUCT.PRODUCT_ID
TRANSACTION.VEHICLE_ID = VEHICLE.VEHICLE_ID

Delete

A

Cancel
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You will now return to the REPORT — Query and Layout Definition
form. The Var List (variable list) and Item List fields should now
contain the information that you just entered. The variable list
identifies the type of variable (Date/Time, String, Number), and the
item list identifies the specific type of variable. When you use the
Query butfon to change the query, the change will be reflected in the
variable list and item list (always in the proper order).

# REPORT - Query and Layout Definition
Takle Data Edit
¥ | & |0 (B | |, || ®|7|
Close New Query | Table : Insert | Update | Delete
Type Destination - Company
2 " Report & View .
“{gﬁpar _ P . Id rZip
& Ticket  Printer
 File V¥ Name I Country
Report Id: [TESTT Level: \E
rAddrl T Phone
Description: |T"-‘5t Ticket | = raddr2 T Fax
Printer: |HP LaserJet 5Si Mo“HPﬁSl || | - city o (Gl
File: | | state
Layout: [TEST.QRP Query | Layout |
Var List: 510 S[11.S[21 N[O} N[1}.DTIOL DT[1].N[2]. S[3].[4].S[5L.516|  Quick @ | @uick L. |
Item List: |TRANSACTION.ACCOUNT?ID,TRANSACTION.PRODU| | “Report | = Test |
Press "Queny to retrieve information... | MUK

10-6 (9/00)



Chapter 10: Report Writer Tutorial
Generating a Ticket

Test the Query
Once you have completed the query and linked the tables, press the
Query butfon in the lower right-hand corner of the REPORT — Query
and Layout Definition form. This will display the query on the Edit
Query form.

Edit Query x|

o

v
Ok

Test

TRANSACTION.WT_GNIT, '
=] *
) Cancel

All elements fo be printed on your report or ticket should show up in
the display area. From this form, you can also use SQL statements
to refine your query. Click the Test button fo test the query or any
changes that you make, and then click OK to confirm the query.
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Defining the
Layout

10-8 (9/00)

To generate a basic report, which can be modified to print a ticket,
click the Quick L. button on the REPORT — Query and Layout
Definition form. This will open a ReportWindows form that shows all
of the items defined in your query, plus the text objects that are used
as column headings.

Sections of a Report/Ticket:

»  Report Header appears at the beginning of the report.
»  Page Header appears at the top of each page.

»  Detail Block is the body of the Ticket/Report.

»  Page Footer appears af the bottom of each page.

»  Report Footer appears af the end of the report.

If you add a break group (a subsection) to the report, you can also
insert a Break Group Header and Break Group Footer.

Tool Palette
Open the View menu on the ReportWindows menu bar, and select
Palette from the drop-down menu to display the tool palefte.

Use the right mouse button to scroll through the tools, or point at a
fool and use the leff mouse butfon to select it. You can also select a
fool from the Tool menu on the menu bar. The fool palette is shown
to the left. The tools (from left fo right, starting with the top row) are
described below:

»  Selector Tool - For selecting objects.

»  Background Text Tool - For adding background text.

»  Field Tool - For adding fext fields.

»  Box Tool — For adding boxes.

»  Picture Tool - For adding picture objects.

« Line Tool - For adding line objects (complete work areas).
«  Graph Tool - For adding graphs.

»  Crosstab Tool - For adding tables.

»  Auto Selector Off - Pointer remains on last item used.

»  Auto Selector On - Poinfer returns fo selector tool.

The ReportWindows layout form for the query that you creafed is
shown below, with the tool paletfte displayed. Note that
TRANSACTION.VEHICLE_ID appears fwice: once as a background
fext object (a column heading for a report) and once as a field
object (an entry under the column heading) This is the same for
each itfem specified in the query.
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= ReportWindows - TESTT.QRP
File Edit View Report Tools Format Help
Pos: | Width: | | [2] |Ms Sans Serif [2][10
Content: [ | Eiiran | Ft: |
} It } A } 2 ! 3 )
[ Report Header 0 Lines |

TRANSA TRANSACTIONVEHICLE ID  TRANSACTIOMN.ACCOUNT ID TRANSACTIO

Detail Block
RAMNS A TRANSACTIONVEHICLE_ID TRAMSA

e ICOUNT_IDT TRANSACTIO
+ [ [
#] Page Footer ] E:] |
[ Report Footer 0 Lines | % D)
.
+
o I N

Delete an Object

1. Use the selector fool to highlight the TRANSACTION.VEHICLE_ID
background text object (which is shown in the Page Header
section).

2. Open the Edit menu on the menu bar and select Cut.

3. The object should be deleted.

Delete a Line
1. Use the selector fool to highlight the blank line just below Page
Header.

2. Select Cut from the Edit menu.

3. The line object should be deleted.

4. Delete all of the lines from the page header.
Add Lines to the Page Header

1. Select the line tool.

2. Place the cursor on the Page Header heading.

3. Click the left mouse button until there are five lines under Page
Header.

4. The screen should look like the one shown below.
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=[] ReportWindows - TESTT.QRP -
File Edit ¥Yiew Report Tools Format Help

Pos: | Width: | | [] [Ms sans Serif [#]]10
Content: [ | Eior ] Fk: |
: I : i

-
i L il L 12

AL

e

T kL

[ Report Header 0 Lines |

+] Page Header ]

Detail Block
RANSA TRANSACTIONNEHICLE_ID - TRAMSACTION. ACCOUNT_ID. TRAMSACT

] Page Footer ]

]

Report Footer 0 Lines |

o] [EN S+

-
-

K

l

Add Lines to the Detail Block
1. Select the line fool.

2. Position the cursor directly on the Detail Block heading.
3. Click the left mouse button unfil you have added seven lines.

Add a Picture to the Ticket
1. Select the picture tool.

2. Position the cursor at the left edge of the first blank line in the
page header area. Hold down the leff mouse button and drag
the cursor to draw a box 1.5 inches wide and 5 lines deep.
Release the mouse button. To position the cursor and measure
the width of the box, use the ruler at the top of the window or
use the Position and Width fields above the ruler.

3. When the box is complete, open the Edit menu and select

Paste From.
4. Select a bitmap (*.bmp) from the list of available files.
5. Click OK.

6. The picture should be placed in your ficket.
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Add a Second Picture to the Ticket

1.
2.

o o

NoR oo R

Select the picture tool again.

Position the cursor 4 inches from the left edge of the first blank
line in the page header area, and create another box 1.5
inches wide by 5 lines deep.

Open the Edit menu and select Paste From.

Select another bitmap (*.bmp) file.

Click OK.

The second picture should be placed in your ficket.

dd Text to the Page Header

Select the background text fool.

Place the cursor on the first line in the page header, just fo the
right of the first picture that you inserfed. Click the left mouse
button, and type the fext “Mettler-Toledo Inc.” The complete text
is displayed in the Confent data field at the top of the window.

Choose the selector fool.

Highlight the fext thaf you just entered.

Choose a font and a point size (14) from the combo boxes to
the right of the Width combo box.

Use the same procedure to fill in the address lines of the page
header, so that your screen looks like the one shown below.

ReportWindows - TESTT.QRP

Eie Edit VYiew Report Tools Format Help

Pos: | width: | | [2] [Ms Sans Serit [#][10 |[3=]=] =) [E u
Content: | | Eoircn | Fmt: |
] il 2 3 n 1 5 H@
1| =
|
[ Report Header 0 Lines |
Mettler-Toledo Inc.
735 Toledo Court ._J |
METTLER TOLEDO Burlington, Ontario !I:
L7R 3Y8
AI Dietail Block

[TRANSA S TRANSACTIONVEHICLE_ID & TRANSACTION. ACCOUNT_ID. TRAMSACTION.SHIP [+

=l L1

o
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Add the Date to the Last Line of the Page Header

1.
2.

6.
7.

Select the field fool.

Position the cursor in the last line of the page header, midway
between the two pictures. Click the left mouse button to create
a field for the date.

Click the Editor butfon to display the Formula Editor screen.

Double-click on the CurrentDate function shown in the right-
hand window. The CurrentDate function will move to the top
window.

Click OK. The CurrentDate function will be placed in the field
you created.

Click on the scroll arrow to the right of the Fmt field.
Choose the Date format you want for your ficket.

Your page header is now complete.
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Detail Block

Use the selector tool fo move the input objects in the Detail Block fo
form a pattern like the one shown below.

= A Report¥indows - TESTT.ORP M
File Edit View Heport Tools Format Help
Pos: | Width: | | [] [Ms Sans Serit Bl [EE==Z Bz s]u
Content: | | orin | Fmt: | &
I ) K ) 2 ) 3 ) 4 ) 5 5 [l
o _|_ 3
5] [
Mettler-Toledo Inc. =T L
METTLER- ~ “TOLEDOD edo Court ._J -
Burlington, Ont L.
LR 3%5
CurrentDate()

+ Detail Block

TRANSACTION.OUT_CONSEC

WEHICLE. DESCRIPTION
TRANSACTION.PRODUCT_ID| PRODUCT.DESCRIFTION
TRAMSACTION. ACCOUNT_ID] ACCOUNT. MNAME

TRAMNSACTIOMN.IN_WEIGHT TRANSACTIONWT_UNIT TRAMNSACTION. IN_DATETI
TRANSACTION. OUT_WEIG TRANSACTION.WT_LINIT TRANSACTION. OUT_DATET
TRAMNSACTION.NET WEIGHT TRAMSACTIONWT_UNIT

#1Fage Footer hd
Kl [ e

»  To move an object, position the cursor on the object. Hold
down the left mouse butfon fo highlight the object, and drag it
to the new location.

«  To duplicate the Weight Unit field, use the Copy and Paste
commands in the Edit menu.

»  Use the line fool to add lines if necessary.

»  Use the background text tool to create any headings that you
want fo be printed with the input objects.

Preview Your Ticket

To preview your ticket layout, open the Report menu and select
Preview. To return to the layout design form, open the Report menu
and select Design.

Save and Exit

Open the File menu and select Save to save your layout. Open the
File menu and select Exit fo refurn to the REPORT — Query and
Layout Definition form.
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Generating a

Report
Open the WinBridge REPORT — Query and Layout Definition form by
selecting WB Report from the Report/Ticket menu on the Vehicle
Processing screen. Enter the following information in the data fields:
Name: TESTREP
Level: O
Description: Test Report
Prinfer: (Press the Printer button and select from the list)
File: (Leave blank)
Layout: TESTREP.QRP
Var List: (Leave blank)
[tem List: (Leave blank)
Type: Select the Ticket radio button
Destination: Select the View radio button

Click the Quick Q. button to display the Quick Query form.
2. Select Transaction from the combo box at the top of the form.
3. Select the following fransaction database items from the list
box on the leff and use the arrow butfons fo move them fo the
list box on the right:
Account ID
In DateTime
Out DateTime
Net Weight
Vehicle ID
Wt Unit
4. \When finished, click OK fo return fo the REPORT — Query and
Layout Definition form. You can click the Query button in the
lower right-hand corner of the screen to display the Edit Query
form.
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Dynamic
Variables

Dynamic variables are used to modify a report before you run it. For
example, you can use Date variables to provide defails about
fransactions that were made between two dates.

Dynamic Variables Available:

Date :d110:d12
String :s1 10 :s12
Number :nlto:nl12

The items that you selected during your quick query should appear
on the Edit Query form shown below:

SELECT ALL
TRANSACTION.ACCOUNT_ID,
TRANSACTION.IN_DATETIME,
TRANSACTION.OUT_DATETIME,
TRANSACTION.NET_WEIGHT,
TRANSACTION.VEHICLE_ID,
TRANSACTION.WT_UNIT

FROM  TRANSACTION

Refine your query fo include two dynamic date variables. Position
the cursor af the end of the FROM TRANSACTION line and press the
RETURN key to move the cursor to the next line. Enter the following
WHERE clauses connected by the word AND:

WHERE  TRANSACTION.IN_DATETIME>=:d1 AND
TRANSACTION.OUT_DATETIME<=:d2

(9/00) 10-15



METTLER TOLEDO WinBridge Software User Manual

Order By
ORDER BY is an SQL stafement that sorfs or indexes the items
presented in the report. The order of the data is especially important
when break group reports are to be generated. Reports with break
groups in them group all fransactions of a certain type (for
example, all fransactions belonging to Account 1).
Refine your query further by adding an ORDER BY statement.

SELECT ALL

TRANSACTION.ACCOUNT_ID,
TRANSACTION.IN_DATETIME,
TRANSACTION.OUT_DATETIME,
TRANSACTION.NET_WEIGHT,
TRANSACTION.VEHICLE_ID,
TRANSACTION.WT_UNIT
FROM  TRANSACTION
WHERE ~ TRANSACTION.IN_DATETIME>=:d1 AND
TRANSACTION.OUT_DATETIME<=:d2
ORDER BY TRANSACTION.ACCOUNT_ID
If you are using more than one ORDER BY element, each element
should be separafed by a comma.

Your final query should appear as shown below:

= Edit Query

Cancel

Test
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Click the Test button, and enter the prompts for your dynamic
variables, as shown in the Dynamic Conditions form below. Click
OK when you are finished, and then click OK again to exit the Edit
Query screen.

= Dynamic Conditions
Insert semantic of your Report variables:
[ ]
| | Qut Date |
v’ X
0Ok Cancel
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Formatting

10-18 (9/00)

Formatting a report layout is similar fo formatting a ficket layout.

Use Quick Layout to Format Your Report

1.

Click the Quick L. button on the REPORT — Query and Layout
Definition form.

Add a title o your report in the report header. Use the line tool
tfo add a line to the report header. Then use the background
fext tool fo position and enter fext for the title in the new line.

Use the background text tool to add column headings.
Headings can be placed in the report header or page header.

Arrange the field objects to allow enough space for the required
Information.

Use preview mode fo check your changes. Open the Report
menu and select Preview. \When you want fo return fo design
mode, open the Report menu and select Design.

Create a Break Group

1.

Open the Format menu and select Break Groups to display the
Format Break Groups form.

Input items are shown in the window on the left. Choose
TRANSACTION.ACCOUNT_ID as your first break group. Use the
arrow button to move it fo the Break Groups window on the
right.

When you click OK, a new break group header and break
group footer will be added to the report.

NOTE: due to space limitations, only part of the full title might
be displayed (Header:...CTION.ACT_ID).

Create a Field in the Break Group Footer

1.

o v

Use the line tool to add a line to the Footer:
TRANSACTION.ACCOUNT_ID.

Use the field tool fo add a field under the Net Weight column.
Click the Editor butfon to display the Formula Editor form.
Double-click on Sum in the Functions list box.

Double-click on TRANSACTION.NET_WEIGHT in the Data ltems
list box.

Click OK to create a formula that reads
SUM(TRANSACTION.NET_WEIGHT).

Create a Field in the Page Footer

1.

2.
3.
4

Use the field tool fo add a field under the Net Weight column.
Click the Editor butfon to display the Formula Editor form.
Double-click on Reportsum in the Functions list box.

Double-click on TRANSACTION.NET_WEIGHT in the Data ltems
list box.



Chapter 10: Report Writer Tutorial
Generating a Report

5. Click OK to create a formula that reads
REPORTSUM(TRANSACTION.NET_WEIGHT).

6. Your form should look like the one shown below:

=/ A] ReportWindows - TESTREP.QRP |
File Edit View Report Tools Format Help Scale 1
Pos: [4.916 | Width: | Dynamic | E“Times New Roman [2l[0 ] =lu
Content: [ReportSum TRANSACTION.NET_WEIG | [#] [_eomor_] Fmt: | *
o i ; 2 ; .3 ) I ; 5 ; &[]
o
[+]
:
]—I:III.,COUNT # T DATE/TIME OUT DATE/TILE NET Weight Units 0
=|

N Header _CTION

ACCOUNT_ID OLines |

H3ACTION
I

TRANSACTION.IN_DAT] TRANSACTION.OUT_Da& TRANSACTION TRAH

Footer. TRANSACTION.ACCOUNT ID |

Sum(TRANSACTION
I
Page PageMumb et

] Report Foater

[l »

Save Your Report Format
Open the File menu and select Save.

Exit ReportWindows
Open the File menu and select Exit. You will return fo the REPORT —
Query and Layout Definition form.

View Your Report

Click the Report button to display the Reports form. Highlight the
report that you just created. Click the Print button to print the report,
the View button to view it on the computer screen, or the To File
button fo output it to a file.

You will be asked to insert filter conditions (for example, the specific
dates that you want the report to cover), and then the report will run.
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11 Specific Industries
Forestry

We provide a WinBridge package specifically for the forestry
industry. It simplifies your job by giving you one tool designed to
keep frack of everything you need to know about your transactions.
We have configured the standard WinBridge tables to store the
information that is important to your operation. When you install
the WinBridge forestry option, you will use the Vehicle Processing
screen shown below:

'WinBridge %]

Program  Edit Teble Extdtables Beport/Ticket Datebase Scale Tools Help

WinBridge: The Forestry Solution
—Forestry Transaction:
il Euis et
Truck ﬂ Destination:
Contractor: Quiality: ‘ j‘
Stratum: = =] paywa | EMEK ‘ K
Timbermark: Weight
S s [ v
ﬂ Out q
tn
et
o/ 3
e (| pecept | cear
Load1 Load2 Load3 Load4 Load5 Loadf Load? Load8 Loads Load10
Bl I I I I I I I I |
I
[ mwM[

The input data fields are combo boxes that let you select the
appropriate ID or other number fo be used for a transaction. A data
field for displaying a name or description is locafed next to each of
the Truck and Stratum fields.

Required Data Fields

Mill: Mill identifier
Truck: Truck identifier
Contractor: Contractor identifier
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Stratum: Wood stratum

Species: \Wood species

Timbermark: Identifying mark stamped in the wood (Verified
and Date Check)

Trans. Type: Type of fransaction: purchased wood, prescaled,
or transfer (Verified)

Butts Ahead: Percentage of wood with wide end foward front of
fruck

Destination: Mill where wood is to be shipped

Quality: Quality of product

Remark: A remark that appears on screen

Optional Data Fields

Cut Block: Area (# or county) where wood came from
(Verified)

Log Sort: Size of logs: free length, saw logs, 8 feef, mixed

Yard: Location in lumber yard where wood will be
delivered

Peeler %: Percentage of peeler logs

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each forestry table.

Forestry Table Standard WinBridge Table
Contractor Account
Species Carrier
Stratum Product
Quality Remark
Remark Remark2
Mill Company
Trans. Type Table 1
Cut Block Table 2
Butts Ahead Table 3
Deck or Yard Table 4
Destination Table 5
Log Sort Table 7
Peeler % Table 8
Timbermark Table 15
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Daily Weight Button
Click the Daily Wt. Push bufton on the Vehicle Processing screen fo
find out how much of a product has been weighed during the
current day. A window will appear to display the daily weight for
the product that is selected in the Stratum data field.
Sampling
WinBridge lefs your operators know when fo sample a product.
You define how the sampling schedule is sef up:

e Step Sampling: A sample is taken when a preset number of
loads has been processed.

You can set up a schedule to take samples by individual strafum
or other factor. See Chapter 4 for information about sampling.

Timbermark Expiration

The Timbermark table sfores information about timbermarks,
including a field for the timbermark’s expiration date. When a
fransaction is processed for an expired timbermark, a message
appears on screen to notify the operator. The operator can click OK
to continue with the fransaction. See Chapter 4 for information
about using expiration dates in the exiended fables.

Forestry Reports
You can create your own report or choose from a selection of
standard reports:

e Standard WinBridge Reports
e Contractor Report

e Cut Block Report

e Destination Report

e Mill Report

e Species Report

e Stratum Report

e Timbermark Report

e Transaction Report
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Agriculture

We provide a WinBridge package specifically for the agriculture
industry. It simplifies your job by giving you one tool designed to
keep track of everything you need to know about your transactions.
We have configured the standard WinBridge tables to sfore the
information that is important to your operation. When you install
the WinBridge agriculture opfion, you will use the Vehicle
Processing screen shown below:

WinBridge [}
Program  Edit Tahle Extdtables BReport/Ticket Database Scale Tools

WinBridge: The Agriculture Solution

[~ Transaction

Vehicle ﬂ I—‘ Weighment. |:|
P | 2 —
alszan
R -l Pretc rase:
—Amount YWeight
Toal [ ] m | b [ e
Scale:
: ky Tons
Scale:
Net [ e
] 3 W
Daily daliv. Wt Continue
Compute Clear Accept
L _>l_I

[ M|

The input data fields are combo boxes that let you select the
appropriate ID or other number fo be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields

Vehicle: Vehicle identifier

Carrier ID: Carrier identifier

Product: Product identifier

Account: Account identifier

Remark: A remark that appears on screen

Unloading Area: Unloading location (Verified)
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Silo Location:  Silo identifier (Verified)
Product Grade:  Product grade (Verified)
Quality: Product quality

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each agriculture table.

Agriculture Table Standard WinBridge Table
Quality Remark
Unloading Area Table 1
Silo Location Table 2
Product Grade Table 3

Daily Weight Button

Click the Daily Deliv. Wt. Push button on the Vehicle Processing
screen fo find out how much of a product has been weighed during
the current day. A window will appear to display the daily weight
for the product that is selected in the Product data field.

Inventory

The WinBridge program can keep track of inventory levels by
aufomatically adjusting them each time a delivery is processed.
Sampling

WinBridge lefs your operators know when fo sample a product.
You define how the sampling schedule is set up:

e Step Sampling: A sample is taken when a preset number of
loads or weight has been processed.

e Random Sampling: A sample is taken af random within @
preset number of loads or weight range.

You can set up a schedule fo take samples by individual product,
customer, or other factor. See Chapter 4 for information about
sampling.

Vehicle Tracking

Click the Trans push button fo view a table listing all the vehicles
that are currently on your site.

Manual Weight Adjustment

The WinBridge program can modify an invoiced price by applying
a weight correction factor. It can change the price by subtracting an
amount or a percentage. See Chapter 6 for information about
weight correction factors.
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Presets

Presetfs are used to speed up transactions by reducing repetitive,
manual dafa entry. Suppose a vehicle always carries the same
product for the same cusfomer. You can define presets that link the
vehicle to the customer and product. When you enter the vehicle ID
to process a transaction, the system will fill in the rest of the
information automatically. See Chapter 6 for information about
using presets.

Agriculture Reports
You can create your own report or choose from a selection of
standard reports:

e Standard WinBridge Reports
»  Product Grade Report

»  Silo Location Report

e Unload Area Report
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Aggregate:
Sand and
Gravel

WinBridge

\We provide a WinBridge package specifically for the aggregate
(sand and gravel) industry. It simplifies your job by giving you one
tool designed to keep track of everything you need to know about
your transactions. We have configured the standard WinBridge
tables fo store the information that is important to your operation.
When you install the WinBridge aggregate opfion, you will use the
Vehicle Processing screen shown below:

Program Edit Table Extdtables Hepor/Ticket Database Scale Tools Help

m" Search @ ﬁ
Trans Preset

WinBridge: The Sand / Gravel Solution W e

(=] = f = B ol E 12.55
ontrag
Ticket | Report Help &y

~ Transaction

| |

Contract
’7 j‘ max

deliv

I:l Delivery Zone ﬂ

Vehicle =] Delivery Method: =]
Carrier Id: Product Grade: =]

Product ‘ ﬂl ‘ j‘ Remarkc | j‘

—Amount

! —

Transaction

e C Je [

Discount Surcherges | Scale
Tax 2 I:l Converted wt
Tota [ ] - " 7
Daily deliv. ¥t Continue
Compute Clear Accept

il

[ |

The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located nexf to each of
the Vehicle, Product, Customer, Delivery Zone, Delivery Method,
and Product Grade fields.

Required Data Fields

Contract: Contract identifier
Vehicle: Vehicle identifier
Carrier ID: Carrier identifier
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Product: Product identifier

Account: Account identifier

Delivery Zone:  Delivery zone (Verified)

Delivery Method: Delivery method (Verified)
Product Grade:  Product grade (Verified)
Optional Data Fields

Remark: A remark that appears on screen

Each field is linked to a table that is used fo store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each aggregate table.

Aggregate Table Standard WinBridge Table
Delivery Zone Table 1
Delivery Method Table 2
Product Grade Table 3

Daily Weight Button

Click the Daily Weight push butfon on the Vehicle Processing
screen fo find out how much of a product has been weighed during
the current day. A window will appear fo display the daily weight
for the product that is selected in the Product data field.

Inventory
The WinBridge program can keep track of inventory levels by
aufomatically adjusting them each time a delivery is processed.

Virtual Indicator

Your WinBridge system can read weights from up fo four indicators
(four scales). Plus it provides a virtual indicafor for processing
large vehicles that need to be weighed on more than one scale.
You can define the virtual indicator as the sum of fwo or more
existing indicators. See Chapter 4 for information about setting up
a virtual indicator.

Taxes and Surcharges

The WinBridge program can add faxes and surcharges when
processing transactions. You can define up fo two faxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about faxes and Chapter 4 for information about surcharges.
Units of Measure

You can use any unit of measure when weighing products. Simply
enfer a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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ODBC
The WinBridge database is ODBC compliant, allowing you fo send
datfa from it to accounting and other soffware packages.

Aggregate Reports
You can create your own report or choose from a selection of
standard reports:

Standard WinBridge Reports
Carrier Report

Delivery Method Report
Delivery Site Report

Delivery Zone Report
Product Grade Report
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Aggregate:

Concrete and

Asphalt
We provide a WinBridge package specifically for the aggregate
(concrete and asphalf) industry. It simplifies your job by giving you
one tool designed to keep track of everything you need to know
about your transactions. We have configured the standard
\WinBridge tables to store the information that is important to your
operation. When you install the WinBridge aggregate option, you
will use the Vehicle Processing screen shown below:

WinBridge %]

Program  Edit Table Exdisbles Repor/Ticket Datmbase Scale Taals

T || search Ef s & -g'*é E 13.00
Trans N Bresst | Ticket |8 Repart [ Heln &% | z

T

WinBridge: The Concrete / Asphalt Solution ~ “esme [ ]
~ Transaction
Lz kg Delivery Zone I—ﬂl
kg |—ﬂ|
dellv I:' Product Info l—jll—‘
Transaction
Scale,
Product ‘ ﬂ” ﬂ‘ Out I:l kg I:ITDHS
Scale: —
Rermark: ‘ ﬂl Converted wi l—‘
= - -
Daily deliv. Wt = ] . e
Compute Clear Accept
‘ LI_I
‘ N
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The input data fields are combo boxes that lef you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, Customer, Delivery Site, Bafch ID, Product
Info, and Set Point fields.

Required Data Fields

Contract: Contract identifier
Vehicle: Vehicle identifier
Carrier ID: Carrier identifier
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Product: Product identifier

Account: Account identifier

Remark: A remark that appears on screen
Delivery Zone:  Delivery site (Verified)

Batch ID: Batch identifier (Verified)

Product Info: Additional product information (Verified)
Set Point: Set point: set per contract (Verified)

Each field is linked to a table that is used fo store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each aggregate table.

Aggregate Table Standard WinBridge Table
Delivery Site Table 1
Bafch ID Table 2
Product Info Table 3
Set Point Table 4

Daily Weight Button

Click the Daily Weight push butfon on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear fo display the daily weight
for the product that is selected in the Product data field.

Inventory
The WinBridge program can keep track of inventory levels by
automatically adjusting them each fime a delivery is processed.

Virtual Indicator

Your WinBridge system can read weights from up to four indicators
(four scales). Plus it provides a virtual indicafor for processing
large vehicles that need fo be weighed on more than one scale.
You can define the virtual indicator as the sum of two or more
existing indicators. See Chapter 4 for information about setting up
a virtual indicator.

Taxes and Surcharges

The WinBridge program can add taxes and surcharges when
processing fransactions. You can define up to fwo faxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about faxes and Chapter 4 for information about surcharges.
Units of Measure

You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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ODBC
The WinBridge database is ODBC compliant, allowing you fo send
dafa from it to accounting and other soffware packages.

Aggregate Reporis
You can create your own reportf or choose from a selection of
standard reports:

e Standard WinBridge Reports
e Carrier Report

e Batch ID Report

e Product Information Report
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Waste:
Recycling

WinBridge
Program  Edit

E

\We provide a WinBridge package specifically for the waste
recycling industry. It simplifies your job by giving you one tool
designed to keep track of everything you need to know about your
transactions. We have configured the standard WinBridge fables to
store the information that is imporfant to your operation. When you
install the WinBridge waste option, you will use the Vehicle
Processing screen shown below:

Table Extdtables Bepor/Ticket Database Scale Tools Help

Bl sfl s @ BEEEE
Trans [ Preset |8 Ticket (8 Report (8 Help &%

WinBridge: The Recycling Solution Weighment: |:|
i~ Transaction
Tare weight Product | ﬂH jJ
venee [ ] L] PR
FITHE
Caontainer: - Truck Gnly I:l Unlnad Area
Remark: | ﬂ‘ Product Grade
Transaction
: —
Scalg
our Yy =
Scale —
= 5 /
Daily deliv. Wi @ Continue
Compute Clear Accept
-
4 »
[ b

The input data fields are combo boxes that lef you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is locafed nexf to each of
the Vehicle, Product, and Customer fields.

Required Data Fields

Vehicle: Venhicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle
Carrier ID: Carrier identifier

Remark: A remark that appears on screen
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Product: Product identifier
Account: Account identifier
Unload Area: Unloading location (Verified)
Origin: Originating location (Verified)

Product Grade:  Product grade (Verified)

Each field is linked to a table that is used fo store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table
Unloading Area Table 1

Origin Table 2

Grade Table 3

Daily Weight Button

Click the Daily Weight push butfon on the Vehicle Processing
screen fo find out how much of a product has been weighed during
the current day. A window will appear fo display the daily weight
for the product that is selected in the Product data field.

Sampling
WinBridge lefs your operators know when fo sample a product.
You define how the sampling schedule is set up:

e Step Sampling: A sample is taken when a preset number of
loads or weight has been processed.

e Random Sampling: A sample is taken af random within @
preset number of loads or weight range.

You can set up a schedule fo take samples by individual product,
customer, or other factor. See Chapter 4 for information about
sampling.

Presets

Presets are used fo speed up transactions by reducing repetitive,
manual dafa entry. Suppose a vehicle always carries the same
product for the same cusfomer. You can define presets that link the
vehicle fo the customer and product. When you enter the vehicle ID
to process a tfransaction, the system will fill in the rest of the
information automatically. See Chapter 6 for information about
using presets.

Units of Measure

You can use any unit of measure when weighing products. Simply
enfer a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

Standard WinBridge Reports
Destination Report

Origin Report

Product Grade Report
Delivery Location Report
Unload Area Report
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Waste:
Transfer
Stations

We provide a WinBridge package specifically for the waste market.
It simplifies your job by giving you one fool designed to keep track
of everything you need to know about your fransactions. We have
configured the standard WinBridge tables fo store the information
that is important to your operation. When you install the WinBridge
waste option, you will use the Vehicle Processing screen shown
below:

'WinBridge B
Program  Edit Table Extdtables Beport/Ticket Database Scale Tools Help

lef Bl =0 & 2
Trans [N Breset [N Ticket [ Repart [N Help

WinBridge: The Transfer Station Solution
i~ Transaction
Tare weight PR | jl | j‘
vehice. | - ] Account
Al ¥
Cantainer: - Truck Only I:l Unload Area:
Garter Destraton
rematc | 5
Transaction
. —
Scale:
[
Scale: —
= =, 7
Daily deliv. Wt = a !
Compute Clear Accept
L | _'I_I

[ mom[

The input data fields are combo boxes that let you select the
appropriate ID or other number fo be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields

Vehicle: Vehicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle
Carrier ID: Carrier identifier
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Remark: A remark that appears on screen
Product: Product identifier

Account: Account identifier

Unload Area: Unloading location (Verified)
Destination: Shipment destination (Verified)
Origin: Originating location (Verified)

Each field is linked to a table that is used fo store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table
Unloading Area Table 1
Origin Table 2
Destination Table 3

Daily Weight Button

Click the Daily Weight push butfon on the Vehicle Processing
screen fo find out how much of a product has been weighed during
the current day. A window will appear fo display the daily weight
for the product that is selected in the Product data field.

Sampling
WinBridge lefs your operators know when fo sample a product.
You define how the sampling schedule is set up:

e Step Sampling: A sample is taken when a preset number of
loads or weight has been processed.

e Random Sampling: A sample is taken af random within @
preset number of loads or weight range.

You can set up a schedule fo take samples by individual product,
customer, or other factor. See Chapter 4 for information about
sampling.

Presets

Presetfs are used to speed up transactions by reducing repetitive,
manual dafa entry. Suppose a vehicle always carries the same
product for the same cusfomer. You can define presets that link the
vehicle to the customer and product. When you enter the vehicle ID
to process a tfransaction, the system will fill in the rest of the
information automatically. See Chapter 6 for information about
using presets.

Units of Measure

You can use any unit of measure when weighing products. Simply
enfer a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

Standard WinBridge Reports
Destination Report

Origin Report

Delivery Location Report
Unload Area Report
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Waste:
Landfills

\We provide a WinBridge package specifically for landfill
operations. It simplifies your job by giving you one fool designed fo
keep track of everything you need to know about your transactions.
\We have configured the standard WinBridge tables to store the
information that is important to your operation. When you install
the WinBridge waste option, you will use the Vehicle Processing
screen shown below:

WinBridge n
Program Edit Tehle Extdisbles Report/Ticket Database Scale Tools Help

[ f search @ ﬂ & Gl I Contrag
Trans (N Preset [N Ticket |8 Report [§ Help & g 13.16

WinBridge: The Landfill Solution

Tare weight Product; | ﬂH ﬂ‘

Ve = L o
L
Caontainer: ~ Truck Only |:| Cell Lacation:

[~ Transaction

Carrier Id Destination

Remark | = Origin:

—Amount Transaction

. Y
SCale:

H

SinchErEES | Out |:| kg I:|T0n5
Tax | Scale: —
Discount: Net I:| kg
[ ] )
U = 5 o
Compute Clear Accept
K| _'IJ

[ NUM

The input data fields are combo boxes that lef you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is locafed nexf to each of
the Vehicle, Product, and Customer fields.

Required Data Fields

Vehicle: Venhicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle
Carrier ID: Carrier identifier

Remark: A remark that appears on screen
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Product: Product identifier

Account: Account identifier

Cell Location:  Cell location (Verified)
Destination: Shipment destination (Verified)
Origin: Originating location (Verified)

Each field is linked to a table that is used fo store the information
that you will include in the record of a transaction. The list below
indicates which standard WinBridge table was reconfigured to
make each waste table.

Waste Table Standard WinBridge Table
Cell Location Table 1

Destination Table 2

Origin Table 3

Daily Weight Button

Click the Daily Weight push butfon on the Vehicle Processing
screen fo find out how much of a product has been weighed during
the current day. A window will appear fo display the daily weight
for the product that is selected in the Product data field.

Taxes and Surcharges

The WinBridge program can add faxes and surcharges when
processing transactions. You can define up fo two faxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about faxes and Chapter 4 for information about surcharges.

Manual Weight Adjustment (Scrap)

The WinBridge program can modify an invoiced price by applying
a weight correction factor. It can change the price by subtracting an
amount or a percentage. See Chapter 6 for information about
weight correction factors.

Units of Measure

You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.

0DBC

The WinBridge database is ODBC compliant, allowing you fo send
dafa from it to accounting and other soffware packages.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

e Standard WinBridge Reports
e Destination Report

e Origin Report

e Cell Location Report
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Waste: MERF

and RRF

We provide a WinBridge package specifically for the waste (MERF
and RRF) industry. It simplifies your job by giving you one fool
designed to keep track of everything you need to know about your
fransactions. We have configured the standard WinBridge tables fo
sfore the information that is important to your operation. When you
install the WinBridge waste option, you will use the Vehicle
Processing screen shown below:

WinBridge [ X]
Program  Edit Teble Extdtsbles RepotyTicket Datshase Scale Tools Help

¥ Bl s & Elﬂ""a 13.19
Trans (N Preset [ Ticket § Report Help L

WinBridge: The MERF and RRF Solution

[~ Transaction

Tare weight [PREENEE | d‘ | ﬂ‘
FICIET
Container:  Truck Only I:lDEhvery Location:
Remat | =]
Transaction
. —
Scale:
T
Scale —
-, = 7
Daily deliv. Wi = (] i
Compute Clear Accept

o o

[ powl

The input data fields are combo boxes that let you select the
appropriate ID or other number fo be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Product, and Customer fields.

Required Data Fields

Vehicle: Vehicle identifier

Container: Container identifier

Truck Only: Check the box if no container is on the vehicle
Carrier ID: Carrier identifier

Remark: A remark that appears on screen

Product: Product identifier

Account: Account identifier
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Waste: MERF and RRF

Delivery Location: Delivery location within site (Verified)
Destination: Final shipping destination (Verified)

Origin: Originating location (Verified)

Each field is linked to a table that is used to store the information
that you will include in the record of a transaction. The list below

indicates which standard WinBridge table was reconfigured to
make each waste fable.

Waste Table Standard WinBridge Table
Delivery Location Table 1
Destination Table 2
Origin Table 3

Daily Weight Button

Click the Daily Weight push butfon on the Vehicle Processing
screen to find out how much of a product has been weighed during
the current day. A window will appear fo display the daily weight
for the product that is selected in the Product data field.

Taxes and Surcharges

The WinBridge program can add taxes and surcharges when
processing fransactions. You can define up fo fwo faxes and six
surcharges for each product. The system can add the appropriate
charges and calculate a net price. See Chapter 3 for information
about faxes and Chapter 4 for information about surcharges.

Manual Weight Adjustment (Scrap)

The WinBridge program can modify an invoiced price by applying
a weight correction factor. It can change the price by subfracting an
amount or a percentage. See Chapter 6 for information about
weight correction factors.

Units of Measure

You can use any unit of measure when weighing products. Simply
enter a conversion unit and a conversion factor in the Product
table. See Chapter 3 for information about conversion units.

ODBC

The WinBridge database is ODBC compliant, allowing you fo send
data from it to accounting and other software packages.
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Waste Reports
You can create your own report or choose from a selection of
standard reports:

Standard WinBridge Reports
Destination Report

Origin Report

Delivery Location Report
Unload Area Report
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WB-Standard

WB-Standard

The WB-Standard option is a simplified version of the WinBridge
software package. If is designed for operations that do not have
complex processing or datfa management requirements. The
Vehicle Processing screen for this opfion is shown below:
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The input data fields are combo boxes that let you select the
appropriate ID or other number to be used for a transaction. A data
field for displaying a name or description is located next to each of
the Vehicle, Customer, and Product fields.

Required Data Fields

Vehicle: Vehicle identifier
Account: Account identifier
Product: Product identifier
Remark: A remark that appears on screen
Remark2: A remark that appears on screen

Each field is linked to a table that is used to store the information
that you will include in the record of a fransaction. The following
tables are available with this version of the program:

(9/00) 11-25



METTLER TOLEDO WinBridge Software User Manual

11-26 (9/00)

Vehicle table
Customer table
Product table
Remark table
Remark2 table

The following fables and functions are not available with the WB-
Standard option:

Confract table

Carrier table

Container table

Badge table (Unattended option)
Short Code table (Unattended option)
Groups fable

Extended tables

Virtual Indicafor

Scales 3 and 4

Host Communication
Networking

Reports

The WB-Standard program provides a selection of standard
reports. The Report Module can be added fo the package to allow
you to create your own report and ticket formats.
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Definitions

Accelerator
A keyboard shortcut for choosing a menu item or activating a push
button (for example, ALT+Key, CTRL+Key, and SHIFT+Key).

Check Box
A box representing an option that can be turned on or off. The
option is furned on when a check mark appears in the box.

Combo Box

An object that displays a list of items when you click on the down
arrow. When you select an item from the list, it will be displayed in
the box. You can also display the list of ifems by pressing
ALT+DOWN ARROW and close it by pressing ALT+UP ARROW.

Data Field

A box where you can enfer data or where a program displays dafa.
If a data field described in this manual does not appear on your
computer screen, your supplier can install it for you.

Disable
To turn off an option so that it cannot be selected. When a menu
item or push button is disabled, it appears dimmed or gray.

Enable
To turn on an option so that it can be selected.

Filter
Information used fo help search for data. When a filfer is included
in a query, the search is limited to records that match the filter.

Form

A window or box that lefs you communicate with an application.
Most WinBridge forms confain data fields where you can enter or
view information.

Format

The way in which data is displayed on the screen. Special formats
are used fo display currency, percentage, decimal, dafe, time, and
numbers.

Group Box
A box marked on a computer screen to identfify a set of related
objects or dafa fields.
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Icon
A picture that represents an application or window that is closed or
minimized.

List Box

A box that displays a read-only list of items. You can scroll through
all the items in the list box by using the two vertical arrow keys or
by moving the scroll bar.

Menu
A list of options. You can open a menu by clicking the menu fitle in
the menu bar.

Menu Item
An option in a menu or menu bar. When you click on i, @ menu
item will start an action or display another menu.

Primary Key

The data field used to identify records in a WinBridge table. For
example, the Product ID is the primary key for the Product table.
Each product listed in the table must have its own unique ID.

Push Button
An object that begins an action when you click on it.

Query
A request for information from a dafabase. The request can include
a filter fo limit the search to a specific type of dafa.

Radio Button

A circle representing an option that can be furned on or off. The
option is furned on when a dot appears in the circle. In a group of
radio buttons, only one button can be on.

Scroll Bar

A box with an arrow at each end and a slide bar in between. Scroll
bars are used when the contents of a window or list box are foo
large to be displayed all af once. A window can have a verfical
scroll bar af the right side of the window and a horizontal scroll bar
at the botfom of the window.

Table
The basic data storage structure of the WinBridge database. A table
is a grid divided info columns and rows.

Window
A rectangular area on the computer screen where an application
receives inpuf from the mouse or keyboard and displays output.
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